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CHƢƠNG 1 :MICROSOFT WORD 

I. GIÔÙI THIEÄU 

Microsoft Word laø moät chöông trình soaïn thaûo 

vaên baûn chuyeân nghieäp, duøng Word chuùng ta coù 

theå deã daøng taïo ra ñuû caùc daïng vaên baûn töø ñôn 

giaûn nhö moät laù thö ñeán phöùc taïp nhö moät trang 

taïp chí (bao goàm caùc töïa baøi caàu kyø, noäi dung 

ñöôïc chia thaønh nhieàu coät, caùc baûng bieåu, hình 

veõ...) 

 

1. KHÔÛI ÑOÄNG  

Caùch 1 : Double click leân bieåu töôïng Microsoft 

Word treân neàn Desktop 

Caùch 2 : Vaøo nuùt leänh Start, troû vaøo Programs, 

choïn Microsoft Word  

 

2. GIÔÙI THIEÄU GIAO DIEÄN 

 1. Thanh Tieâu ñeà (Tiltebar) 

Chöùa teân cuûa trình öùng duïng Microsoft Word vaø 

teân taäp tin vaên baûn ñang soaïn thaûo, beân phaûi coù 

nuùt cöïc tieåu, cöïc ñaïi/khoâi phuïc, nuùt ñoùng cöûa 

soå.  

 

 2. Thanh trình ñôn (Menu bar) 

Goàm chín menu leänh: File, Edit, View, Insert, 
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Format, Tools, Table, Windows, Help. Ñeå kích 

hoaït menu leänh chæ caàn di chuyeån chuoät tôùi teân 

menu töông öùng kích chuoät traùi (hoaëc giöõ phím Alt 

vaø nhaán kyù töï ñöôïc gaïch chaân cuûa menu töông 

öùng). Noù thaû xuoáng moät baûng menu leänh. Hoaëc 

baám phím F10 roài duøng caùc phím muõi teân ñeå choïn 

leänh roài baám phím Enter. 

 

 3. Thöôùc (Ruler) 

Khi maøn hình ôû cheá ñoä Print Layout thì coù 2 caây 

thöôùc ngang vaø doïc. Hai thanh thöôùc duøng ñeå canh 

leà traùi, phaûi, treân, döôùi cho moãi trang vaên baûn. Ñeå 

hieån thò hay che daáu thanh thöôùc, chæ caàn choïn leänh 

View/Ruler. 

 

 4. Caùc thanh coâng cuï (Toolbars) 

Goàm caùc thanh coâng cuï chöùa caùc nuùt leänh, töôïng 

tröng cho caùc leänh thöôøng ñöôïc söû duïng. Khi ta 

nhaán vaøo moät nuùt leänh naøo ñoù treân thanh coâng cuï 

thì Word seõ thöïc hieän moät chöùc naêng töông öùng. 

Ñeå hieån thò hay che daáu thanh coâng cuï chæ caàn 

choïn trình ñôn View, choïn leänh Toolbars/…, choïn 

thanh coâng cuï töông öùng. Neân chæ cho xuaát hieän 

caùc thanh Standard vaø Formatting Toolbar 

 

 5. Vuøng soaïn thaûo (Editor) 

 Laø khu vöïc ñeå nhaäp vaø trình baøy vaên baûn.  
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 6. Thanh cuoän (ScrollBars) 

Caùc thanh naøy ôû döôùi vaø beân phaûi, beân trong coù 

caùc muõi teân cuoán vaø hoäp cuoän, ñöôïc söû duïng ñeå 

cuoän vaên baûn trong cöûa soå maøn hình soaïn thaûo. 

  

3. THOAÙT KHOÛI WORD  

 Caùch 1 : Nhaát Alt +F4 

 Caùch 2 : Vaøo menu File choïn Exit  

 Caùch 3 : Click vaøo nuùt  X(close) cuûa cöûa soå 

Microsoft Word  

Neáu coù vaên baûn chöa löu thì Word thoâng baùo 

nhö sau. Choïn Yes thì löu, No thì khoâng löu, 

Cancel thì boû qua. 

 

 

 

II.  TAÏO FILE VAÊN BAÛN  

 1. Khaùi nieäm  

Character (kyù töï) Laø 1 kyù töï ñöôïc goõ töø baøn phím 

ngoaïi tröø phím chöùc naêng. 

Word (töø) Moät nhoùm kyù töï lieân tuïc, giöõa caùc 

töø laø 1 khoaûng traéng  

Line (doøng) Taát caû caùc töø naèm treân cuøng 1 

doøng. 
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Paragraph (ñoaïn) Moät ñoaïn vaên baûn ñöôïc keát thuùc 

baèng phím Enter. 

WordWrap  Khaû naêng töï ñoäng xuoáng doøng khi 

gaëp leà phaûi vaên baûn 

Shift+Enter  EÙp xuoáng doøng trong 1 ñoaïn vaên. 

Enter  Xuoáng doøng taïo ra ñoaïn vaên môùi. 

Ctrl+Enter  Ngaét sang trang môùi. 

 

 2. Nhaäp vaên baûn   

 Nhaäp vaên baûn yeâu caàu phaûi chính xaùc.  

 Caàn choïn moät Font chöõ roõ raøng deã ñoïc.  

 Nhaäp vaên baûn ñuû noäi dung, ñuùng chính taû, khoâng 

ñeå thöøa khoaûng traéng. 

 Trong 1 ñoaïn vaên (paragraph) neáu coù nhieàu doøng 

thì Word seõ töï ñoäng canh leà nhôø cheá ñoä 

WordWrap.  

 Khoâng neân vöøa nhaäp lieäu vöøa ñònh daïng.  

 Khoâng ñöôïc duøng phím khoaûng traéng ñeå canh vaên 

baûn. 

 Font tieáng vieät thöôøng ñöôïc söû duïng laø : VNI-

Times, VNI-Helve  

 

 3. Taïo Vaên baûn Môùi 

Sau khi khôûi ñoäng Word, maøn hình seõ töï ñoäng coù 

moät cöûa soå soaïn thaûo vaên baûn mang teân 

Document1. Ngöôøi soaïn thaûo nhaäp vaên baûn vaø löu 

teân theo yù cuûa mình. Tuy nhieân muoán soaïn theâm 

vaên baûn môùi thì kích chuoät vaøo nuùt  (new) treân 
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thanh Standard Toolbar. 

 

 4. Löu Vaên baûn  

Khi chöa ñaët teân(filename) cho vaên baûn thì leänh 

File/Save vaø File/Save As laø nhö nhau. Hoäp thoaïi 

sau seõ xuaát hieän: 

Trong muïc Save in:  Choïn folder chöùa taäp 

tin caàn löu  

Treân muïc File name: Ñaùnh teân taäp tin caàn 

löu (ñöøng boû daáu tieáng 

Vieät) 

Nhaán Enter hoaëc choïn nuùt leänh Save ñeå löu  

Neáu vaên baûn ñaõ coù teân thì leänh File/Save laø löu 

caäp nhaät. Leänh     File/Save As laøm xuaát hieän hoäp 

thoaïi treân cho pheùp löu vaên baûn vôùi teân khaùc hay 

coøn goïi laø löu theo version. 
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 5. Môû taäp tin vaên baûn 

Khi muoán môû vaên baûn ñaõ coù treân ñóa leân maøn hình 

ñeå xem hay söõa chöõa, boå sung chæ caàn click chuoät 

vaøo nuùt open treân thanh Standard Toolbar, hoaëc 

choïn leänh File/Open hoaëc nhaán Ctrl+O, xuaát hieän 

hoäp thoaïi sau : 

 

 

Trong muïc Look in : Choïn folder chöùa taäp tin caàn 

môû  

Neáu coù thì caùc taäp tin seõ hieån thò  trong khung  

Choïn teân taäp tin caàn môû roài click nuùt Open 

Coù theå môû nhieàu taäp tin vaên baûn baèng caùch giöõ 

phím Ctrl hoaëc Shift  vaø mouse ñeå choïn caùc taäp tin. 

Khi coù nhieàu taäp tin ñang môû ñoàng thôøi, ñeå chuyeån 

qua laøm vieäc vôùi vaên baûn naøo thì choïn leänh 

Window/teân taäp tin  
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 6. Ñoùng taäp tin  

Nhaán Ctrl+F4 hoaëc vaøo File/Close (ñoùng vaên baûn 

ñang hieän haønh) 

Coù theå ñoùng nhieàu taäp tin vaên baûn cuøng luùc baèng 

caùch giöõ phím Shift, vaø choïn leänh File/Close All 

 

 7. Trình baøy trang in  

Choïn leänh File/Page Setup ( hoäp thoaïi 

Thay ñoåi caùc thieát ñaët, choïn OK. 

 

Tab Paper Size: 

 

 

 

Choïn khoå giaáy(Paper Size), höôùng giaáy 

(Orientation). Thoâng thöôøng duøng khoå giaáy A4, 

höôùng giaáy thaúng ñöùng (Portrait) 

 

 Tab Margins: 
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Thay ñoåi caùc thieát ñaët veà leà ñænh(top), ñaùy(bottom), 

traùi(left), phaûi(right) 

 

 8. In aán  

Caùch 1: Nhaán nuùt leänh Print treân thanh 

Standard Toolbar neáu muoán in toaøn boä 

vaên baûn  

Caùch 2: Vaøo menu File/Print… -> hoäp thoaïi: 
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Choïn loaïi maùy in trong hoäp Name 

Trong Page range choïn: 

 All: in toaøn boä vaên baûn 

 Current page: in chæ trang hieän haønh 

 Pages: khai baùo in nhöõng trang naøo cuûa 

vaên baûn 

 Trong Copies khai baùo soá baûn in 
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Luùc naøy con nhaùy seõ di chuyeån ñeán trang töông öùng 

 

 2. Caùc Phím Xoaù 

 Xoaù moät kyù töï beân traùi con nhaùy : ( 

(BackSpace)  

 Xoaù moät kyù töï beân phaùi con nhaùy : Delete 

 Xoaù moät töø tröôùc con nhaùy : 

Ctrl+((BackSpace) 

 Xoaù moät töø sau con nhaùy : Ctrl+Delete  

 Ñeå xoùa khoái choïn, thì choïn noù roài nhaán phím 

Delete 

 

 3. Thao taùc choïn khoái 

 Ñöa con troû mouse ñeán vò trí ñaàu khoái vaø reâ chuoät 

qua traùi, phaûi, leân, xuoáng ñeå choïn khoái mong 

muoán. 

 Giöõ Shift+Caùc phím     

o Shift+Home :  Töø ñieåm cheøn ñeán ñaàu doøng  

o Shift+End :  Töø ñieåm cheøn ñeán cuoái doøng 

o Shift+PgDn:  Töø ñieåm cheøn ñeán cuoái trang  

o Ctrl+Shift+End : Töø ñieåm cheøn ñeán cuoái vaên baûn   

 Ctrl+A  : choïn toaøn boä vaên baûn  

 Giöõ phím Alt+ reâ chuoät seõ choïn khoái chöõ nhaät tuøy 

yù  

 

 4. Boû Choïn Khoái 

Sau khi choïn khoái xong muoán boû vieäc choïn treân chæ 
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vieäc click chuoät traùi vaøo moät vò trí baát kyø treân vaên 

baûn. Hoaëc duøng moät trong caùc phím muõi teân di 

chuyeån con nhaùy  

 

 5. Sao Cheùp Khoái 

 Choïn khoái  

 Nhaán Ctrl+C hoaëc choïn leänh Edit/Copy 

 Chuyeån con nhaùy ñeán nôi cheøn 

 Nhaán Ctrl+V hoaëc choïn leänh Edit/Paste 

 

 6. Di Chuyeån Khoái  

 Choïn khoái  

 Nhaán Ctrl+X hoaëc choïn leänh Edit/Cut  

 Chuyeån con nhaùy ñeán nôi cheøn 

 Nhaán Ctrl+V hoaëc choïn leänh Edit/Paste 

 

 7. Xoaù Khoái  

 Choïn khoái  

 Nhaán phím delete  

 8. Undo vaø Redo 

 Ñeå huûy boû chuoåi haønh ñoäng vöøa xaûy ra nhaán 

Ctrl+Z hoaëc leänh Edit/Undo hoaëc nuùt leänh Undo 

treân thanh Standard Toolbar 

 Ñeå khoâi phuïc laïi nhöõng leänh Undo vöøa laøm coù 

theå duøng nuùt leänh Redo treân thanh Standard 

Toolbar 

 9. Phoùng to hoaëc thu nhoû vaên baûn  

 Nhaép vaøo nuùt Zoom treân thanh Standard 
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Toolbar choïn caùc giaù trò mong muoán hoaëc coù 

theå nhaäp vaøo ñaây moät tyû leä baát kyø  

 Hoaëc vaøo menu View/Zoom…( hoäp thoaïi. Choïn 

tyû leä mong muoán  

 10. Di chuyeån thanh coâng cuï  

 Ñöa mouse ñeán bieân traùi cuûa thanh coâng cuï 

vaø reâ chuoät ñeán vò trí thích hôïp  

III.TRÌNH BAØY FONT CHÖÕ 

 Thanh FORMATTING TOOLBAR 

 

 MENU LỆNH  

Muoán ñònh daïng veà font chöõ phöùc taïp hôn thì choïn 

leänh Format/Font  

 Choïn khoái vaên baûn. Neáu khoâng choïn thì seõ 

ñònh daïng kyù töï taïi vò trí Cursor 

 Choïn leänh Format/Font… -> hoäp thoaïi 
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 1. Lôùp Font  

Caùc muïc Font, Font Style, Size, Font color: nhö söû 

duïng bieåu töôïng  

 

Underline style: Caùc kieåu gaïch chaân  

None  Khoâng gaïch döôùi 

Single Gaïch döôùi 1 neùt  

Word Only  Gaïch döôùi töøng töø  

Double  Gaïch döôùi 2 neùt  
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Dotted  Gaïch döôùi baèng daáu chaám  

Thick  Gaïch döôùi baèng neùt daøy  

Dash Gaïch döôùi baèng ñöôøng ñöùt neùt  

Dot dash  Gaïch döôùi baèng ñöôøng chaám 

gaïch  

Dot Dot dash  Gaïch döôùi baèng ñöôøng chaám 

chaám gaïch  

Wave  Gaïch döôùi baèng ñöôøng daïng 

soùng  

Effects: Taïo caùc hieäu quaû nhö  

Strikethrough  Gaïch giöõa chöõ baèng 

ñöôøng ñôn  

Double Strikethrough  Gaïch giöõa chöõ baèng 

ñöôøng ñoâi  

Superscript  Ñöa chöõ 
leân treân

 vaø 

giaûm kích thöôùc  

Suscript  Ñöa chöõ xuoáng döôùi vaø 

giaûm kích thöôùc  

Shadow  CChhööõõ  ccooùù  bbooùùnngg  

Outline    

Emboss CCChhhöööõõ õ    nnnooo ãã ã iii,,,   cccooo ùù ù    mmmaaaøø øuuu   

tttrrraaaéé énnnggg,,,   bbbooo ùù ùnnnggg   mmmaaaøø øuuu   xxxaaaùù ùmmm  

Engrave  CCChhhöööõõ õ    nnnooo ãã ã iii,,,   cccooo ùù ù    mmmaaaøø øuuu   

tttrrraaaéé énnnggg,,,   bbbooo ùù ùnnnggg   mmmaaaøø øuuu   xxxaaaùù ùmmm 

Small Caps  CHÖÕ THÖÔØNG THAØNH 

CHÖÕ IN COÙ ÑOÄ CAO 

KHOÂNG ÑOÅI 

All Caps  ÑOÅI CHÖÕ THÖÔØNG 
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THAØNH CHÖÕ IN  

Hidden  AÅn vaên baûn  

 

Muïc Default : Khi choïn muïc naøy moãi laàn taïo 1 

vaên baûn môùi, Word seõ choïn söû duïng nhöõng thieát 

ñaët naøy nhö maëc ñònh. Nhöõng thieát ñaët seõ ghi vaøo 

Template Normal.dot 

Muïc OK : Nhöõng thieát ñaët seõ aùp duïng cho khoái 

ñöôïc choïn hoaëc ngay taïi vò trí cursor neáu khoâng 

choïn khoái 

 2. Lôùp character Spacing 
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Scale: taêng, giaûm ñoä roäng caùc kyù töï, ñoä cao 

khoâng ñoåi 

Spacing: Khoaûng caùch giöõa caùc kyù töï 

Normal Khoaûng caùch bình thöôøng  

Expanded K h o a û n g  c a ù c h  t h ö a   

Condensed  Khoaûng caùch neùn  

Position: Vò trí cuûa caùc kyù töï so vôùi ñöôøng Base 

Normal  Vò trí thöôøng  

Raised Ñöa chöõ leân treân 

Lowered  Ñöa chöõ xuoáng döôùi  

 

 3. Lôùp Text Effects  

Muïc Animations : choïn caùc loaïi animation mong 

muoán  

 

III. CHEØN CAÙC KYÙ TÖÏ ÑAËC BIEÄT 

Ñònh vò cursor taïi vò trí caàn cheøn. Choïn leänh 

Insert/Symbol ( hoäp thoaïi 
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Choïn Font: caùc kyù töï ñaëc bieät chuû yeáu naèm 

trong caùc Font sau: Symbol, Windings, 

Windings 2, Windings 3 

 

Double click leân kyù töï caàn cheøn hoaëc choïn kyù 

töï roài click nuùt Insert. Laäp laïi cho caùc kyù töï 

khaùc. Click nuùt Close seõ ñoùng hoäp thoaïi laïi.  

 

IV. CHUYEÅN ÑOÅI DAÏNG KYÙ TÖÏ 

 Choïn khoái 

Duøng menu leänh: Choïn leänh Format/Change Case 

xuaát hieän hoäp thoaïi sau: 
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- Sentence case : Kyù töï ñaàu doøng cuûa caâu 

thaønh chöõ hoa 

- lower case : Chöõ thöôøng. 

- UPPERCASE : Chöõ in hoa 

- Title Case : Hoa caùc kyù töï ñaàu cuûa moãi 

töø. 

- tOGGLE cASE : Neáu chöõ thöôøng thì chuyeån 

thaønh chöõ hoa vaø ngöôïc laïi. 

Choïn chöùc naêng töông öùng roài choïn OK. 

Hoaëc duøng phím taét nhaán Shift+F3. 

IV.  ÑÒNH DAÏNG ÑOAÏN VAÊN 

Moät Paragraph laø 1 ñoaïn vaên goàm 1 hoaëc nhieàu 

doøng. Trong 1 ñoaïn vaên chæ nhaán phím Enter khi 

keát thuùc ñoaïn vaên. 

 

 1. Caùc khaùi nieäm veà ñoaïn vaên 

 First line  

 Hanging Indent 

 Left Indent 

 Right Indent 
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Ñaùnh daáu choïn 1 hoaëc nhieàu ñoaïn vaên, reâ 1 trong 

caùc tam giaùc treân ruler ñeå thay ñoåi vò trí caùc doøng 

cuûa paragrah theo phöông ngang. 

  

 2. Ñònh daïng ñoaïn vaên ñôn giaûn  

Ñaùnh daáu choïn 1 hoaëc nhieàu ñoaïn vaên, nhaép choïn 

moät trong caùc bieåu töôïng leänh  

 

 

Canh traùi  

Canh giöõa  

Canh phaûi 

Canh ñeàu hai beân 

Ñaùnh soá thöù töï moãi ñoaïn vaên 

Chöùc naêng Bullet 

Leà traùi cuûa Paragraph được chuyeån sang 

beân phaûi moät böôùc Tab 

Leà traùi cuûa Paragraph được chuyeån sang 

beân traùi moät böôùc Tab 

 

First 

Line 

Right 

Indent 

Left 

Indent 

Hanging 

Indent 
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 3. Ñònh daïng ñoaïn vaên phöùc taïp hôn  

Ñeå ñònh daïng ñoaïn vaên phöùc taïp hôn söû duïng leänh 

Format/Paragraph  ( hoäp thoaïi 

 

  

 Muïc Alignment  

Left(Canh traùi), Centered(canh giöõa), Right(canh 

phaûi), Justilied(canh ñeàu 2 beân) 

 Muïc Indentation  

Left : Soá ño khoaûng caùch leà traùi  
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Right: Soá ño khoaûng caùch leà phaûi   

 Muïc Special  

None First line vaø Hanging indent thaúng haøng 

nhau  

First  Doøng ñaàu tieân thuït ra hay vaøo  

Hanging Caùc doøng coøn laïi thuït ra hay vaøo 

By : Soá ño khoaûng caùch giöõa First line vaø 

Left (ngöôøi söû duïng coù theå ñaùnh vaøo giaù 

trò tuøy yù) 

 Muïc Spacing  

Before Khoaûng caùch so vôùi paragraph treân 

After  Khoaûng caùch so vôùi paragraph döôùi  

 Muïc Line Spacing  

Single Ñoä thöa giöõa caùc haøng trong paragraph 

bình thöôøng 

1.5 line  Ñoä thöa  gaáp röôûi  

Double  Ñoä thöa gaáp ñoâi 

Muïc At  Ñoä thöa tuøy yù, ví duï gaáp 1.2 laàn thì nhaäp 

vaøo muïc naøy   

 

 TRÌNH BAØY PARAGRAPH DAÏNG 

LIEÄT KEÂ 

Vaên baûn daïng lieät keâ laø moät kieåu trình baøy ñaëc 

bieät, coù theå nhaän bieát nhôø caùc kyù hieäu ñöùng ñaàu 

moãi paragraph (Thoâng thöôøng laø caùc daáu gaïch ñaàu 

doøng hoaëc caùc soá thöù töï) 

Coù 2 daïng kieät keâ baèng soá thöù töï hoaëc baèng caùc kyù 

töï ñaëc bieät 
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a. Duøng caùc bieåu töôïng treân thanh formatting 

Duøng caùc nuùt leänh:  

Numbering ñeå ñaùnh soá töï ñoäng caùc ñoaïn vaên theo 

maãu hieän haønh. 

Bullets ñeå cheøn kyù hieäu ñaëc bieät hieän haønh ôû ñaàu 

moãi ñoaïn vaên. 

b. Duøng menu leänh  

Ñaùnh daáu choïn caùc paragraph caàn trình baøy, thöïc 

hieän leänh Format/Bullets and Numbering, -> hoäp 

thoaïi sau: 

 Lôùp Bulleted: 

 

Nhaép choïn moät maãu vaø OK, Neáu muoán thay theá 1 

maãu naøo baèng kyù töï khaùc thì choïn noù roài click nuùt 

Customize -> hoäp thoaïi: 
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Choïn 1 maãu trong Bullet character hoaëc click nuùt 

Bullet ñeå choïn 1 kyù töï ñaëc bieät töø caùc font kyù hieäu 

khaùc. 

Ngoaøi ra ta coøn coù theå thay ñoåi caùc thieát ñaët veà vò 

trí cuûa Bullet vaø ñoaïn vaên trong phaàn Bullet 

position, Text position 

 

 Lôùp numbering  

Nhaép choïn moät maãu vaø OK.  
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   25 

Lôùp Outline Number: Ñaùnh soá kieåu ñeà cöông 

(nhieàu caáp) 

 Ví duï:  

I. Tieát 1:  

1. Taïo Style, Taïo muïc luïc (table of contents) cho 

taøi lieäu. 

a. Taïo Heading 

b. Söû duïng Style. 

2. Taïo muïc luïc. 

II. Tieát  2: 

1. Merging taøi lieäu. 

a. Khaùi nieäm 

b. Caùch taïo 

2. Caùc loaïi taøi lieäu  

a. Troän taøi lieäu daïng Letter 

b. Troän taøi lieäu daïng Label 

Caùch taïo: 

o Ñaùnh daáu khoái muoán ñònh daïng 

o Choïn leänh … Choïn Tab Outline Number  

Choïn kieåu ñaùnh soá  OK 

 

o Duøng (Increase indent)  hoaëc  (Decrease 

indent) ñeå taêng giaûm caáp (Caáp con thuït vaøo 1 

Tab so vôùi caáp cha) 

 

Chuù yù: Coù theå chænh laïi kieåu ñaùnh soá baèng 

Customize 
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V. DROPCAP 

Choïn 1 hoaëc vaøi 

kyù töï ñaàu tieân 

cuûa First line. 

Thöïc hieän leänh 

Format/Dropca

p -> hoäp thoaïi: 

 

None : Boû 

choïn 

DropCap 

Dropped: 

drop trong 

ñoaïn vaên 

In Margin: drop ôû leà traùi 

 

Font : Choïn font  

Lines to Drop : Soá doøng  

Distance From Text : Khoaûng caùch theo 

phöông ngang cuûa Drop Cap so vôùi caùc doøng 

cuûa ñoaïn vaên  

 

Chuù yù : 

 Moät ñoïan vaên vöøa coù chöùc naêng DropCap, vöøa 

coù chöùc naêng Column thì chuùng ta neân ñònh 

daïng column tröôùc vaø DropCap sau. 

VI. KEÛ KHUNG VAØ TOÂ NEÀN  

 1. Söû Duïng Toolbar 



   27 

Ñaùnh daáu choïn caùc 

paragraph caàn keõ 

khung  

Nhaép vaøo bieåu töôïng 

treân thanh Formatting, choïn vò trí caàn keû  

 2. Söû Duïng Menu 

Ñaùnh daáu choïn caùc paragraph caàn keû khung  

thöïc hieän leänh Format/Border and Shading -> 

hoäp thoaïi: 

 

 

 Choïn neùt trong phaàn Style, maøu saéc trong phaàn 

Color, ñoä roäng neùt trong phaàn Width. Choïn 1 trong 

caùc thieát ñaët trong phaàn Setting. Ñeå keû hoaëc khoâng 

keû 1 vò trí naøo ñoù, thay ñoåi trong phaàn Preview 

Ngoaøi ra trong hoäp thoaïi naøy duøng lôùp Shading ñeå 



   28 

toâ neàn cho ñoaïn vaên 

 

 

VII. SÖÛ DUÏNG TAB 

Tab laø kieåu ñònh daïng thöôøng gaëp trong vaên baûn. 

Moãi ñoaïn vaên coù theå coù soá löôïng, vò trí vaø loaïi tab 

khaùc nhau. Tab thöôøng duøng cho caùc ñoaïn vaên coù 

cuøng caùch canh cho caùc cuïm noäi dung  

 

Ví duï :  

STT TEÂN HAØNG SOÁ LÖÔÏNG ÑÔN GIAÙ THAØNH TIEÀN  

1. Maët haøng A ................. 1000 ........ 125.50 

2. Maët haøng B ..................... 40 ...... 1500.25 

3. Maët haøng C ............... 10000 ........ 500.50 

 

Chuùng ta thaáy cuïm Teân Haøng canh traùi vôùi nhau, 
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cuïm Soá Löôïng, Thaønh Tieàn canh phaûi vôùi nhau, 

cuïm Ñôn Giaù canh theo daáu chaám thaäp phaân. 

 

 Caùc loaïi tab: khi cursor taïi vò trí tab, nhöõng gì 

ñaùnh vaøo seõ 

Left Tab daït sang phaûi 

Center Tab daït sang 2 phía 

Right Tab daït sang traùi 

Decimal Tab canh theo phaàn thaäp phaân cuûa soá 

Bar Tab taïo vaïch ñöùng 

 

 1. Ñaët tab  

Böôùc 1: Choïn caùc paragraph caàn trình baøy  

Böôùc 2: Choïn loaïi Tab baèng caùch nhaép mouse ôû 

goùc beân traùi cuûa Ruler, moãi khi nhaép 

vaøo seõ coù moät bieåu töôïng Tab hieän 

ra, ñoù laø caùc loaïi Tab cuûa Word  

Böôùc 3: Choïn ñieåm döøng Tab treân Ruler 

baèng caùch nhaép chuoät ôû moät toïa ñoä 

xaùc ñònh, moät kyù hieäu Tab töông öùng 

hieän ra treân ruler 

(Böôùc 2 vaø 3 coù theå thöïc hieän laïi nhieàu laàn neáu 

ñaët nhieàu Tab) 

 

 2. Hieäu chænh Tab  

Ñaùnh daáu  choïn caùc paragraph ñaõ ñöôïc ñaët cuøng 

Tab, Ruler theå hieän caùc Tab ñaõ ñaët baèng caùc kyù 

hieäu Tab maøu ñen (caùc kyù töï Tab seõ bò môø neáu caùc 
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paragraph khoâng cuøng Tab)  

 

Thay ñoåi toaï ñoä : Keùo kyù hieäu Tab sang vò trí môùi 

treân Ruler  

Gôõ boû tab : Keùo kyù hieäu Tab xuoáng döôùi ruler laø gôõ 

Tab ra khoûi Paragraph  

 

 3. Duøng menu leänh  

Böôùc 1:  Ñaùnh daáu choïn caùc paragraph caàn trình 

baøy  

Böôùc 2: Thöïc hieän leänh Format/Tab -> hoäp thoaïi 

 

 

Böôùc 3: Nhaäp toïa ñoä tab taïi muïc Tab stop 

position, choïn loaïi tab taïi phaàn 

Alignment, Leader(ñieàn vaøo choå troáng 
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baèng daáu chaám, ñöùt, lieàn) 

Böôùc 4: Click nuùt Set 

Laëp laïi böôùc 3 vaø 4 cho caùc Tab khaùc 

Ñeå xoùa Tab ñaõ ñaët, choïn Tab trong danh saùch roài 

nhaán nuùt Clear 

Ñeå xoùa taát caû Tab ñaõ ñaët nhaán nuùt Clear All 

  

VIII. CHIA COÄT  

Ñeå deã daøng chia coät ta neân nhaäp xong vaên baûn. 

Phaàn vaên baûn naøo caàn chia coät ta choïn noù roài thöïc 

hieän leänh Format/Columns->hoäp thoaïi  

 

 

Choïn:  
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Two, Three, Left, Right  

Line Between  : Ñöôøng keõ giöõa caùc coät  

Width and Spacing : Ñieàu chænh ñoä roäng  vaø 

khoaûng caùc giöõa caùc coät chöõ  

Chuù yù:  

 Muoán chia ñoaïn naøo chæ queùt khoái ñoaïn 

ñoù neáu khoâng seõ gặp tình traïng : sau khi 

chia nhieàu coät maø noäi dung chæ naèm treân 

moät coät. 

 

Word seõ töï ñoäng chia caùc coät coù ñoä cao baèng 

nhau. Muoán eùp ngaét coät thì sau khi chia coät 

xong ñònh vò cursor taïi vò trí caàn ngaét vaø thöïc 

hieän leänh Insert/Break -> hoäp thoaïi: choïn 

Column Break roài OK 

 

 

IX. STYLE 

 1. Khaùi nieäm: Style laø moät taäp hôïp caùc ñònh 
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daïng ñaõ ñöôïc ñònh nghóa tröôùc vaø ñöôïc ñaëtù teân 

 Coù theå gaùn Style cho 1 ñoaïn vaên baøn baát kyø 

Öu ñieåm cuûa Sltyle: 

o Ñònh daïng nhanh 

o Söûa chöõa thuaän lôïi 

Coù 2 loaïi Style: Style cho ñoaïn (paragraph Style) vaø 

Style cho kí töï (Character Style) 

Word coù saün caùc Style coù theå söû duïng ngay, danh saùch 

caùc Style coù trong hoäp Style Box treân thanh coâng cụ 

,  

ñeå xem heát danh saùch caùc Style: Shift + Click 

 

 

  

 2. Taïo Style 

Coù 2 caùch taïo Style 

Caùch1: Taïo baèng Stle box 

o Taïo caùc ñònh daïng cho 1 khoái hoaëc 1 ñoaïn vaên 

baûn baát kyø 

Character Style 

paragraph Style 
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o Ñaùnh daáu ñoaïn hoaëc khoái chöùa ñònh daïng 

o Nhaäp teân Stle vaøo hoäp Style Box       

  Nhaán Enter 

Caùch 2: söû duïng leänh Format / Style … HÑT  

Choïn New  HÑT 

 

Name <Nhaäp teân Style> 

Style type <Choïn loaïi Style> 

Base on <Choïn Style laøm neàn cho Style ñang taïo> 

 Style ñang taïo seõ bao goàm caùc ñònh daïng cuûa Style 

neàn 

Style for following paragraph <choïn Style cho ñoaïn keá 

tieáp> 
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Format <Choïn caùc ñònh daïng theo yù muoán> 

Automaticcally Update caäp nhaät hay khoâng caäp nhaät 

khi chænh söûa 1 Style 

Shortcut Key Gaùn Style vaøo phím taét 

OK  Apply 

 

 3. Gaùn Style vaøo vaên baûn 

Choïn ñoaïn hoaëc khoái vaên baûn muoán gaùn 

Choïn Style trong Style Box hoaëc vaøo leänh Format 

Style <Choïn Style> 

 

 4. Chænh söûa Style: Coù 2 caùch 

Caùch 1: Duøng Style Box 

o Choïn ñoaïn hoaëc khoái vaên baûn ñaõ taïo Style 

o Söûa ñònh daïng  

o Gaùn laïi Style cuõ cho khoái naøy  HÑT 

 

o Update the style to reflect recent changes  

Caäp nhaät ñònh daïng môùi cho taát caû caùc ñoaïn 

vaên baûn ñaõ gaùn Style naøy 
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o Reapply the formatting of the style to the 

selection traû veà ñònh daïng cuõ 

o Automatically updated the style from now on  

Töï ñoäng caäp nhaät ñònh daïng môùi maø khoâng xuaát 

hiện HÑT 

Caùch 2: Choïn leänh Format / Style  HÑT 

o Choïn Style muoán söûa 

o Choïn Modify 

o OK  Apply 

X. TAÏO BAÛNG  

Table laø baûng goàm nhieàu haøng, nhieàu coät 

Ví duï : Coù baûng goàm 3 haøng x 5 coät  

 

STT Teân haøng Soá 

löôïng 

Ñôn 

Giaù 

Thaønh 

Tieàn 

1 Maët haøng A 10 10 100 

2 Maët haøng B 100 100 10000 

 

Ñaët con troû ôû vò trí muoán taïo baûng, choïn leänh 

Table/Insert/Table xuaát hieän hoäp thoaïi sau: 



   37 

 

 

Choïn soá coät (Number of columns) vaø soá doøng 

(Number of rows) xong, Choïn OK  

Coät 1     

     

Haøng 3    OÂ cuoái 

cuøng 

 

 HIEÄU CHÆNH  TABLE  

 1. Thay ñoåi ñoä roäng coät 

Di chuyeån con troû chuoät ñeán caïnh phaûi coät, khi con 

troû chuoät bieán thaønh muõi teân 2 ñaàu thì Drag chuoät 

theo phöông ngang ñeå thay ñoåi ñoä roäng coät 

 2. Thay ñoåi ñoä roäng caùc coät baèng nhau 
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Choïn caùc coät lieân tuïc nhau roài choïn leänh 

Table/AutoFit/Distribute Columns Evently 

 3. Thay ñoåi ñoä cao haøng 

Di chuyeån con troû chuoät ñeán caïnh döôùi haøng, khi 

con troû chuoät bieán thaønh muõi teân 2 ñaàu thì Drag 

chuoät theo phöông ñöùng ñeå thay ñoåi ñoä cao haøng 

 4. Thay ñoåi ñoä cao caùc haøng baèng nhau 

Choïn caùc haøng lieân tuïc nhau roài choïn leänh 

Table/AutoFit/Distribute Rows Evently 

 5. Lieân keát caùc oâ laøm moät 

Choïn caùc oâ caàn noái laïi laøm moät roài choïn leänh 

Table/Merge Cells 

 6. Taùch moät oâ thaønh nhieàu oâ 

Choïn oâ caàn taùch roài choïn leänh Table/Split Cells, 

xuaát hieän hoäp thoaïi: cung caáp caùc thoâng tin (taùch 

thaønh bao nhieâu doøng, bao nhieâu coät). 

 7. Thao taùc choïn 

 Choïn haøng - Select Row  

 Ñaët con troû text vaøo 1 oâ vaøo menu Table/ 

Select/Row. 

 Hoaëc ñaët con troû beân traùi cuûa haøng, khi 

con troû coù daïng  thì nhaép mouse. 

 Reâ chuoät theo chieàu doïc ñeå choïn nhieàu 

haøng.  

 Choïn coät – Select column 

 Ñaët con troû text vaøo 1 oâ vaøo menu 

Table/Select/Column. 

 Hoaëc ñaët con troû treân ñænh coät con troû coù 
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daïng  vaø nhaép mouse. 

 Reâ chuoät theo chieàu ngang ñeå choïn 

nhieàu coät  

 Choïn oâ – Select cell  

 Ñaët mouse trong caïnh traùi cuûa 1 oâ, khi 

con troû coù daïng  thì nhaép mouse 

 Choïn nhieàu oâ lieân tuïc: drag mouse töø oâ 

ñaàu ñeán oâ cuoái 

 Choïn toaøn boä baûng bieåu – Select Table  

 Ñaët con troû text ôû moät oâ trong Table vaøo 

menu Table/Select/Table 

 

 8. Caùc leänh cheøn – Insert  

Cheøn haøng : Ñaùnh daáu choïn 1 haøng laøm moác, 

choïn leänh Table/Insert/Rows Above ñeå cheøn 

haøng môùi ôû phía treân haøng ñaõ choïn. Leänh 

Table/Insert/Rows Below ñeå cheøn haøng môùi ôû 

phía döôùi haøng ñaõ choïn. 

 

Cheøn coät :   Ñaùnh daáu choïn 1 coät laøm moác, 

choïn leänh Table/Insert/Columns to the Left 

ñeå cheøn coät môùi ôû beân traùi cuûa coät choïn. Leänh 

Table/Insert/Columns to the Right ñeå cheøn 

coät môùi ôû beân phaûi cuûa coät choïn. 

Cheøn OÂ:  Ñaùnh daáu choïn 1 oâ, vaøo menu Table 

choïn leänh Insert Cells xuaát hieän hoäp thoaïi sau 

: 
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Shift cells Right: Caùc oâ beân phaûi oâ choïn seõ 

bò ñaåy sang beân phaûi  

Shift cells down: Caùc oâ phía döôùi oâ choïn bò 

ñaåy xuoáng döôùi  

Insert Entire Row: Cheøn moät haøng môùi  

Insert Entire Column: Cheøn moät coät môùi  

 

 9. Caùc leänh xoùa – Delete 

Xoùa haøng:  Ñaùnh daáu choïn caùc haøng caàn xoùa, 

choïn leänh Table/Delete/Rows  

Xoùa Coät:  Ñaùnh daáu choïn caùc coät caàn xoùa, 

choïn leänh Table/Delete/Columns  

Xoùa oâ:  Ñaùnh daáu choïn caùc oâ caàn xoùa, 

choïn leänh Table/Delete/Cells 

xuaát hieän hoäp ñoái thoaïi sau : 

Shift Cells left: Xoùa 

oâ choïn, caùc oâ beân traùi 

noù ñöôïc ñaåy sang traùi  

Shift Cells up: Xoùa oâ 

choïn, caùc oâ beân döôùi 

noù ñöôïc ñaåy leân 
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Delete entire row: Xoùa nguyeân moät haøng  

Delete entire column: Xoùa nguyeân moät coät  

 

 10. Table and borders toolbar 

Choïn leänh View/Toolbars/Table and borders  

Hoaëc nhaép vaøo nuùt leänh Tables and Borders treân 

thanh coâng cuï chuaån  

 

Caùc leänh choïn töø Menu Table coù theå thay theá baèng 

caùc nuùt leänh töông öùng treân thanh Tables and 

Borders. 

Ngoaøi ra coøn coù caùc nuùt leänh ñeå hoå trôï vaán ñeà keû 

khung, doùng noäi dung vaên baûn trong oâ, xoay noäi 

dung trong oâ, … 

 

 NHAÄP NOÄI DUNG TRONG TABLE  

 Döõ lieäu trong oâ coù theå chöùa chöõ, soá, hình veõ, 

nhaép mouse vaøo moät oâ con troû text hieän ra 

trong oâ ñeå nhaäp noäi dung trong oâ ñoù. 

 Döõ lieäu trong oâ seõ töï ñoäng xuoáng doøng neáu 

ñoä roäng cuûa oâ khoâng ñuû chöùa noäi dung cuûa 

vaên baûn. 

 Nhaäp noäi dung cho moät oâ, goõ phím Tab ñeå di 

chuyeån con troû text sang oâ keá tieáp, duøng 

phím Shift+Tab ñeå chuyeån con troû text veà oâ 

tröôùc ñoù. 
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Chuù yù :  Ñeå söû duïng Tab trong baûng thì choïn caùc oâ coù 

cuøng tab roài thieát ñaët Tab nhö bình thöôøng, 

nhöng khi nhaäp noäi dung thì duøng toå hôïp 

phím Ctrl+Tab ñeå di chuyeån Tab ñeán ñieåm 

döøng. 

Ở bước 4: chọn More items  

  

Lần lượt đặt con trỏ vào vị trí và chọn trường cần chèn, 

đóng hộp thoại và tiếp tục thao tác này cho vị trí khác.  

Hiển thị thanh công cụ Mail Merge  

  

Từ thanh coâng cuï, mở hộp thoại cheøn caùc field   

 

XI.CHEØN CAÙC ÑOÁI TÖÔÏNG GRAPHIC 

 CHEØN HÌNH AÛNH 

 CLIPART 

Ñeå cheøn hình ClipArt vaøo vaên baûn thöïc hieän 

caùc böôùc sau: 

B1: Thöïc hieän leänh Insert/Picture/Clip Art -> 

hoäp thoaïi 

Caùc ClipArt ñöôïc nhoùm thaønh töøng loaïi. Ví duï ñeå 

cheøn hình con vaät choïn loaïi Animals, choïn hình 

mong muoán -> menu: nhaán nuùt Insert Clip. 

 PICTURE 

Ngoaøi ClipArt, caùc hình aûnh coøn löu treân ñóa 

döôùi daïng caùc taäp tin hình aûnh coù phaàn môõ roäng 
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.GIF, .WMF, .JPG, … ñeå cheøn hình vaøo vaên baûn 

duøng leänh Insert/Picture/From File -> hoäp thoaïi:  

 

Choïn taäp tin hình aûnh roài nhaán nuùt Insert. 

 3. ÑÒNH DAÏNG PICTURE 

Click choïn hình caàn ñònh daïng ( hình ñöôïc choïn 

seõ xuaát hieän 8 handle bao quanh. Caùc handle seõ 

xuaát hieän bao quanh 1 hình chöõ nhaät aûo chöùa 

hình. Drag 1 trong caùc handle naøy ñeå thay ñoåi 

kích thöôùc hình. Ñeå thay ñoåi kích thöôùc theo 

phöông ngang hoaëc phöông ñöùng thì duøng caùc 

handle ôû giöõa, ñeå thay ñoåi kích thöôùc theo 2 

phöông tuyeán tính thì duøng caùc handle ôû 4 goùc. 

Ngoaøi ra treân maøn hình xuaát hieän theâm thanh 

coâng cuï Picture. Neáu noù khoâng xuaát hieän thì 

choïn leänh View/Toolbars/Picture.  

 

 

Insert Picture 
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Image Control 

More Constrast 

Less Constrast 

More Brightness 

Less Brightness 

Crop 

Line Style 

Text Wrapping 

Format Object 

Set Transparent Color 

Reset Picture 

 

 Chèn WORDART 

B1: Choïn leänh Insert/Picture/WordArt -> hoäp 

thoaïi: 



   45 

 



   46 

Choïn 1 maãu vaø click OK 

B2: Choïn Font, nhaäp noäi dung cho WordArt roài 

click OK 

 

 

Maãu WordArt vôùi noäi dung xuaát hieän trong vuøng 

soaïn thaûo. 

Ñeå ñònh daïng WordArt, click choïn seõ xuaát hieän 

thanh WordArt toolbar. Neáu khoâng coù thì choïn leänh 

View/Toolbars/WordArt 

 

 

Töø traùi sang phaûi caùc nuùt leänh cuûa thanh WordArt 

Insert WordArt Cheøn 1 WordArt môùi 

Edit Text Chænh noäi dung 

WordArt ñang choïn 
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WordArt Gallery Choïn maãu khaùc cho 

WordArt  

Format Object Hoäp thoaïi ñònh daïng 

WordArt 

WordArt Shape Thay ñoåi hình daïng 

WordArt 

Free Rotate Xoay WordArt 

Text Wrapping Doùng vaên baûn bao 

quanh WordArt 

WordArt Same Letter Heights Caùc kyù töï coù 

cuøng ñoä cao 

WordArt Vertical Text Moãi kyù töï treân 1 doøng 

WordArt Alignment Doùng caùc doøng cuûa 

cuøng 1 WordArt 

WordArt Character Spacing Khoaûng caùch giöõa 

caùc kyù töï 

 

 CHEØN COÂNG THÖÙC TOAÙN HOÏC (EQUATION 

EDITOR) 

Thöïc hieän: 

Chuyeån con nhaùy ñeán nôi caàn trình baøy. 

Choïn menu Insert/Object xuaát hieän hoäp thoaïi. 

Choïn Microsoft Equation 3.0, roài choïn OK. Treân 

maøn hình xuaát hieän thanh coâng cuï. 

Treân thanh coâng cuï Equation, choïn nhoùm kieåu, 

choïn kieåu trình baøy trong nhoùm ñoù, roài nhaäp noäi 

dung vaøo khung vieàn chaám chaám. 

Sau nhaäp xong, baám chuoät traùi vaøo vò trí baát kyø 



   48 

treân maøn hình ñeå keát thuùc nhaäp. 

 

 

  

 TROÄN THÖ TÍN 

 Coâng vieäc vaên phoøng thöôøng coù nhu caàu taïo ra 

nhöõng giaáy môøi, phieáu baùo, thö caùm ôn, giaáy 

chöùng nhaän,... Nhöõng loaïi thö  tín naøy coù chung 

maãu maõ, chæ khaùc moät soá thoâng tin veà ngöôøi nhaän 

nhö Hoï teân, Ñòa chæ, Ñieåm, ... --> Ñeå thuaän tieän 

Word trang bò chöùc naêng giuùp NSD chæ caàn soaïn 

1 maãu thö tín, sau ñoù troän vôùi thoâng tin veà ngöôøi 

nhaän chöùa trong 1 baûng --> in ra haøng loaït caùc 

giaáy môøi. 

VD: Ta seõ taïo 1 phieáu baùo ñieåm göûi ñeán töøng HS 

vôùi döõ lieäu laáy töø baûng  

Caùc böôùc: 

Thanh Coâng Cuï 

Equation 

Caùc Nhoùm Kieåu 

Trình Baøy 

Caùc kieåu trình baøy trong 

nhoùm 
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1/ Taïo Data Source: nguoàn döõ lieäu chöùa trong 

1 Table ghi ñóa laáy teân Danhsach.Doc  

STT Hoï teân Toaùn Vaên ÑTB 
Xeáp 

loaïi 

1 Hoaøng 

Anh Thu 

9 8 8.5 Gioûi 

2 Ñoã Thò 

Ngaø 

3 4 3.5 Yếu 

3 Traàn 

Maïnh 

Huøng 

7 7 7.0 Khaù 

4 Nguyeãn 

Vaên Kieät 

6 8 7.0 Khaù 

2/ Taïo Main Document: Maãu giaáy môøi chöùa 

trong 1 taäp tin môùi laáy teân laø Phieudiem.Doc 
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Ñöùng taïi taäp tin Main Document 

(Phieudiem.Doc) 

Choïn leänh: Tool / Letters and Mailings /Mail 

Merge --> HÑT 
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Ở bước 4: chọn More items 

 

  

mở tập tin 

danhsach.doc 
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Lần lượt đặt con trỏ vào vị trí và chọn trường cần chèn, 

đóng hộp thoại và tiếp tục thao tác này cho vị trí khác.  

Hiển thị thanh công cụ Mail Merge  

  

 

Từ thanh coâng cuï, muốn mở hộp thoại cheøn caùc field   
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Xem keát quaû troän thö :  

 

 

 Ñeå cheøn nhöõng giaù trò phaûi tính toaùn töø 

nhöõng Field coù saün trong baûng --> Choïn 

Insert Word Field --> Menu <Choïn caùch 

tính toaùn> 

VD: Taïi vò trí (6) baïn muoán 

 Neáu ÑTB > 5 --> Cheøn vaøo chuoãi “Phaùt 

huy keát quaû hoïc taäp” 

 Neáu ÑTB < 0 --> Cheøn vaøo chuoãi “Coá 

gaéng hôn” 

Choïn Insert Word Field / If...Then...Else... --

>HÑT 
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  View Merge Data: Baät taét cheá ñoä xem 

döõ lieäu keát quaû 

  Di chuyeån giöõa caùc 

Record (phieáu baùo) 

  Mail Merge Helper: Cho pheùp chænh 

söûa taäp tin Main Document vaø Data Source 
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    Ñöa keát quaû Mail Merge (caùc 

phieáu ñieåm) ra 1 taäp tin 

   In keát quaû Mail Merge ra giaáy 
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CAÙC CHÖÙC NAÊNG KHAÙC CỦA MICROSOFT 

WORD 

 

I. TAÏO TIEÂU ÑEÀ ÑAÀU TRANG HAY CUOÁI 

TRANG 

Choïn leänh View/Header and Footer ñeå chuyeån 

sang cheá ñoä taïo tieâu ñeà ñaàu trang vaø cuoái trang. 

Microsoft Word coù thanh coâng cuï Header and 

Footer chöùa caùc leänh ñöôïc ñaët trong phaàn Header 

hoaëc Footer: 

 

 

 

II. TEMPLATE 

1. KHAÙI NIEÄM:  

Template laø 1 taäp tin khuoân maãu, cho pheùp môû 1 taäp 

tin môùi vôùi 1 maãu ñaõ ñöôïc taïo saün. Khuoân maãu coù theå 

bao goàm Tieâu ñeà, Logo, noäi dung gì ñoù, … vôùi nhöõng 

ñònh daïng coù saün. Coù theå ví Template nhö 1 caùi neàn 

treân ñoù baïn soaïn thaûo VB theo yù nuoán 

Taäp tin Template coù phaàn môû roäng .DOT 
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2. SÖÛ DUÏNG CAÙC TAÄP TIN TEMPLATE COÙ SAÜN 

Trong Word ñaõ coù saün moät soá taäp tin Template maø 

ñieån hình laø taäp tin Normal.DOT 

Ñeå söû duïng caùc taäp tin Template coù saün: 

 File / New  HÑT:  

Choïn Blank Document  Töùc laø baïn ñaõ choïn 

taäp tin Normal.DOT laøm neàn 

Ngoaøi ra coù theå choïn caùc taäp tin Template khaùc 

baèng caùch choïn caùc TAB khaùc, roài choïn taäp tin 

Template theo yù muoán 

Trong taäp tin Template coù theå bao goàm: 

 Header, Footer 

Text 

Field (maøu xaùm) seõ hoïc ôû session sau 

Watermark (hình môø aån döôùi Text) 

Vaø caùc ñònh daïng ñöôïc taïo saün (Style, …) 

Chuù yù:  

 Thay vì môû 1 taäp tin môùi treân neàn Template nhö 

treân baïn coù theå: Töø cöûa soå WindowExplorer: 

Double click vaøo taäp tin .DOT 

 Phaân bieät taäp tin .DOC vaø .DOT 

 

3. TAÏO TEMPLATE 

File / New  HÑT: Choïn Button Template 

Choïn TAB General  Choïn Blank Document 

Taïo noäi dung Template theo yù muoán 

Ghi taäp tin vaøo Folder Template maëc nhieân  
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(C:\WINDOWS\Application 

Data\Microsoft\Templates) 

Thöû môû 1 taâp tin môùi treân neàn cuûa Teplate vöøa taïo 

 

4.TAÏO FOLDER CHÖÙA TAÄP TIN TEMPLATE 

CHO RIEÂNG BAÏN 

 Khi File / New  Word seõ lieät keâ caùc taäp tin 

Template coù trong Folder Template maëc nhieân 

hoaëc trong caùc TAB coù saün trong HÑT. Baïn coù 

theå taïo theâm TAB chöùa taäp tin Template cho 

rieâng mình trong HÑT naøy 

Caùch taïo: taïo Folder trong Folder Template 

Ghi caùc taäp tin Template vaøo Folder naøy 

Chuù yù: Baïn coù theå taïo Folder môùi ôû baát cöù vò trí naøo, 

ghi caùc taäp tin Template vaøo Folder ñoù; Ñoåi ñöôøng 

daãn ñeán Folder naøy baèng leänh 

Tool / Option  HÑT Choïn TAB File Location; Choïn 

User Teplates; Choïn Modify  Choïn ñöôøng daãn môùi; 

Choïn OK 

 

III. ÑAÙNH SOÁ TRANG CHAÜN TRANG LEÛ 

TRONG HEADER FOOTER 

Ñoái vôùi nhöõng trang giaáy in caû 2 maët vò trí Header vaø 

Footer ôû trang chaün vaø leû thöôøng khaùch nhau, 

Caùch taïo: 

File / Page setup  HÑT: Choïn TAP Layout; 

Check: Different Odd and Event 

Apply <Whole Document> 
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OK 

Vaøo Header trang chaün trang leû ñeå taïo noäi dung 

Ñeå Ñaùnh soá trang ñieåu khieån vò trí cuûa soá trang 

Insert / Page Number  HÑT … 

 

IV. TABLE OF CONTENTS (BAÛNG MUÏC LUÏC) 

1. Taïo baûng muïc luïc 

Vieäc ñaùnh soá trang cho caùc muïc chính trong taøi lieäu 

döïa treân caùc Style ñaõ taïo   

Phaûi taïo caùc Style 

VD:  Taïo 2 Style CHÖÔNG  vaø MUC 

Gaùn 2 Style vaøo caùc vò trí muoán taïo trong muïc 

luïc 

Ñeå con troû taïi vò trí muoán taïo baûng muïc luïc 

Insert / Index and Table / Table of Contents 

 Format <Format> 

 Show Level <2> 

 Option: Choïn Style nhaäp caáp  

VD:  chuong 1 

 Muc  2 

 OK; OK 

2/ Caäp nhaät baûng muïc luïc 

o Khi caàn thay doåi caùch taïo baûng muïc luïc    

Vaøo laïi leänh Insert / Index and Table / Table of 

Contents  HÑT <choïn laïi caùc thoâng soá> ; OK 

 HDT : Choïn OK 

o Khi noäi dung taøi lieäu coù söï thay ñoåi (thay ñoåi 

Font chöõ, nhaäp theâm , …) 
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Ñeå con troû trong baûng muïc luïc; Nhaán F9; Choïn 

Update Page Number ..; OK 

 

V/ Auto Text:  

1/ Auto Text: Cheøn VB töï ñoäng 

Chöùc naêng: Coù nhöõng cuïm töø ta phaûi nhaäp ñi 

nhaäp laïi nhieàu laàn, (VD: Tröôøng cao ñaúng coâng 

nghieäp 4), ñeå tieát kieäm thao taùc nhaäp --> ta gaùn 

cuïm töø ñoù vaøo 1 kí töï (hay 1 nhoùm kí töï) ñaïi 

dieän (ví duï: CDCN) --> khi nhaäp ta chæ caàn goõ 

kí töï --> cuïm töø töï ñoäng xuaát hieän 

 Taïo Auto Text:  

 Ñaùnh daáu khoái VB muoán taïo 

 Insert / Auto Text / Auto Text --> HÑT: 

Choïn TAB Auto Text 

 Enter Auto Text entries here <Nhaäp kí töï 

ñaïi dieän> 

 Choïn Add, OK 

 Söû duïng Auto Text: Nhaäp kí töï ñaïi dieän, Nhaán 

F3 

2/ Auto Correct: 

Chöùc naêng: Thöïc hieän cheá ñoä kieåm tra töï ñoäng 

VB nhaäp vaø söûa caùc loãi thöôøng gaëp trong khi 

NSD nhaäp VB. Word seõ töï ñoäng söû khi baïn keát 

thuùc nhaäp 1 töø baèng SpaceBar 

Insert / Auto Text / AutoCorrect --> HÑT 
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 Correct TWo INitial CApitals: Baät taét cheá 

ñoä töï ñoäng söûa 2 kí tö hoa thaønh 1 kí töï hoa 

ôû ñaàu moãi töø 

 Capitalizes first letter of sentences: Baät 

taét cheá ñoä töï ñoäng söûa kí töï ñaàu caâu thaønh 

chöõ hoa 
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 Capitalize names of days: Baät taét cheá ñoä 

töï ñoäng söûa teân ngaøy trong tuaàn thaønh chöõ 

hoa 

 Correct accidental usage of cAPLOCK 

key: Baät taét cheá ñoä töï ñoäng phaùt hieän vaø baät 

laïi phím Caplock trong tröôøng hôïp queân 

khoâng taét phím Caplock 

 Replace text as you type: Baät taét cheá ñoä 

töï ñoäng söûa töø nhaäp trong Replace (töø sai) 

baèng töø nhaäp trong With (töø ñuùng). Ñeå  thöïc 

hieän ñöôïc chöùc naêng naøy phaûi taïo tröôùc  --> 

coù theå thay theá cho chöùc naêng Auto Text 

 

VI. CAÙC CHEÁ ÑOÄ SOAÏN THAÛO 

Trong vieäc soaïn thaûo vaø trình baøy vaên baûn coù caùc 

cheá ñoä sau: Normal, Web Layout, Print Layout, 

Outline 

 

Normal duøng khi nhaäp, hieäu chænh, ñònh 

daïng taøi lieäu 

Print Layout duøng khi ñònh daïng tröôùc khi in aán. 

Trong cheá ñoä naøy taøi lieäu khi in ra 

gioáng nhö xuaát hieän treân maøn hình 

(WYSWYG). 

 

Ñeå chuyeån qua laïi giöõa caùc cheá ñoä trình baøy vaên 

baûn ta choïn leänh View/Normal hoaëc View/Print 

Layout 
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VII. ÑÒNH DAÏNG BAÈNG CAÙC PHÍM TAÉT 

Canh traùi Ctrl + L 

Canh phaûi Ctrl + R 

Canh giöõa Ctrl + E 

Canh ñeàu 2 beân Ctrl + J  

Chöõ ñaäm Ctrl + B  

Chöõ nghieâng Ctrl + I  

Gaïch döôùi moät neùt Ctrl + U  

Gaïch döôùi töøng töø Ctrl + Shift + W 

Gaïch döôùi hai neùt Ctrl + Shift + D 

Chæ soá döôùi H2O Ctrl + daáu =  

Chæ soá treân X2 Ctrl + Shift + =  

Chöõ hoa nhoû Ctrl + Shift + K  

Che daáu vaên baûn Ctrl + Shift + H  

Kieåu chöõ (Font) Ctrl + D  

Taêng kích thöôùc chöõ leân moät  Ctrl + ]  

Giaûm kích thöôùc  chöõ xuoáng moät Ctrl + [  

Môû vaên baûn  Ctrl + O 

Ñoùng vaên baûn  Ctrl + F4 

Löu vaên baûn  Ctrl + S 

In vaên baûn  Ctrl + P 

Sao cheùp  Ctrl + C 

Caét vaên baûn  Ctrl + X 

Daùn vaên baûn  Ctrl + V 

Huûy moät leänh do laøm sai  Ctrl + Z 

Chöõ hoa lôùn  Ctrl + Shift + A  
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CHƢƠNG 2 : MICROSOFT  EXCEL 

 

I.  KHÔÛI ÑOÄNG 

Caùch 1: Double Click leân Shortcut Microsoft Excel 

treân neàn Desktop cuûa Windows 

Caùch 2: Start/Programs/Microsoft Excel 

 

II.  GIÔÙI THIEÄU GIAO DIEÄN 

Sau khi khôûi ñoäng Excel, giao dieän Excel goàm caùc 

thaønh phaàn sau: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Title 

Bar 

Menu 

Bar 

StandardT

oolbar 

Formatting 

Toolbars 

Sheet 

Tab 

Status 

Bar 

Works

heet 

Formula 

Bar 
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Title Bar: Thanh tieâu ñeà chöùa teân cuûa Workbook 

ñang môû. Moät taäp tin cuûa Excel ñöôïc goïi laø 1 

Workbook, moãi Workbook coù theå coù ñeán 255 

sheet. 

Menu Bar: Thanh trình ñôn chöùa caùc leänh cuûa 

Excel 

Standard Toolbar: Thanh coâng cuï chuaån chöùa caùc 

nuùt leänh thoâng duïng veà File, Edit (neân luoân cho 

hieän) 

Formatting Toolbar: Thanh ñònh daïng chöùa caùc nuùt 

leänh thoâng duïng veà trình baøy noäi dung baûng tính 

(neân luoân cho hieän) 

Ngoaøi 2 thanh coâng cuï naøy ta coøn coù nhieàu thanh 

coâng cuï khaùc, maø muoán aån hay hieän söû duïng leänh 

ViewToolbars… 

Formula Bar: Doøng chöùa döõ lieäu nhaäp hoaëc coâng 

thöùc cuûa oâ hieän haønh 

Sheet Tab: Chöùa teân caùc Worksheet coù trong 

Workbook 

Status Bar: Thanh traïng thaùi cho bieát tình traïng 

hieän haønh nhö cheá ñoä laøm vieäc, tình traïng caùc 

phím NumLock, CapsLock,… 

Goùc phaûi thanh traïng thaùi cho bieát traïng thaùi laøm 

vieäc hieän taïi nhö:  

Ready: ñang saün saøng chôø nhaäp döõ lieäu hay 

coâng thöùc 
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Enter: Ñang nhaäp döõ lieäu hay coâng thöùc vaøo oâ 

hieän haønh 

Point: Ñang ghi moät coâng thöùc tham chieáu ñeán 

moät oâ 

Edit: Ñang hieäu chænh döõ lieäu hay coâng thöùc cuûa 

oâ hieän haønh 

 

III.  CAÁU TRUÙC WORKBOOK 

Workbook laø taäp tin cuûa Excel coù phaàn môõ roäng laø 

.XLS. Moãi Workbook coù theå coù ñeán 255 

Worksheet, moãi Worksheet coù teân phaân bieät. 

1. Giôùi thieäu Worksheet 

Moät Worksheet goàm coù: 

65536 doøng ñöôïc ñaùnh soá töø 1 ñeán 65536 töø treân 

xuoáng döôùi 

255 coät ñöôïc ñaùnh töø traùi sang phaûi : A, B, C,…, Z, 

AA, AB,…,AZ, BA, BB,.. IV 

Giao cuûa 1 doøng vaø 1 coät goïi laø oâ (cell). Moãi oâ coù 

1 ñòa chæ phaân bieät ñöôïc xaùc ñònh baèng <coätdoøng>. 

Ví duï C7 laø oâ giao giöõa coät C vaø doøng soá 7 

Khoái(range) laø taäp hôïp caùc oâ lieân tuïc taïo neân 1 

hình chöõ nhaät. Ñòa chæ cuûa moät khoái ñöôïc xaùc ñònh 

bôûi ñòa chæ cuûa oâ ôû goùc traùi treân vaø ñòa chæ cuûa oâ ôû 

goùc phaûi döôùi cuûa hình chöõ nhaät phaân caùch nhau 

bôûi daáu hai chaám(:). Ví duï: B3:D4 laø ñòa chæ cuûa 

khoái chöõ nhaät goàm caùc oâ B3, C3, D3, B4, C4, D4. 

 

2.Di chuyeån trong Worksheet: 
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Taïi moät thôøi ñieåm chæ coù 1 oâ laø hieän haønh(con troû 

oâ seõ ñònh vò taïi ñoù). Ñòa chæ cuûa oâ hieän haønh xuaát 

hieän taïi phaàn Name box cuûa thanh Fomula Bar. Ñeå 

choïn oâ hieän haønh ta coù theå duøng caùc caùch sau: 

- Click mouse taïi oâ 

- Goõ ñòa chæ oâ taïi hoäp Name box cuûa thanh 

Fomula Bar roài nhaán Enter 

- Duøng caùc phím ñieàu khieån ñeå di chuyeån con troû 

oâ ñeán oâ mong muoán 

 

Caùc phím di chuyeån con troû oâ: 

 di chuyeån con troû oâ sang oâ 

keá caän beân phaûi 

 di chuyeån con troû oâ sang oâ 

keá caän beân traùi 

 di chuyeån con troû oâ sang oâ 

keá caän beân treân 

 di chuyeån con troû oâ sang oâ 

keá caän beân döôùi 

PgUp leân trang keá treân(trang maøn 

hình) 

PgDn xuoáng trang keá döôùi 

Home veà oâ ñaàu tieân cuûa doøng hieän 

taïi 

Ctrl+Home veà oâ A1 

 

3. Thao taùc treân Worksheet 
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Maëc ñònh khi taïo 1 Workbook môùi thì noù seõ coù 3 

Worksheet coù teân laàn löôït laø Sheet1, Sheet2, 

Sheet3 

- Ñeå cheøn theâm 1 Worksheet ta söû duïng leänh 

Insert/Worksheet 

- Ñeå choïn Worksheet laøm vieäc, click vaøo teân 

Worksheet treân thanh Sheet Tab 

- Ñeå ñoåi teân Worksheet: Right-Click leân teân 

Worksheet caàn ñoåi -> xuaát hieän menu, choïn 

leänh Rename: goõ teân môùi roài Enter 

- Ñeå xoùa Worksheet: Right-Click leân teân 

Worksheet caàn xoùa -> xuaát hieän menu, choïn 

leänh Delete seõ xuaát hieän hoäp thoaïi yeâu caàu xaùc 

nhaän. Choïn OK seõ xoùa, Cancel seõ khoâng xoùa 

- Ñeå di chuyeån Worksheet: Drag teân Worksheet 

treân thanh Sheet Tab ñeán vò trí môùi 

- Ñeå sao cheùp 1 sheet: giöõ phím Ctrl, drag teân 

Worksheet ñeán vò trí môùi seõ taïo 1 baûn sao gioáng 

heät veà noäi dung 

 

Nhaäp döõ lieäu: (neáu oâ hieän coù chöùa noäi dung thì seõ 

bò thay theá baèng noäi dung môùi) 

- Choïn oâ caàn nhaäp döõ lieäu 

- Nhaäp noäi dung xong nhaán Enter hoaëc caùc phím 

di chuyeån con troû oâ 

Hieäu chænh döõ lieäu: 

- Choïn oâ caàn hieäu chænh 
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- Nhaán phím F2, hieäu chænh noäi dung xong nhaán 

Enter 

Xoùa döõ lieäu: 

- Choïn oâ caàn xoùa noäi dung 

- Nhaán phím Delete 

 

IV. CAÙC KIEÅU DÖÕ LIEÄU 

Moãi oâ chæ coù theå chöùa 1 kieåu döõ lieäu maø thoâi. Caùc 

kieåu döõ lieäu goàm: 

 

1. Kieåu soá 

Coù theå laø soá nguyeân hoaëc soá thöïc. Löu yù khi nhaäp 

soá thöïc thì phaàn phaân caùch thaäp phaân phaûi goõ daáu 

chaám. 

Kieåu Ngaøy Giôø cuõng laø kieåu soá 

Maêc ñònh kieåu soá seõ canh phaûi trong oâ 

 

2. Kieåu chuoåi 

Laø döõ lieäu khoâng duøng trong caùc pheùp tính soá hoïc. 

Neáu soá khoâng duøng ñeå tính toaùn thì bieåu dieãn döôùi 

daïng chuoåi baèng caùch nhaäp daáu nhaùy ñôn vaøo 

tröôùc chuoåi soá. Maëc ñònh döõ lieäu kieåu chuoåi seõ 

canh traùi trong oâ.  

 

3. Kieåu luaän lyù 

Laø döõ lieäu chæ coù 1 trong 2 giaù trò laø TRUE hoaëc 

FALSE 
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4. Coâng thöùc 

Noäi dung cuûa oâ coøn coù theå chöùa coâng thöùc. Taát caû 

coâng thöùc khi nhaäp vaøo oâ luoân baét ñaàu laø daáu baèng 

(=). Coâng thöùc laø söï keát hôïp cuûa caùc toaùn töû vaø caùc 

toaùn haïng vaø luoân traû veà 1 giaù trò xaùc ñònh thuoäc 1 

trong caùc kieåu döõ lieäu treân. 

VD: trong oâ C4 ta goõ coâng thöùc sau: =A4+2*(A4-

B4)/SUM(1,4,7,52) 

Caùc toaùn töû goàm coù: +, -, *, / 

Caùc toaùn haïng: ñòa chæ oâ (A4, B4), haøm(SUM), 

haèng(2,1,2,7,52), … 

 

 Caùc toaùn töû soá hoïc: +(coäng), -(tröø), *(nhaân), 

/(chia) 

 Toaùn töû noái chuoåi: & (vd: “TTTH “ & 

“CCS”  “TTTH CCS”) 

 Toaùn töû so saùnh:  

<  nhoû hôn 

<=nhoû hôn hay baèng 

=  baèng 

> lôùn hôn 

>= lôùn hôn hay baèng 

<> khaùc 

Caùc bieåu thöùc so saùnh luoân traû veà 1 trong 2 

giaù trò: TRUE(neáu laø bieåu thöùc ñuùng), 

FALSE (neáu laø bieåu thöùc sai) 

 Toaùn töû luaän lyù : Bao goàm caùc toaùn töû  AND 

, OR , NOT 
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    Duøng ñeå lieân keát nhieàu pheùp so saùnh 

 Keát quaû cuûa pheùp luaän lyù 

   

So saùnh 1 AND  So saùnh 2 Keât quaû 

True  True True 

True  False False 

False  True False 

False  False False 

 OR   

True  True True 

True  False True 

False  True True 

False  False False 

 NOT   

  True False 

  False True 

 

V.  THAO TAÙC TREÂN KHOÁI 

Khoái laø moät vuøng lieân tuïc caùc oâ taïo thaønh 1 hình 

chöõ nhaät ñöôïc xaùc ñònh bôûi ñòa chæ cuûa oâ ôû goùc traùi 

treân vaø ñòa chæ cuûa oâ ôû goùc phaûi döôùi vieát phaân 

caùch nhau baèng 1 daáu hai chaám (:) 

 

1. Thao taùc choïn 

Choïn 1 doøng: click mouse vaøo tieâu ñeà doøng 

Choïn nhieàu doøng lieân tuïc: ví duï choïn caùc doøng töø 

3 ñeán 7. Click giöõ mouse taïi tieâu ñeà doøng soá 3 vaø 

drag mouse ñeán tieâu ñeà doøng soá 7 
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Choïn 1 coät: click mouse vaøo tieâu ñeà coät 

Choïn nhieàu coät lieân tuïc: ví duï choïn caùc coät töø B 

ñeán F. Click giöõ mouse taïi tieâu ñeà coät B vaø drag 

mouse ñeán tieâu ñeà coät F 

Choïn toaøn boä baûng tính: click mouse taïi giao ñieåm 

cuûa tieâu ñeà doøng vaø coät 

Choïn 1 khoái caùc oâ lieân tuïc: 

Duøng mouse: Drag mouse töø ñòa chæ ñaàu cuõa khoái 

(goùc traùi treân) ñeán ñòa chæ cuoái cuûa khoái(goùc phaûi 

döôùi) 

Duøng keyboard: ñònh vò con troû oâ taïi oâ ñaàu tieân cuûa 

khoái (goùc traùi treân). Giöõ phím Shift vaø nhaán caùc 

phím di muõi teân ( ) ñeå choïn khoái mong 

muoán 

 

2. Xoùa 

Choïn oâ, doøng, coät, toaøn boä baûng tính hay khoái caàn 

xoùa noäi dung roài nhaán phím Delete (chæ xoùa noäi 

dung). 

Ngoaøi ra ta coøn coù theå choïn caùc leänh xoùa khaùc nhö 

sau: 

Leänh Edit/Clear/All xoùa taát caû 

Leänh Edit/Clear/Formats chæ xoùa ñònh daïng 

Leänh Edit/Clear/Contents chæ xoùa noäi dung 

Leänh Edit/Clear/Comments chæ xoùa ghi chuù 

 

3. Sao cheùp döõ lieäu 

b1: Choïn khoái caàn sao cheùp 
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b2: Choïn leänh Edit/Copy hoaëc nhaán Ctrl+C 

b3: Ñònh vò con troû oâ taïi oâ ñaàu tieân cuûa khoái ñích 

b4: Choïn leänh Edit/Paste hoaëc nhaán Ctrl+V 

 

4. Di chuyeån döõ lieäu 

Gioáng Sao cheùp döõ lieäu, chæ khaùc ôû böôùc 2 

b2: choïn leänh Edit/Cut hoaëc nhaán Ctrl+X 

 

Ghi chuù: Neáu khoái caàn sao cheùp khoâng coù oâ naøo laø 

coâng thöùc thì khoái ñích seõ gioáng heät khoái nguoàn 

Neáu khoái caàn sao cheùp coù chöùa coâng thöùc thì vieäc 

sao cheùp naøy laø sao cheùp coâng thöùc vaø do ñoù keát 

quûa ôû vuøng ñích coù theå thay ñoåi tuøy thuoäc vieäc söû 

duïng ñòa chæ trong coâng thöùc 

Khi di chuyeån khoái thì keát quûa khoâng thay ñoåi 

 

5.  Söû duïng caùc loaïi ñòa chæ trong sao cheùp coâng 

thöùc 

Coù 3 loaïi ñòa chæ trong Excel: Tuyeät ñoái, töông ñoái 

vaø hoãn hôïp. Caùch vieát: 

Tuyeät ñoái: $A$7, $B$20:$D$22, ... 

Töông ñoái: A7, B20:D22, ... 

Hoãn hôïp: A$7, $A7, ... 

Khi laäp coâng thöùc cho 1 oâ vaø sao cheùp coâng thöùc 

ñoù cho caùc oâ coù caùch tính cuøng loaïi thì tuøy thuoäc 

caùch toå chöùc baûng tính maø ta söû duïng caùc loaïi ñòa 

chæ cho phuø hôïp. 
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 Ví duï veà duøng ñòa chæ töông ñoái : 

 

 

Khi sao cheùp coâng thöùc cuûa E4 cho E5, E6 

 

Ví duï veà duøng ñòa chæ tuyeät ñoái theo haøng: 

 

 

Khi sao cheùp coâng thöùc cuûa D4 cho D5, D6 
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Ví duï veà duøng ñòa chæ tuyeät ñoái theo coät: 

 

 

Khi sao cheùp coâng thöùc cuûa C7 cho D7, E7 

  

Ví duï veà duøng ñòa chæ tuyeät ñoái : 

 

Khi sao cheùp coâng thöùc cuûa D4 cho D5, D6, F4, 

F5, F6 

 

VI. CAÙC LEÄNH VEÀ TAÄP TIN 

1. Môû 1 Workbook ñang toàn taïi treân ñóa 

Choïn leänh File/Open hoaëc Click vaøo nuùt Open treân 

thanh Standard Toolbar  xuaát hieän hoäp thoaïi: 
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Trong muïc Files of type: choïn All Microsoft Excel 

Files 

Trong muïc Look in choïn folder coù chöùa taäp tin caàn 

môû 

Choïn teân taäp tin roài click leân nuùt Open 

Coù theå môû nhieàu Workbook ñoàng thôøi. Neáu coù 

nhieàu Workbook ñang môû thì chuyeån qua laïi giöõa 

caùc Workbook baèng caùch duøng menu Window 

 

2. Ñoùng Workbook ñang môû 

Choïn leänh File/Close ñeå ñoùng Workbook hieän 

haønh. 

Ñeå ñoùng taát caû Workbook ñang môû thì nhaán phím 

Shift ñoàng thôøi choïn leänh File/Close. 

 

3. Taïo Workbook môùi 
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Choïn leänh File/New hoaëc Click vaøo nuùt New treân 

thanh Standard Toolbar. 

 

4. Löu Workbook 

Coù 2 leänh duøng ñeå löu Workbook laø 

File/Save 

File/Save as 

 

Trong tröôøng hôïp Workbook chöa coù teân thì leänh 

Save vaø Save as laø nhö nhau. Excel seõ xuaát hieän 

hoäp thoaïi: 

 

 

 

Khi löu tröõ Workbook phaûi xaùc ñònh roõ: 

 Teân Workbook laø gì (ñaët teân cho gôïi nhôù) 

(muïc File name) 
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 Löu trong Folder naøo cuûa oå ñóa naøo? 

(muïc Save in) 

 

VII. THAO TAÙC ÑÒNH DAÏNG 

 

I. MOÄT SOÁ CAÙC THIEÁT ÑAËT CAÀN THIEÁT 

Sau khi khôûi ñoäng Excel, choïn leänh Tools/Options 

 xuaát hieän hoäp thoaïi, choïn Tab General vaø thay 

ñoåi moät soá thieát ñaët sau: 

Standard font: choïn font maëc ñònh cho toaøn boä 

baûng tính vaø thanh Fomula bar. 

Default file location: choïn folder maëc ñònh khi löu, 

môû Workbook 

Sau khi choïn xong choïn OK, thoaùt khoûi Excel. Moãi 

khi khôûi ñoäng Excel thì nhöõng thieát ñaët naøy seõ coù 

hieäu löïc. 

 

2.THAY ÑOÅI ÑOÄ ROÄNG COÄT, CHIEÀU CAO 

HAØNG 

 Thay ñoåi ñoä roäng coät 

Muoán thay ñoåi ñoä roäng coät naøo thì ñöa mouse ñeán 

ñöôøng phaân ranh giöõa coät ñoù vaø coät keá caän beân traùi 

treân haøng tieâu ñeà coät vaø drag 

Ñeå thay ñoåi ñoä roäng cuûa 1 hoaëc nhieàu coät baèng 

nhau thì choïn chuùng roài 

duøng leänh: 

Format/Column/Width 

thì xuaát hieän hoäp thoaïi: 
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Nhaäp giaù trò môùi roài OK 

 

 Thay ñoåi ñoä cao haøng 

Muoán thay ñoåi ñoä cao haøng naøo thì ñöa mouse ñeán 

ñöôøng phaân ranh giöõa haøng ñoù vaø haøng keá caän beân 

döôùi treân coät tieâu ñeà doøng vaø drag 

Ñeå thay ñoåi ñoä cao cuûa 1 hoaëc nhieàu haøng baèng 

nhau thì choïn chuùng roài 

duøng leänh: 

Format/Row/Height thì 

xuaát hieän hoäp thoaïi: 

Nhaäp giaù trò môùi roài OK 

 

 3. ÑÒNH DAÏNG TRÌNH BAØY KIEÅU DÖÕ LIEÄU 

SOÁ 

 Döõ lieäu Date 

Vieäc nhaäp döõ lieäu kieåu ngaøy vaøo oâ tuøy thuoäc vaøo 

thieát ñaët trong Control Panel. Do ñoù phaûi thieát ñaët 

kieåu nhaäp tröôùc khi nhaäp döõ lieäu kieåu ngaøy. 

Trong Control Panel, double click leân bieåu töôïng 

Regional Options  hoäp thoaïi, trong hoäp thoaïi naøy 

choïn tab Date, trong muïc Short date format nhaäp 

vaøo: dd/mm/yy  Apply  OK 
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 Döõ lieäu Number 

Khi nhaäp döõ lieäu kieåu soá phaûi löu yù: 

Duøng daáu chaám cho kyù hieäu phaân caùch thaäp phaân 

Khoâng ñöôïc nhaäp daáu phaân caùch haøng ngaøn. 

Vd: Ñeå trình baøy soá: 12.542.123,51 

Nhaäp: 12542123.51 

Sau ñoù ñònh daïng ñeå hieån thò theo maãu mong muoán 

baèng caùch choïn leänh Format/Cells  hoäp thoaïi: 
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choïn tab Number, choïn muïc Custom vaø thieát ñaët 

theo maãu  

 

 

Ghi chuù: Ñoái vôùi döõ lieäu kieåu soá nhö Ngaøy, Giôø, soá 

nguyeân, soá thöïc, phaàn traêm,… Sau khi nhaäp xong ta 

coù theå trình baøy hieån thò noù theo baát cöù daïng thöùc 

naøo baèng caùch vaøo leänh Format/Cells vaø thieát ñaët 

theo caùc maãu mong muoán. Neáu trong caùc loaïi 

khoâng coù maãu mong muoán thì choïn Custom vaø 

nhaäp maãu ñònh daïng taïi hoäp Type 
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VIII. ÑÒNH DAÏNG TRÌNH BAØY NOÄI DUNG 

TRONG OÂ 

Maëc ñònh neáu döõ lieäu nhaäp vaøo oâ laø daïng soá thì seõ 

ñöôïc canh phaûi trong oâ, neáu laø chuoåi thì seõ canh 

traùi trong oâ. Sau ñoù ta coù theå cho canh traùi, phaûi, 

giöõa baèng caùch söû duïng caùc nuùt leänh töông öùng 

treân thay Formatting toolbar 

Ngoaøi ra ta coøn coù caùc caùch trình baøy khaùc khi 

choïn leänh Format/Cells vaø choïn tab Alignment 

 

 

Trong muïc: 
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Horizontal coù caùc choïn löïa sau: (theo chieàu 

ngang) 

General trình baøy noäi dung 

theo vò trí maëc ñònh 

Left canh traùi 

Right canh phaûi 

Fill laäp laïi noäi dung ñeå 

ñieàn ñaày chieàu roäng oâ 

Justify canh ñeàu 2 beân khi 

döõ lieäu nhieàu hôn 1 doøng 

Center Across Selection canh giöõa noäi dung 

trong khoái löïa choïn 

 

Vertital coù caùc choïn löïa sau: (theo chieàu cao) 

Top trình baøy noäi dung 

baùm ñænh 

Center trình baøy noäi dung 

baùm giöõa 

Bottom trình baøy noäi dung 

baùm ñaùy 

Justify trình baøy noäi dung 

ñeå ñieàn ñaày chieàu cao oâ 

 

Oreintation: höôùng trình baøy döõ lieäu trong oâ 

 

Trong Text control coù caùc checkbox sau: 

 Wrap text döõ lieäu seõ trình baøy 

trong oâ nhieàu haøng 
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neáu ñoä roäng oâ 

khoâng ñuû 

 Shrink to fit döõ lieäu seõ giaûm kích 

thöôùc neáu 1 haøng 

khoâng trình baøy heát 

 Merge cells troän caùc oâ ñöôïc 

choïn thaønh moät oâ 

 

IX.  ÑÒNH DAÏNG KYÙ TÖÏ 

Ñeå ñònh daïng kyù töï cho 1 oâ hoaëc khoái thì choïn oâ 

hay khoái roài duøng leänh Format/Cells  hoäp thoaïi, 

choïn tab Font 
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Choïn Font, Font style, Size, caùc daïng underline, 

Effects, … 

Ñeå ñònh daïng cho 1 phaàn noäi dung trong oâ thì ñaàu 

tieân choïn löïa tröôùc (double click leân oâ, choïn phaàn 

noäi dung) roài choïn leänh Format/Cells. 

 

X. KEÛ KHUNG 

B1: Choïn khoái caàn keû khung 

B2: Thöïc hieän leänh Format/Cellshoäp thoaïi, choïn 

tab Border 
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B3: Choïn loaïi neùt trong Line 

B4: Click choïn caùc vò trí caàn keû trong Presets vaø 

Border 

Laäp laïi böôùc B3, B4 cho loaïi neùt vaø vò trí keû khaùc 

B5: Click OK ñeå ñoùng hoäp thoaïi laïi 

 

XI. TOÂ NEÀN 

B1: Choïn khoái caàn toâ neàn 

B2: Thöïc hieän leänh Format/Cellshoäp thoaïi, choïn 

tab Patterns 
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B3: Choïn maãu trong Pattern, maøu saéc trong Color 

B4: Click OK ñeå ñoùng hoäp thoaïi laïi 

 

XII. THAO TAÙC DÖÕ LIEÄU 

 THAO TAÙC CHEØN 

 1. Cheøn coät 

B1: Choïn 1 hoaëc n coät (drag tieâu ñeà coät) 

B2: Choïn leänh Insert/Columns 

Seõ cheøn vaøo 1 hoaëc n coät troáng tröôùc caùc coät ñöôïc 

choïn 

 

 2. Cheøn doøng 
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B1: Choïn 1 hoaëc n doøng (drag tieâu ñeà doøng) 

B2: Choïn leänh Insert/rows 

Seõ cheøn vaøo 1 hoaëc n doøng troáng tröôùc caùc doøng 

ñöôïc choïn 

 

 3. Cheøn oâ 

B1: Choïn 1 hoaëc n oâ 

B2: Choïn leänh Insert/Cells  hoäp thoaïi 

 

  Shift cells right: cheøn 

ñuùng soá oâ troáng ñöôïc 

choïn ngay taïi khoái 

choïn, ñaåy taát caû caùc 

oâ ñöôïc choïn vaø taát caû 

caùc oâ beân phaûi noù 

sang phaûi. 

 Shift cells down: 

cheøn ñuùng soá oâ troáng ñöôïc choïn ngay taïi khoái 

choïn, ñaåy taát caû caùc oâ ñöôïc choïn vaø taát caû caùc 

oâ beân döôùi noù xuoáng döôùi. 

 

 THAO TAÙC XOÙA 

 1. Xoùa coät 

B1: Choïn 1 hoaëc n coät (drag tieâu ñeà doøng) 

B2: Choïn leänh Edit/Delete 

Caùc coät ñöôïc choïn seõ xoùa, noäi dung caùc coät beân 

phaûi noù seõ doàn sang traùi 
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 2. Xoùa doøng 

B1: Choïn 1 hoaëc n doøng 

(drag tieâu ñeà doøng) 

B2: Choïn leänh 

Edit/Delete 

Caùc doøng ñöôïc choïn seõ 

xoùa, noäi dung caùc doøng 

döôùi noù seõ doàn leân treân 

 

3. Xoùa oâ 

B1: Choïn 1 hoaëc n oâ 

B2: Choïn leänh Edit/Delete… hoäp thoaïi 

  Shift cells left: xoùa caùc oâ ñöôïc choïn, dôøi taát caû 

caùc oâ beân phaûi noù sang traùi 

 Shift cells up: xoùa caùc oâ ñöôïc choïn, dôøi taát caû 

caùc oâ beân döôùi noù leân treân 

 

 THAO TAÙC CHEÙP 

 1.  Sao cheùp coâng thöùc 

Ñieåm tieän lôïi cuûa Excel laø vaán ñeà sao cheùp coâng 

thöùc. Sau khi thieát laäp coâng thöùc cho 1 oâ, ta deã 

daøng sao cheùp coâng thöùc naøy ñeán taát caû nhöõng oâ 

khaùc coù cuøng caùch tính. (löu yù söû duïng caùc loaïi ñòa 

chæ cho ñuùng) 
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Sau khi thieát laäp coâng thöùc cho oâ E3, ñeå sao cheùp 

coâng thöùc cuûa oâ naøy xuoáng caùc oâ E4, E5 ta duøng 1 

trong 2 caùch: 

Caùch 1: Duøng leänh Copy vaø Paste 

Caùch 2: Dôøi con troû chuoät ñeán Fill handle cuûa oâ 

nguoàn (E3), khi naøo con troû chuoät bieán thaønh daáu + 

thì drag mouse xuoáng caùc oâ E4, E5 

 

 2.  Sao cheùp ñaëc bieät 

Fill handle 
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B1: Choïn 1 hoaëc nhieàu oâ caàn sao cheùp 

B2: Choïn leänh Edit/Copy hoaëc Ctrl+C 

B3: Choïn oâ ñaàu tieân cuûa ñích 

B4: choïn leänh Edit/Paste Special  hoäp thoaïi 

 

  Formulas: chæ sao cheùp coâng thöùc 

  Values: sao cheùp giaù trò hieän taïi cuûa caùc oâ 

nguoàn ñeán ñích 

  Formats: chæ sao cheùp ñònh daïng (gioáng Format 

Painter) 

  Comments: chæ sao cheùp ghi chuù 

  All: sao cheùp bình thöôøng nhö leänh Edit/Paste 
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XIII. Filter:  

1/ Chöùc naêng: Choïn loïc döõ lieäu theo 1 ñieàu 

kieän naøo ñoù 

VD: Töø baûng döõ lieäu sau, loïc ra nhöõng nhaân 

vieân trong TSX (toå saûn xuaát); Hoaëc loïc ra 

nhöõng nhaân vieân laø CN (coâng nhaân) coù 3<HS 

löông <4; ... 

Coù 2 phöông thöùc loïc döõ lieäu:Loïc töï ñoäng vaø 

loïc naâng cao 

 

Loïc töï ñoäng:  Ñieàu kieän loïc ñôn giaûn  

 Loïc taïi choã (giaáu nhöõng Record 

khoâng thoûa maõn ñieàu kieän ñi 

Loïc naâng cao: Ñieàu kieän loïc phöùc taïp hôn 

  Trích loïc danh saùch caùc Record 

thoûa maõn ñ/k loïc ra 1 baûng 

2/ Loïc töï ñoäng: 

 Ñeå con troû trong baûng döõ lieäu 

 Data / Filter / AutoFilter --> xuaát hieän 

caùc ComboBox beân caïnh teân Field 
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 Ñeå taïo ñ/k loïc cho Field naøo Click vaøo 

ListBox cuûa Field ñoù --> Xuaát hieän List 

sau.  

 

 

 Ñeå loïc ra nhöõng nhaân vieân trong TSX (toå saûn 

xuaát) --> Choïn TSX 

 Ñeå loïc ra nhöõng nhaân vieân trong TSX (toå saûn 

xuaát) vaø PKH (phoøng keá hoaïch)  

 Choïn Custom --> HÑT 

Huûy loïc 

Choïn caùc Record coù giaù trò naèm trong Top 

(lôùn nhaát hoaëc nhoû nhaát) 

Neáu ñ/k phöùc taïp --> Choïn Custom -->HÑT 

(coù giaûi thích ôû phaàn sau) 

Choïn giaù trò laøm ñ/k loïc neáu ñ/k laø chính xaùc 1 

giaù trò naøo ñoù. VD loïc ra caùc nhaân vieân ôû TSX 
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Chuù yù:  

* Coù theå choïn ñ/k cuøng luùc cho nhieàu Field. VD 

Loïc ra nhöõng nhaân vieân ôû TSX vaø coù baäc löông 

>3.1 --> Choïn ñ/k cho 2 Field: Ñôn vò vaø HS 

Löông 

* Khi chuyeån sang Ñ/k loïc khaùc phaûi huûy ñ/k 

loïc cuõ baèng caùch choïn laïi muïc Al trong List 

* Ñeå thoaùt khoûi leänh loïc --> Choïn laïi Data / 

Filter / AutoFilter 

3/ Loïc naâng cao: 

Caùc böôùc: 

a/ Taïo baûng ñ/k (BÑK):  

BÑK bao goàm I khoái töø 2 oâ trôû leân 

 Haøng ñaàu goàm teân caùc Field laøm ñ/k loïc   

 Caùc haøng tieáp theo goàm caùc oâ gaøi giaù trò caàn 

loïc (oâ ñ/k –OÂÑK). 

 BÑK ñöôïc ñaët taïi baát cöù vò trí naøo treân BT 

   Choïn pheùp so saùnh 1                                     
Choïn giaù trò 1 

 Choïn toaùn töû 

Chæ cho 

pheùp toái 

ña 2 ñ/k 

   Choïn giaù trò ñ/k 1                                     

Choïn giaù trò 1 
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 Khi taïo BÑK caàn chuù yù  

 Neáu ñk laø chính xaùc 1 giaù trò naøo ñoù thì 

gaøi giaù trò ñoù vaøo OÂÑK 

VD: loïc ra nhöõng nhaân vieân thuoäc TSX 

Ñôn vò 

TSX 

 Neáu ñ/k loïc hoaëc thoûa maõn ñ/k naøy hoaëc 

thoûa maõn ñ/k kia --> caùc ñ/k naøy phaûi gaøi 

vaøo caùc oâ treân caùc haøng khaùc nhau 

VD: Loïc ra nhöõng nhaân vieân thuoäc TSX 

hoaëc PKH 

Ñôn vò 

TSX 

PKH 

 Neáu ñ/k loïc ñoàng thôøi phaûi thoûa maõn ñ/k 

naøy hoaëc thoûa maõn ñ/k kia --> caùc giaù trò 

naøy phaûi gaøi vaøo caùc oâ treân cuøng 1 haøng.  

VD: Loïc ra nhöõng nhaân vieân ôû TSX vaø coù 

HS löông >3.1 

Ñôn vò HS 

löông 

TSX >3.1 

VD khaùc: Loïc ra nhöõng nhaân vieân coù HS 

löông  naèm trong khoaûng töø 3.1 ñeán 4.1 

 

HS 

löông 

HS 

löông 

>3.1 <4.1 

Teân Field ñ/k 

OÂÑK 
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 Coù theå duøng caùc kí töï * vaø ? ñeå gaøi vaøo  

oâÑK 

VD Loïc ra nhöõng ngöôøi coù teân baét ñaàu 

baèng chöõ T 

Teân 

T* 

 

VD sau ñaây thöïc hieän leänh trích ghi DS nhöõng 

nhaân vieân thuoäc Ñôn vò TSX 

 

 

 b/ Choïn leänh: Data / Filter / AdvancedFilter --> 

HÑT 

BÑK 

(H3:H4) 

Baûng trích ghi seõ baét ñaàu taïi oâ naøy (A17) 

Baûng döõ lieäu 

(A3:F15) 

(H3:H4) 
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CAÙC HAØM THOÂNG DUÏNG 

I.  CAÙC HAØM VEÀ SOÁ 

 1. INT(number) 

Laøm troøn number xuoáng ñeán soá nguyeân gaàn nhaát 

Vd: INT(5.9)  5 

INT(-4.3) -5 

 

 2. MOD(number, divisor) 

number vaø divisor phaûi laø soá nguyeân 

Haøm traû veà phaàn dö cuûa pheùp chia nguyeân number 

cho divisor 
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Vd: MOD(26,3)  2 

 

 3. MAX(number1, number2, …) 

Traû veà giaù trò lôùn nhaát trong caùc soá number1, 

number2, … 

Vd: MAX(15, 7, 12)  15 

 

 4. MIN(number1, number2, …) 

Traû veà giaù trò nhoû nhaát trong caùc soá number1, 

number2, … 

Vd: MIN(15, 7, 12)  7 

 

 5. ROUND(number, num_digits) 

Laøm troøn number ñeán vò trí xaùc ñònh bôûi 

num_digits 

… 

num_digits=-3 laøm troøn ñeán haøng ngaøn 

num_digits=-2 laøm troøn ñeán haøng traêm 

num_digits=-1 laøm troøn ñeán haøng chuïc 

num_digits=0 laøm troøn ñeán haøng ñôn vò 

num_digits=1 laøm troøn ñeán 1 soá leû 

num_digits=2 laøm troøn ñeán 2 soá leû 

… 

Vd: A=57483.1652 

ROUND(A,0)  57483 

ROUND(A,1)  57483.2 

ROUND(A,2)  57483.17 

ROUND(A,-1)  57480 
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ROUND(A,-2)  57500 

ROUND(A,-3)  57000 

 

 6. AVERAGE(number1, number2, …) 

Traû veà trò trung bình cuûa caùc soá number1, 

number2, … 

Vd: AVERAGE(9, 4, 5)  6 

ROUND(AVERAGE(7,3,6),1)  5.3 

 7. SUM(number1, number2, …) 

Traû veà toång cuûa number1, number2, … 

Vd: SUM(15,2,3)  20 

 8. VALUE(text) 

Chuyeån chuoåi text daïng soá thanh soá ñeå coù theå tính 

toaùn 

 

II.  CAÙC HAØM VEÀ CHUOÅI 

 1. LEFT(text, num_chars) 

Traû veà num_chars kyù töï cuûa chuoåi text tính töø traùi 

Vd: LEFT(“TRUNG TAM TIN HOC”,9)  

TRUNG TAM 

 

 2. RIGHT(text, num_chars) 

Traû veà num_chars kyù töï cuûa chuoåi text tính töø phaûi 

Vd: LEFT(“TRUNG TAM TIN HOC”,7)  TIN 

HOC 

 

 3. MID(text, start_num, num_chars) 
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Traû veà num_chars kyù töï cuûa chuoåi text tính töø vò trí 

start_num 

Vd: MID(“TRUNG TAM TIN HOC”,5,7)  G 

TIN H 

 

4. UPPER(text) 

Traû veà text vôùi taát caû kyù töï chuyeån thaønh chöõ hoa 

Vd: UPPER(“Trung Tam Tin Hoc”)  TRUNG 

TAM TIN HOC 

 

 5. LOWER(text) 

Traû veà text vôùi taát caû kyù töï chuyeån thaønh chöõ 

thöôøng 

Vd: LOWER(“Trung Tam Tin Hoc”)  trung tam 

tin hoc 

 

 6. PROPER(text) 

Traû veà text vôùi taát caû kyù töï chuyeån thaønh chöõ 

thöôøng, caùc kyù töï ñaàu moãi töø laø chöõ hoa 

Vd: PROPER(“TRUNG TAM TIN HOC”)  

Trung Tam Tin Hoc 

 7. TRIM(text) 

Caét boû caùc khoaûng traéng thöøa: ñaàu chuoåi, cuoái 

chuoåi, giöõa 2 töø chæ coøn 1 khoaûng traéng 

Vd: 

TRIM(“ TRUNG TAM TIN HOC

”)  TRUNG TAM TIN HOC 
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III.  CAÙC HAØM LUAÄN LYÙ 

 1. AND(logical1, logical2, …) 

Traû veà TRUE neáu taát caû caùc bieåu thöùc luaän lyù 

logical1, logical2, … ñeàu coù giaù trò TRUE, traû veà 

FALSE neáu chæ caàn 1 bieåu thöùc luaän lyù logical traû 

veà FALSE 

Vd: AND(12>=5, 8+4/2<9, 32=31+1)  FALSE 

AND(12>=5, 8+4/2>9, 32=31+1)  TRUE 

 2. OR(logical1, logical2, …) 

Traû veà TRUE neáu chæ caàn 1 bieåu thöùc luaän lyù 

logical traû veà TRUE, neáu taát caû caùc bieåu thöùc luaän 

lyù coù giaù trò FALSE thì traû veà FALSE 

Vd: OR(12=5, 8+4/2<9, 32>=31+1)  FALSE 

OR(12=5, 8+4/2<9, 32=31+1)  TRUE 

 3. NOT(logical) 

Traû veà TRUE neáu logical coù giaù trò FALSE vaø 

ngöôïc laïi 

Vd: NOT(10>5)  FALSE 

 

IV. CAÙC HAØM ÑIEÀU KIEÄN 

 1. IF(logical_test, value_if_true, 

value_if_false) 

Ñònh trò bieåu thöùc logical_test. Neáu laø TRUE thì 

thöïc hieän bieåu thöùc value_if_true, ngöôïc laïi thöïc 

hieän value_if_false 

Vd: IF(A5<20, “Nho hon 20”, “Lon hon hay bang 

20”) 
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Neáu noäi dung oâ A5 nhoû hôn 20 thì traû veà chuoåi 

“Nho hon 20”, ngöôïc laïi traû veà chuoåi “Lon hon 

hay bang 20” 

 

 2. COUNTIF(range, criteria) 

Traû veà 1 soá nguyeân laø soá oâ naèm trong khoái range 

maø thoûa maõn ñieàu kieän criteria 

Trong ñoù range laø ñòa chæ khoái, criteria laø ñieàu 

kieän laø soá, bieåu thöùc hay chuoåi nhö 32, “32”, 

“>=30”, “apples” 

 

Giaû söû khoái A1:A4 chöùa laàn löôït caùc giaù trò 100, 

200, 300, 400 

COUNTIF(A1:A4, “>150”)  3 

 

 3. SUMIF(range, criteria, sum_range) 

Coäng doàn nhöõng oâ cuûa sum_range maø doøng ñoù 

thoûa maõn ñieàu kieän cuûa criteria 
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Toång soá ngaøy coâng cuûa Toå 1: =SUMIF(B4:B8, 1, 

D4:D8)  63 

Toång soá nhaân vieân cuûa Toå 1: =COUNTIF(B4:B8,1) 

 2 

Toång soá nhaân vieân coù ngaøy coâng treân 21 

=COUNTIF(D4:D8, “>21”)  3 

 

V.  CAÙC HAØM DOØ TÌM 

=VLOOKUP(ñ/c oâ,ñ/c baûng tra,coät keát 

quaû,0/1)   

Haøm seõ  ñem oâ ñi tra trong coät 1 cuûa baûng tra 

khi tìm thaáy haøm seõ döøng laïi chieáu sang coät keát quaû 

vaø cho giaù trò ôû coät keát quaû ñoù. 

Khaùi nieäm tìm thaáy phuï thuoäc vaøo ñoái soá thöù 4 

 Neáu ñoái soá thöù 4 = False ( hoaëc 0) thì haøm seõ 

tìm chính xaùc coù nghóa laø haøm seõ döøng laïi ôû 

giaù trò ñuùng baèng giaù trò cuûa oâ 

 Neáu ñoái soá thöù 4 = True (hoaëc 1)  haøm seõ tìm 

trong phaïm vi coù nghóa laø noù seõ döøng laïi ôû giaù 

trò lôùn nhaát chöa vöôït quaù giaù trò cuûa oâ, luùc  

naøy coät 1 cuûa baûng tra phaûi ñöôïc saép xeáp theo 

chieàu taêng daàn. 

Chuù yù : Neáu khoâng coù ñoái soá thöù 4 Excel seõ 

hieåu laø True  

Neáu doø tìm khoâng thaønh coâng haøm seõ cho keát 

quaû  #N/A (Not Available - Baát khaû thi) 

Ví duï : Töø  coät ñieåm cuûa BAÛNG ÑIEÅM vaø 

BAÛNG TRA  (ôû döôùi) ta phaûi caäp nhaät coät 
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Xeáp loaïi vaø coät Hoïc boång  gaøi caùc coâng 

thöùc sau vaøo 2 oâ C3 vaø D3 

 

C3: =Vlookup(B3,$F$3:$H$7,2) 

hoaëcVlookup(B3, $F$3:$H$7,2,True) 

D3 :  =Vlookup(B3, ,$F$3:$H$7,3)  

hoaëc   =Vlookup(B3, ,$F$3:$H$7,3,True) 

 

2) =HLOOKUP(ñ/c oâ,ñ/c baûng tra,haøng 

keát quaû,n) :  

Haøm Hlookup coù yù nghóa nhö haøm 

Vlookup nhöng haøm seõ ñöôïc söû duïng 

trong tröôøng hôïp baûng tra ñöôïc boá trí 

theo haøng  nhö sau: 

  

Ñieåm 0 5 7 9 10 

Xeáp 

loaïi 

Keùm TB Kha Gioiû XS 

Hoïc 0 0 5000 8000 10000 
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boång 

 

 

Haøm seõ ñem oâ ñi tra trong haøng 1 cuûa 

baûng tra khi tìm thaáy haøm seõ döøng laïi 

chieáu xuoáng haøng keát quaû vaø cho giaù 

trò ôû haøng keát quaû ñoù. 

 

3) =MATCH(ñ/c oâ,ñ/c baûng tra)  

(ñoái vôùi haøm naøy baûng tra chæ laø 1 coät 

hoaëc 1 haøng) 

Haøm seõ ñem oâ ñi tra trong baûng vaø cho bieát soá 

thöù töï cuûa oâ maø haøm tìm thaáy trong baûng.  

* Khaùi nieäm tìm thaáy ôû ñaây cuõng coù 

yù nghóa gioáng nhö trong haøm 

Vlookup. 

* Soá thöù töï cuûa oâ (1,2,3,...) ñöôïc tính 

töø  treân xuoáng neáu baûng laø coät vaø töø 

traùi qua phaûi neáu baûng laø haøng. 

Ví duï : =Match(B3,F3:F7)=2 

=Match(B7,F3:F7)=4 

 

4) =INDEX(Baûng,Haøng,Coät) 

* Baûng : ñ/c cuûa baûng 

* Haøng : STT cuûa haøng trong baûng 

* Coät    : STT cuûa coät trong baûng 

Haøm cho keát quaû laø giaù` trò cuûa oâ giao nhau giöõa stt 

haøng vaø stt coät trong baûng 
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VI. CAÙC HAØM CÔ SÔÛ DÖÕ LIEÄU 

 1. DSUM(database, field, criteria) 

Tìm nhöõng maãu tin trong database maø thoûa maõn 

tieâu chuaån criteria, gía trò töông öùng cuûa caùc maãu 

tin naøy ôû coät Field seõ ñöôïc coäng doàn vaø traû veà 

Database: laø danh saùch bao goàm caû tieâu ñeà coät 

Field: Ñòa chæ cuûa coät coäng doàn 

Criteria: vuøng ñieàu kieän, caùch thieát ñaët gioáng nhö 

Advanced Filter 

 

 

 

 2. DMAX(database, field, criteria) 

Tìm nhöõng maãu tin trong database maø thoûa maõn 

tieâu chuaån criteria, gía trò töông öùng cuûa caùc maãu 

tin naøy ôû coät Field seõ ñöôïc so saùnh vôùi nhau, giaù trò 

naøo lôùn nhaát seõ ñöôïc traû veà 
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 3. DMIN(database, field, criteria) 

Tìm nhöõng maãu tin trong database maø thoûa maõn 

tieâu chuaån criteria, gía trò töông öùng cuûa caùc maãu 

tin naøy ôû coät Field seõ ñöôïc so saùnh vôùi nhau, giaù trò 

naøo nhoû nhaát seõ ñöôïc traû veà 

 

 4. DAVERAGE(database, field, criteria) 

Tìm nhöõng maãu tin trong database maø thoûa maõn 

tieâu chuaån criteria, gía trò töông öùng cuûa caùc maãu 

tin naøy ôû coät Field seõ ñöôïc tính trung bình coäng vaø 

traû veà 
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CHƢƠNG 3:MICROSOFT  POWERPOINT  

 

 

I. Chức năng  

PowerPoint là phần mềm trình diễn rất tiện lợi trong 

công  việc thuyết trình 1 bài giảng, 1 báo cáo. 

PowerPoint l àm cho bài thuyết trình thêm sinh động, 

trực quan và hấp dẫn 

 

II. Khởi động Power Point: 

Bƣớc 1: Nhắp vào nút Start trên thanh công cụ 

Windows 

Bƣớc 2: Định vị con trỏ chuột trên mục 

Programs 

Bƣớc 3: Nhắp Microsoft PowerPoint. Màn hình 

Power Point đầu tiên xuất hiện. 

 

Cũng như các chương trình Microsoft Office 

khác, PowerPoint có các thanh công 

cụ(Toolbars), thanh thực đơn(Menu bar) và các 

lệnh đơn tắt khác. Ngoài ra, PowerPoint có những 

công cụ, lệnh đơn riêng biệt: 

 

III. Các thành phần chính trên 1 trang PowerPoint: 

Theo ngầm định, một slide PowerPoint có 3 khung 

chính (theo cách nhìn Normal): Outline, Slide 

notes và Slide 
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- Khung Outline thể hiện cấu trúc tổ chức các 

khung slide trong phiên trình bày. Có thể dùng 

khung này để tạo và sắp xếp các slide. 

- Khung Notes cho phép bổ sung và xem các ghi 

chú trong thuyết trình. Khung Notes mô tả chi tiết 

cho nội dung khung slide. 

- Khung slide: nội dung cần trình bày nằm ở 

khung này. Bao gồm văn bản, hình ảnh, các đoạn âm 

thanh. 

- Để di chuyển qua lại các thành khung này, chúng 

ta nhắp chuột vào khung hoặc nhấn F6. 

- Để thay đổi kích cỡ khung, để con trỏ chuột biến 

thành vạch song song và kéo viền khung. 

 

IV. Các kiểu xem PowerPoint: 

 

Khung 

Outline   

Khung 

Notes   

Khung 

Slide 
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- Normal View: cho phép xem tất cả thành phần 

chính của phiên trình bày. 

- Outline View: xem khung slide để bổ sung hoặc 

hiệu chỉnh tiêu đề. Ta không thể làm việc với các 

ảnh đồ họa hoặc các biểu đồ trong kiểu xem này 

- Slide View: trong kiểu xem này, ta có thể làm việc 

với văn bản, các hình ảnh, biểu đồ cho từng slide 

một. 

- Slide Sorter View: với kiểu xem này, ta có thể 

dời, chép, xóa các slide, nhưng không thể hiệu chỉnh 

văn bản trong khung slide hoặc làm việc với các đối 

tượng slide. 

- Slide show: xem dáng vẻ của slide khi đã hoàn 

thành 

- Chọn  menu View->Notes page để xem dáng vẻ 

của phần ghi chú. Lưu ý: không thể hiệu chỉnh văn 

bản của khung slide trong chế độ xem notes page. 

 

 

 

 

 

 

 

 

 

 

 

 

Outline 

View 

Slide sorter 

View 

Slide View 
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V.  Làm việc với các ô giữ chỗ 

“Click”(placeholders) trên khung slide 

 

Ô giữ chỗ “Click” là các ô sẵn có trên khung 

slide dùng để bổ sung văn bản, biểu đồ và các 

hình mẫu. 

 

 

     

 

       

        

 

- Nhắp chuột vào ô giữ chỗ để gõ text hoặc chèn hình 

ảnh, đồ thị. 

- Để sửa đổi nội dung trong ô giữ chỗ, nhắp chuột tại 

điểm muốn sửa đổi, gõ nội dung mới. Ô giữ chỗ tự 

động đóng khung văn bản nếu cần. 

- Muốn xóa bỏ văn bản trong ô giữ chỗ, chọn nội dung 

cần xóa rồi nhấn Delete. 

- Để sao chép nội dung các ô giữ chỗ, click chọn nội 

dung trong ô giữ chỗ cần sao chép, click phải chọn 

Copy rồi di chuyển chuột đến ô giữ chỗ cần chép, 

chọn Paste. 

 

 

2 ô giữ chỗ, 

một tiêu đề 

chính và một 

tiêu đề con 
 

      2 ô giữ  

      chỗ 

text  
  Ô giữ 

chỗ 

   hình ảnh 
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ĐỊNH DẠNG CHO SLIDE 

 

I. Định dạng kiểu chữ, cỡ chữ và màu chữ (Font, 

Font size, Font Colors): 

- Trên thanh Fomating, click vào mũi tên 

thả Font để chọn Font, click vào mũi tên thả 

Font size để chọn cỡ chữ.  

- Để chọn màu chữ, click vào mũi tên thả 

Font Color trên thanh Drawing để chọn màu. 

Muốn chọn màu khác, click vào More Font 

Colors. Trên tab Standard, nhắp chọn màu từ 

bảng màu, nhắp OK. 

- Muốn chọn hay hiệu chỉnh kiểu chữ, cỡ 

chữ, màu chữ cho từng đối tượng riêng biệt, click 

chọn đối tượng hay dòng cần thay đổi rồi thực 

hiện như trên. 

 

II. Định dạng Bullets and numbering trên slide : 

Tạo một danh sách đánh dấu đầu mục: 

Bƣớc 1:  Nhắp chọn New Slide trên thanh công cụ 

chuẩn 

Bƣớc 2:  Chọn ô giữ chỗ trên slide có bố cục Bullets 

Bƣớc 3:  Vào menu Format->Bullets and 

numbering 

Bƣớc 4:  Ở tab Bulleted, click chọn dạng dấu đầu 

mục->OK 

Lƣu ý: Ta có thể tận dụng đến 5 cấp đánh dấu đầu 

mục trong 1 danh sách PowerPoint. Xem mục c. 

Tạo một danh sách có đánh số: 
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Bƣớc 1:  Nhắp chọn New Slide trên thanh công cụ 

chuẩn 

Bƣớc 2:  Chọn ô giữ chỗ trên slide có bố cục Bullets 

Bƣớc 3:  Vào menu Format->Bullets and numbering 

Bƣớc 4:  Ở tab Numbering, click chọn dạng đánh số-

>OK 

Thụt dòng và thụt treo các mục trong danh sách: 

Thụt treo:  trong các danh sách đánh dấu đầu mục và 

đánh số, có khi ta cần dời một dấu đầu mục ra phía 

ngoài lề một cấp. Kỹ thuật này gọi là thụt treo dấu đầu 

mục. Thực hiện bằng cách nhấn Shift+Tab để thụt 

treo 1 đoạn. 

Thụt dòng: 

Để tạo một dòng thụt mới, nhắp 1vị trí bất kỳ ngay 

trong dòng phía  

trên nơi muốn dòng mới xuất hiện. Nhấn End đến 

cuối dòng, Enter  

để tạo dòng mới, nhấn Tab để thụt dòng 1 cấp và gõ 

nội dung văn  

bản; tiếp tục nhấn Tab để thụt dòng thêm, nếu cần. 

Sửa đổi dấu đầu mục hoặc danh sách số: 

Bƣớc 1:  Chọn mục cần thay đổi 

Bƣớc 2:  Vào Format ->Bullets and Numbering 

Muốn thay đổi ký hiệu đầu mục, chọn tab Bulleted  

rồi chọn dạng dấu đầu mục. Muốn có các dạng khác, 

chọn Character để lựa chọn ký hiệu ->OK. 

Muốn thay đổi dạng số trong danh sách, chọn Tab 

Numbering, chọn dạng số rồi nhắp OK. 
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TẠO MỘT TRÌNH DIỄN TRÊN POWER POINT 

 

I. Tạo một trình diễn  

1. Tạo một trình diễn với Autocontent Wizard: 

- Chọn File -> New 

- Nhắp Tab General trong hộp thoại 

New Presentation 

- Nhắp đúp Autocontent Wizard. 

- Nhắp Next để sang bước kế tiếp trong 

Wizard 

- Chọn kiểu trình bày trình từ danh sách 

- Chọn Next để qua từng bước trong 

Wizard. Chọn Finish để kết thúc quá 

trình 

- Sau khi hoàn tất các bước trên, phiên 

trình bày mới hiện ra trong kiểu xem 

Normal. Thay nội dung cần thiết trong 

khung Outline. 

 

2. Tạo một trình diễn PowerPoint mới từ đầu: 

- Nhắp nút New trên thanh công cụ 

Standard 

- Trong hộp thoại New Slide, chọn một 

bố cục (Layout) cho trình diễn 

- Nhắp OK, phiên trình diễn mới được 

tạo và slide đầu tiên hiện ra 

- Nhập các Object 

- Sắp xếp trình tự xuất hiện của các 

Object và hiệu ứng Animation 
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- Slide Show / Custom Animation 

HĐT 

 

Tab Order & Timing, 

đánh dấu đối tượng 

muốn 

trình diễn.  

Lƣu ý: Thứ tự  

đánh dấu là thứ tự 

hiển thị 

nội dung của văn 

bản trên  

slide. Có thể đảo lạI 

thứ tự bằng Move  

 

Start Animation 

Automatically: Đối tượng tự  động xuất hiện theo các 

quãng thời 

gian định 

sẵn, 

On Mouse 

Click: Đối 

tượng  

xuất hiện khi Click Mouse 

Tab Effects, chọn một hiệu ứng và âm thanh từ 

danh sách thả Entry animation and sound để 

tạo hiệu ứng. 

- Để lần lượt hiện ra từng 
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dấu đầu mục hoặc con số cho đối tượng văn 

bản, chọn một cấp từ danh sách thả Grouped 

by 

- Nhắp OK để áp dụng các hiệu ứng 

- Preview: Chạy thử Slide Show để xem các 

hiệu ứng đã chọn. 

 

II. Thêm, xoá một slide 

1. Thêm một slide 

- Vào menu Insert, chọn New Slide. 

- Chọn một bố cục mới, nhắp OK 

 

2. Xóa 1 slide: 

- Chọn slide cần xóa ở khung Outline, 

nhấn Delete. 

 

 3.  Di chuyển qua lại giữa các slide 

- Nhắp nút Previous Slide hoặc Next 

Slide (ở góc dưới phải cửa sổ  

PowerPoint) để duyệt qua các slide 

khác. 

 

III. Bổ sung và định dạng các hình mẫu, hình vẽ, 

tranh ảnh cho slide: 

1. Bổ sung hình mẫu: 

- Nếu trên slide có ô giữ chỗ cho hình mẫu, nhắp 

đúp trên ô này để xem Clip Gallery (thư viện hình 

mẫu). 

- Chọn một chủ đề của hình mẫu. 



   119 

- Nhắp chọn một hình mẫu trong chủ đề đã chọn. 

- Từ thanh lệnh đơn đang xuất hiện trên hình mẫu, 

nhắp tùy chọn đầu tiên, Insert Clip. Hình mẫu xuất 

hiện trong ô giữ chỗ trên slide. 

- Đóng Clip Gallery. Clip Gallery không tự động 

đóng khi chèn hình ảnh. 

- Nếu slide không có ô giữ chỗ cho hình mẫu, 

nhắp nút Insert Clip Art trên thanh công cụ 

Drawing để truy cập Clip Gallery. Sau đó thực hiện 

lại các bước trên. 

 

2. Bổ sung cùng 1 hình mẫu trên tất cả slide: 

- Chuyển qua dạng Slide Sorter View. 

- Chọn View, Master, Slide Master 

- Nhắp nút Insert Clip Art trên thanh công cụ 

Drawing 

- Chọn một hình ảnh trong thư viện Clip Gallery 

- Nhắp tùy chọn Insert Clip trên thanh lệnh đơn 

- Đóng Clip Gallery 

- Kéo và thả hình ảnh vào vị trí mong muốn trên 

Slide Master. Chỉnh hình ảnh theo yêu cầu. 

- Nhắp nút đóng (X) để đóng Slide Master. Ảnh sẽ 

xuất hiện trên tất cả Slide ngoại trừ slide có bố cục 

tiêu đề 

Tô lại màu cho các hình mẫu: 

- Nhắp chọn hình mẫu muốn tô lại màu. 

- Chọn Format -> Picture. Hộp thoại 

Format Picture xuất hiện 

- Nhắp tab Picture 
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- Nhắp nút ReColor trên tab Picture 

- Hộp thoại Recolor Picture trưng một 

cột (Original) để nêu màu ban đầu và 

một cột khác(New) để lựa chọn màu 

mới. 

- Nhắp mũi tên thả cạnh màu mới muốn 

thay đổi. Khung xem trước tự động 

hiện màu vừa chọn -> nhắp OK 

 

3. Bổ sung chữ kiểu vào Slide: 

- Nhắp nút WordArt trên thanh công cụ 

Drawing 

- Chọn kiểu dáng muốn dùng cho 

WordArt. Các kiểu dáng bao gồm 

hình dáng, hướng, bóng và màu. 

- Nhắp OK. Hộp thoại Edit WordArt 

Text xuất hiện 

- Gõ văn bản muốn dùng cho WordArt 

- Nhắp OK để tạo một đối tượng 

WordArt. 

 Thay đổi kiểu dáng WordArt: 

- Chọn đối tượng WordArt cần thay đổi 

trên slide 

- Nhắp nút WordArt Gallery trên thanh 

công cụ WordArt 

- Chọn một kiểu dáng mới từ Gallery 

- Nhắp OK để áp dụng kiểu dáng 

WordArt mới 
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- Nhắp nút WordArt Shape trên thanh 

công cụ WordArt và lựa chọn một 

hình thể khác cho vùng hiển thị của các 

từ. 

 

5.Bổ sung các hình vẽ vào slide: 

- Thanh công cụ Drawing là điểm bắt 

đầu để vẽ các đường kẻ, các mũi tên, 

và các hình thể. 

- Từ thanh công cụ Drawing, nhắp nút 

Line (đường kẻ) hoặc Arrow (mũi 

tên), tùy theo đối tượng muốn vẽ. 

- Kéo con trỏ chuột từ đầu đường kẻ 

hoặc mũi tên đến điểm cuối. 

- Để vẽ một Autoshape, chọn một hình 

từ  một trong các nhóm nêu trên lệnh 

đơn Autoshape. Click chuột và kéo 

hình theo mong muốn. 

 

 

LÀM VIỆC VỚI CÁC BẢNG 

Cách thức tạo một bảng trong Power Point giống 

như trong Microsoft Word. Nếu chúng ta đã thông 

thạo Table trong Word thì việc tạo bảng trong 

PowerPoint không có gì khác. 

 

I. Chèn một bảng vào slide: 

- Vào Insert->Table, xuất hiện màn 

hình bên 
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- Nhập vào số cột  

-    Nhập vào số dòng  

- Click OK để tạo một Table trên slide 

 

II. Thay đổi chiều cao dòng và cột trong Table: 

- Để thay đổi độ rộng của hàng hoặc cột, 

định vị chuột trên vị trí hàng hay cột 

cần thay đổi.  

- Con trỏ chuột đổi thành vạch song song 

với 2 đầu là mũi tên. Kéo viền đến vị 

trí mới, thả chuột. 

- Muốn thay đổi cả chiều cao dòng và 

cột cùng lúc, định vị con trỏ chuột ở 1 

góc của bảng, con trỏ chuột biến thành 

vạch với 2 đầu là mũi tên, kéo viền đến 

vị trí mới. 

 

III. Thêm dòng và cột cho bảng: 

- Để thêm dòng hay cột, chọn ô tại vị trí 

muốn thêm. 

- Trên thanh công cụ Tables and 

Borders, 

chọn: 

+ Insert Columns to the Left: 

 Thêm cột bên trái 

   + Insert Columns to the Right: 

   Thêm cột bên phải 

  + Insert Rows Above: thêm dòng phía 

trên 
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  + Insert Rows Below: thêm dòng phía 

dưới 

   

     

 

 

X

ó

a

 

d

ò

n

g

/

cột trong bảng: 

- Chọn dòng/cột cần xóa 

- Trên thanh công cụ Table and 

Borders, vào Table, chọn Delete 

Rows nếu muốn xóa dòng, chọn Delete 

Columns nếu muốn xóa cột. 

Lƣu ý: khi xóa dòng/cột trong bảng, bảng 

sẽ thu nhỏ lại. Để cho bảng bung rộng với 

khoảng trống trên slide, chọn Format-

>Slide Layout. Trong hộp thoại Slide 

Layout, chọn Reapply. Bố cục bảng sẽ 

điền vùng thích hợp trên slide. 

 

IV. Hợp nhất và tách các ô trong 1 bảng 
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- Chọn các ô cần hợp nhất, vào Table 

trên thanh công cụ Table and Borders, 

chọn Merge Cells. Khi đó các ô đã lựa 

chọn sẽ được tổ hợp thành 1 ô duy 

nhất. 

- Muốn tách 1ô thành 2 ô, chọn ô cần 

tách, trên thanh công cụ Table and 

Borders, chọn Split Cells. 

V. Định dạng đƣờng viền bảng 

- Để định dạng đường viền cho cả bảng, 

chọn bảng, vào Table, chọn Borders 

and Fill. Hộp thoại xuất hiện như sau: 

 

 

 

 

 

Chọn dạng  

đường viền 

 

Chọn màu 

 

Chọn độ 

rộng đường 

viền 

 

- Click sang tab Fill để chọn màu nền 

cho các ô 

- Nhắp OK để các thay đổi có hiệu lực. 
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VI. Định dạng dữ liệu trong 1 bảng 

- Chọn các ô dữ liệu muốn định dạng 

- Để điều chỉnh gióng hàng theo chiều 

ngang, nhắp các nút Align Left, Align 

Center hoặc Align Right trên thanh 

công cụ Formatting 

- Để điều chỉnh gióng hàng theo chiều 

dọc, nhắp các nút Align Top, Center 

Vertically hoặc Align Bottom trên 

thanh công cụ Tables and Borders. 

 

 

LÀM VIỆC VỚI BIỂU ĐỒ 

 

Với PowerPoint ta có thể tạo nhiều dạng biểu đồ 

khác nhau. Bao gồm các kiểu  biểu đồ thông dụng 

như Cột, Hình tròn, đường kẻ, và các dạng biểu đồ 

ít thông dụng hơn như: Bubble (bong bóng), 

Combination (phối hợp)… 

 

I. Tạo một biểu đồ: 

- Nhắp nút New Slide trên thanh công cụ 

Standard 

- Chọn dạng Slide biểu đồ như hình 

dưới:-  

- Nhắp đúp vào ô giữ chỗ có dạng 

đồ thị để mở Microsoft Graph và  

tạo biểu đồ 

Trong trường hợp muốn chèn một  
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biểu đồ trên slide không có ô giữ  

chỗ là biểu đồ thì ta vào menu 

Insert->Chart. 

- Một cửa sổ kiểu bảng tính - bảng  

dữ liệu chứa các dữ liệu mẫu xuất 

hiện. 

- Để xóa dữ liệu mẫu trong bảng dữ liệu, 

nhắp vào hộp xám bên góc trái trên của 

bảng tính và nhấn Delete. 

  

 

 

 

 

 

 

 

 

 

 

 

 

2. Nhập dữ liệu biểu đồ: 

- Nếu không thấy Datasheet, vào View -

>Datasheet để lấy bảng này ra. 

 



   127 

- Tạo 

dữ liệu để vẽ đồ thị 

 Cách 1: Nhập dữ liệu vào bảng tính 

 Cách 2: Import dữ liệu từ Excel hoặc Access 

Chọn lệnh Edit / Import file  HĐT <Chọn File 

dữ liệu>  Open  HĐT 

Chọn Sheet 

Chọn địa chỉ khốI chứa dữ liệu để vẽ ĐT 

 

3. Thêm/xóa các dòng/cột của bảng dữ liệu: 

Thêm: 

-    Chọn vị trí cần thêm dòng/cột 

- Chọn Insert->Cells. PowerPoint sẽ 

chèn thêm dòng/cột mới 

Xóa: 

- Chọn dòng/cột cần xóa 
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- Chọn Edit->Delete. Power Point xóa 

dòng/cột đã chọn 

 

 

II. Chỉnh sửa biểu đồ  

 Chart / Chart Type <Chọn kiểu ĐT> 

  Chart / Chart Option: Định dạng cho ĐT 

 

Tab Title <Nhập các tiêu đề cho ĐT> (Đối với 

ĐT tròn chỉ có 1 tiêu đề chính) 

Tab Legend <Tạo khung ghi chú cho đồ thị> 

Tab Data label <Tạo nhãn cho các Series dữ liệu 

trong ĐT> 

 

  Data / Series in Rows : Series dl theo hàng 

       Series in Rows : Series dl theo cột 

 Có thể sửa các Properties của đồ thị và của 

từng Series dl trực tiếp trên ĐT 

Các bước: 
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1. Chọn thành phần (Click) 

2. Double click vào thành phần HDT <Thực hiện 

sửa> 

 VD: Có thể đổI mầu cho các Series dl trên 

ĐT; Thay đổI Font Size cho các nhãn trên các 

trục x,y; điều chỉnh mật độ các lưới 

3. Thêm hay xóa đi 1 series dl… bằng cách 

Double Click vào RowHeader hoặc Column 

Header của BT (ở chế độ vẽ ĐT) 

 

III. Tạo hiệu ứng các biểu đồ: 

- Chọn Slide muốn tạo hiệu ứng. Chọn 

đối tượng biểu đồ 

- Vào Slide show -> Custom 

Animation, chọn Chart Effects. 

 Hộp thoại xuất hiện như sau: 

o Chọn hiệu ứng cho biểu đồ theo Sêri (by 

Series), theo loạI (by Category), hoặc 

theo điểm dữ liệu 
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o Entry animation and Sound: chọn hiệu 

ứng hình ảnh và âm thanh Nhắp OK để 

các hiệu ứng có tác dụng 

- Chạy Slide Show để xem lại các hiệu 

ứng vừa tạo. 

 

LÀM VIỆC VỚI CÁC SƠ ĐỒ TỔ CHỨC: 

 

PowerPoint có một chương trình được thiết kế để 

chuyên tạo các sơ đồ tổ chức. Chương trình này có 

tên Microsoft Organization Chart và xuất hiện 

trong cửa sổ riêng 

I. Tạo một sơ đồ tổ chức 

1. Tạo mới một slide có cấu trúc sơ đồ tổ chức: 

Chọn dạng slide và nhắp OK 

 

2.Nhập thông tin vào sơ đồ tổ chức 
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- Trong sơ đồ tổ chức có nhiều hộp. Mỗi 

hộp có thể dùng để lưu trữ thông tin liên quan của 

từng cá nhân trong tổ chức 

- Muốn nhập liệu cho hộp nào, chỉ cần click 

chọn hộp. Nhập dòng đầu tiên. Nếu cần nhập dòng 

tiếp theo, nhấn Enter  

 

II. Chỉnh sửa sơ đồ 

1. Bổ sung và xóa các thành phần trong sơ đồ 

tổ chức: 

- Nhắp đúp sơ đồ để mở chương trình Organization 

Chart 

- Để bổ sung một đốI tượng bên dưới đối tượng 

khác, click lên nút Subordinate. 

- Chọn vị trí cần bổ sung 

- Nhập dữ liệu cho đối tượng 

- Để bổ sung một “phụ tá” (assistant) vào sơ đồ, 

nhắp nút Assistant trên thanh công cụ. Khi đó một 

đối tượng phụ tá xuất hiện 

- Để gỡ bỏ 1 hộp, nhắp chọn hộp và nhấn Delete 

 

2. Dời các đối tƣợng trong sơ đồ tổ chức: 

- Nhắp đúp sơ đồ để mở chương trình Organization 

Chart 

- Để dời hộp, chọn hộp, nhắp đè nút chuột trái và 

kéo đến vị trí mới 

 

III. Định dạng sơ đồ tổ chức 

1. Định dạng bố cục trong sơ đồ tổ chức 
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- Nhắp đúp sơ đồ để mở chương trình Organization 

Chart  

- Nhắp chọn hộp, để chọn nhiều hộp đi kèm, nhấn 

Shift rồi click chuột chọn 

- Sau đó nhắp lệnh đơn Styles rồi nhắp bố cục kiểu 

dáng hộp 

 

2. Định dạng văn bản và hộp trong sơ đồ tổ 

chức 

- Chọn các hộp chứa văn bản muốn định dạng. Để 

định dạng chỉ 1 dòng, click chuột chọn dòng, chọn 

Text->Font từ thanh lệnh đơn 

- Trong hộp thoạI Font, chọn Font chữ, kiểu chữ và 

co chữ.-> nhắp OK 

- Chọn Text->Color từ thanh lệnh đơn để thay đổi 

màu cho chữ, chọn màu, nhắp OK 

- Để thay đổi màu nền hộp, chọn hộp cần thay đổi, 

chọn Boxes, Color và chọn một màu. 

- Để đổ bóng, chọn Boxes->Shadow và chọn vị trí 

đổ bóng 

- Thay đổi đường viền, chọn Boxes, Border Style 

và chọn 1 kiểu dáng 

- Thay đổi kiểu đường kẻ trên hộp, chọn Boxes, 

Border Line Style và chọn 1 kiểu dáng. 

 

 

CÁC CHỨC NĂNG KHÁC 

 

I. Chạy slide show 

1. Xác lập Slide Show và chạy Slide Show: 
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- Chọn Slide Show -> Set Up Show. 

Hộp thoại xuất hiện: 

 

- Chọn một trong các tùy chọn ở mục Show type 

- Ở mục Advance slides, chọn Using timings, if 

present. 

- Nhắp OK để chấp nhận các xác lập Slide Show. 

- Chạy thử Slide Show. 

 

2. Thiết lập chạy Slide Show liên tục: 

Trong một vài trường hợp, ta muốn Slide 

để tự động chạy mà không cần khởi động 

lại Slide. Điều này chúng ta thường dùng 

trong các cuộc hội nghị, các buổi trình 

chiếu thương mại, các kiốt. 

- Mở slide muốn trình chiếu liên tục 
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- Chọn Slide Show ->Set Up Show 

 

- Chọn Loop continuously until “ESC” 

- Nhấn OK để thiết lập 

- Chạy thử Slide Show, nhấn ESC để 

thoát. 

 

II. LIÊN KẾT TÀI LIỆU GIỮA WORD – 

EXCEL – POWER POINT 

1. Nhập dữ liệu từ một bảng tính: 

- Mở tập tin Excel chứa dữ liệu muốn nhập khẩu 

- Chọn vùng dữ liệu muốn sao chép sang 

PowerPoint 

- Chọn Edit-> Copy 

- Chuyển về cửa sổ PowerPoint, chọn slide để sao 

chép dữ liệu. 

- Chọn Edit-> Paste để sao chép dữ liệu vào slide. 
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2. Nhập dữ liệu từ Word: 

Trước khi tạo một phiên trình bày cho PowerPoint với 

dữ liệu từ Word, chúng ta phải định dạng Word theo 

Heading để tổ chức văn bản.Heading 1 trở thành tiêu 

đề của Slide, Heading 2 trở thành dấu đầu mục cấp 

đầu tiên, vân vân…Nếu chỉ muốn chép dữ liệu từ 

Word vào PowerPoint, ta chỉ cần dùng Edit,Copy và 

Edit, Paste. 

- Đóng tập tin Word trước khi nhập dữ 

liệu vào PowerPoint 

- Chuyển sang cửa sổ PowerPoint 

- Nhắp nút Open trên thanh công cụ 

Standard của cửa sổ PowerPoint 

- Trong hộp thoại Open, chọn All 

Outlines từ danh sách thả Files of Type. 

- Xác định vị trí văn bản rồi nhắp đúp 

tập tin Word. Một phiên trình bày mới được thiết lập. 

 

3. Xuất dữ liệu từ slide của Power Point sang 

Word: 

- Nhắp nút Slide Sorter View ở góc 

dướI trái màn hình PowerPoint 

- Chọn Slide muốn sao chép 

- Nhắp nút Copy 

- Chuyển sang cửa sổ Word , nhắp nút 

Paste 

 

III. Slide Master 
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1. Khái niệm:  

SlideMaster là Slide đặc biệt của 

PoerPointPowerPoint. SlideMaster gồm các thành 

phần như  trong hình dướI. Những thành phần trong 

SlideMaster sẽ xuất hiện ở tất cả các Slide vớI định 

dạng như trong SlideMaster 

2. Cách tạo: 

View / Master / Slide master  Cửa sổ Slide 

Master 

Thực hiện  

 Tạo các thành phần Footer, Logo, Sound, 

… 

 Định dạng theo ý muốn 

 Close 

Chú ý: Có thể tạo Slide Master bất kỳ lúc nào 

 

IV. Gán các Template có sẵn cho cho Slide 
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Format / Apply Design Template  HĐT 

 

V. Tạo các Action Button để di chuyển nhanh 

giữa các Slide bất kỳ 

Slide Show / Action Button / Chọn Button 

 HĐT 

 

VI. Tạo hiệu ứng chuyển tiếp, âm thanh, thời gian 

hiển thị giữa các slide: 

- Chuyển sang kiểu xem Slide Sorter  

- Chọn Slide Show -> Slide Transition. Hộp thoại 

Slide Transition xuất hiện. 

Xác định bước chuyển tiếp: 

 Từ danh sách thả Effect, chọn một bước chuyển 

tiếp. Ví dụ ở hình bên dưới là Cover Up. 

 Để xác định tốc độ của bước chuyển tiếp, chọn 

slow(chậm), Medium (trung bình), Fast(nhanh) 
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Xác định âm thanh chuyển tiếp: 

Chọn dạng âm thanh ở mục Sound 

     

Xác định 

thời gian 

hiển thị  một 

slide: 

Ở mục 

Automaticall

y after gõ 

vào số giây 

mà slide kế 

tiếp sẽ hiển 

thị. 

Nếu không 

muốn ấn 

định thời gian tự động, chọn On mouse click. Slide kế 

tiếp sẽ hiển thị sau mỗi khi click chuột. 

Sau khi đã ấn định các thông số trên, nhấn Apply to All 

để có hiệu lực cho các bổ sung đã chọn. 

Lƣu ý: khi chọn hiệu ứng âm thanh chuyển tiếp, 

chúng ta phải cân nhắc cẩn thận vì hiệu ứng âm 

thanh nhiều quá sẽ gây ồn ào cho bài thuyết trình. 

Đừng nên lạm dụng hiệu ứng này. 

 

 

VII. ẤN ĐỊNH PHIÊN TRÌNH BÀY ĐỂ CHẠY 

TRÊN MẠNG 
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Muốn trình chiếu một phiên trình bày trên 

Intranet hoặc Internet, tập tin PowerPoint phảI ở  

dạng thức HTML- HyperText Markup Language. 

Phiên trình bày sau khi chuyển sang HTML, nó 

được xem trên mạng nhờ một bộ duyệt Internet 

Explorer hoặc Nestcape Navigator 

1) Lưu phiên trình bày ở dạng Web: 

2) Mở phiên trình bày 

3) Chọn File, Web Page Preview 

4) Chọn File, Save as Web Page 

5) Trong hộp thoại Save as, dùng danh sách 

thả Save in hoặc Place Bar để chọn nơi 

lưu. 

6) Nếu muốn lưu phiên trình bày dưới dạng 

trang Web trên bộ duyệt Web, nhắp nút 

Publish trong hộp thoạI Save As. 

7) Trong hộp thoạI Publish as Web page, 

chọn các xác lập cho nội dung muốn xuất 

bản. 

8) Nhắp Publish. 

 

IN ẤN BẢN BÁO CÁO  

I. In các slide: 

Vào File->Print. Hộp thoại Print xuất 

hiện: 
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- Chọn Grayscale hoặc Pure black and white nếu in 

các bản thô 

slide theo số riêng lẻ được chỉ định          

- Xác lập Grayscale sẽ in theo các bóng xám. Pure 

black and white chỉ  

in trong chế độ trắng đen mà không có bóng xám. 

- Nhắp OK để in slide. 

 

II. In các bảng thuyết minh 

In các bảng thuyết minh (handouts) hiển 

thị 2,3,4,6,9 slide trên một trang in.  

 

Lựa chọn vùng 

in: 

-All:in tất cả slide 
-Current slide: in 

slide hiện hành 

-Slides: in các 

slide theo số riêng 

lẻ được chỉ định 

 

 

Chọn số 

lượng bản in. 

Chọn in theo 

Collate (xếp 

quyển)  

 

Tùy chọn 

mặc định 
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- Vào File ->Print. Hộp thoại Print xuất 

hiện như phần 1. Ở đây, chúng ta lưu ý 

đến các mục trong hình bên dưới: 

 

 

 

 

   

 

 

 

- Để thêm các phần đầu và phần chân 

vào bảng thuyết minh, chọn  

- View->Master->Handout Master . 

Thông thường chúng ta có thể bổ sung 

số trang in, ngày in vào phần đầu và 

phần chân này. 

 

III. In phần Outlines của slide: 

- Chọn File ->Print. Hộp thoại Print 

xuất hiện. 

- Tương tự như 2 phần trên, chọn các 

thông số cần thiết. 

- Ở mục Print What, chọn Outline 

View. 

- Để chỉ in các tiêu đề của slide, ta phải 

lược bớt nội dung Outlines. Chọn 

View->Toolbars->Outlining. Thanh 

công cụ xuất hiện, nhắp một vị trí bất 
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kỳ trong khung Outlines, sau đó nhắp 

chọn Collapse All. 

 

IV. In phần ghi chú: 

- Chọn File ->Print. Hộp thoại Print 

xuất hiện. 

- Chọn các thông số cần thiết khi in. 

- Ở mục Print What, chọn Notes Pages. 

- Để xem Notes Pages trước khi in, vào 

View->Notes Pages 

- Để thêm các phần đầu và phần chân 

vàophần ghi chú, chọn  

View->Master->Notes Master 

Baøi taäp : chuû ñeà  

THƢƠNG MẠI ĐIỆN TỬ  
 

1. Quy trình kinh doanh và hợp đồng trong 

thƣơng mại điện tử 
Các quy trình giao dịch trực tuyến  

Quy trình mua bán qua mạng  

Tổ chức giao hàng và thanh toán trên mạng 

 

2. Hợp đồng trong thƣơng mại điện tử  
Hình thức của hợp đồng  

Chủ thể của hợp đồng  

Các loại hợp đồng trong thương mại điện tử  

Nội dung của hợp đồng trong TMĐT  

Thời điểm hình thành hợp đồng  

Hợp đồng mua bán ngoại thương trong TMĐT  
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3. . Quy trình vận tải giao nhận trong thƣơng 

mại điện tử 
Vận tải giao nhận trong thương mại điên tử  

Vận đơn điện tử (Electronic Bill of Lading)  

Những vấn đề cần lưu ý khi áp dụng thương mại điện 

tử trong vận tải giao nhận 

 

4. Quy trình thanh toán trong TMĐT 
 Định nghĩa thanh toán điện tử  

 Lợi ích của thanh toán điện tử  

 Yêu cầu đối với thanh toán điện tử  

 Các bên tham gia trong thanh toán điện tử  

 Rủi ro trong thanh toán điện tử  

 Cở sở vật chất, kỹ thuật cho thanh toán điện tử 

 

5. Quy trình thanh toán trong TMĐT 

 Thanh toán điện tử giữa Doanh nghiệp - 

Ngƣời tiêu dùng (B2C)  
1. Quy trình thanh toán  

2. Các dịch vụ NH được sử dụng trong thanh 

toán B2C  

i. Dịch vụ ATM  

ii. Dịch vụ ngân hàng qua điện thoại (Tel 

Banking)  

iii. Dịch vụ ngân hàng tại chỗ (PC / Home 

banking)  

iv. Dịch vụ ngân hàng qua Internet (Internet 

banking)  

v. Dịch vụ EFTPOS  
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vi. Một số dịch vụ khác: Interactive TV, 

Wireless banking  

3. Các loại thẻ sử dụng trong thanh toán  

i. Thẻ tín dụng (Credit card)  

ii. Thẻ ghi nợ (Debit card)  

iii. Tiền điện tử (E-cash/Digital cash)  

iv. Các phương thức thanh toán khác: smart card; 

virtual cash; electronic wallets... 

 

6. Quy trình thanh toán trong TMĐT 

 Thanh toán điện tử giữa Doanh nghiệp - 

Doanh nghiệp (B2B)  
1. Tổng quan về EDI - Electronic Data 

Interchange  

2. Quy trình thanh toán dùng EDI  

3. Thanh toán điện tử trong ngoại thương  

i.SWIFT  

ii. Các phương thức thanh toán khác  

4. So sánh thanh toán ngoại thương truyền thống 

với thanh toán ngoại thương điện tử 

 

7. LUẬT ÁP DỤNG TRONG THƢƠNG MẠI 

ĐIỆN TỬ 

 Điều ước quốc tế về TMĐT  

 Luật mẫu về thương mại điện tử - 1996  

Luật về chữ ký điện tử  

Quy tắc về vận đơn điện tử  

 Tập quán quốc tế về TMĐT 

 

8. Xung đột luật trong thƣơng mại điện tử 
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So sánh nguồn luật điều chỉnh TMĐT với 

nguồn luật điều chỉnh TM truyền thống  

Xung đột luật trong TMĐT  

 Xung đột giữa luật mẫu về TMĐT và luật quốc gia  

 Xung đột giữa các luật quốc gia về TMĐT 

 

9. QUẢN LÝ RỦI RO TRONG THƢƠNG 

MẠI ĐIỆN TỬ  

 Các rủi ro thƣờng gặp trong thƣơng mại 

điện tử 

Nhóm rủi ro khách quan  

Nhóm rủi ro chủ quan 

 . Ảnh hƣởng của rủi ro tới hoạt động kinh 

doanh của doanh nghiệp trong thƣơng 

mại điện tử 
. Hạn chế hiệu quả kinh doanh  

 Thiệt hại về vật chất  

 Thiệt hại về thông tin, phần mềm, phần cứng  

 Mất cơ hội kinh doanh   

Ảnh hưởng đến uy tín doanh nghiệp 

 

10. Các biện pháp phòng tránh rủi ro trong 

TMĐT 
Bảo mật trong giao dịch  

a. Mã hoá dữ liệu  

b. Chữ ký điện tử  

c. Phong bì số (digital envelope)  

d. Cơ quan chứng thực (Certificate Authority)  

 Kiểm tra tính đúng đắn, chân thực của thông 

tin  

 Lưu trữ dữ liệu nhiều nơi, dưới nhiều hình thức  
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 Chống virus tấn công  

 Tham gia bảo hiểm 

 

11. MARKETING ĐIỆN TỬ  

Khái niệm về E-marketing  

Quá trình phát triển của marketing điện tử  

Điều kiện áp dụng marketing điện tử  

Các hoạt động marketing trong thương mại điện 

tử 

 

12. Nghiên cứu thị trường trong marketing điện tử 

Phân tích hành vi khách hàng trong TMĐT  

Nghiên cứu thị trường trực tuyến  

Phân đoạn thị trường, thị trường mục tiêu, định vị sản 

phẩm 

 

13. Chiến lược marketing điện tử 

Chiến lược sản phẩm  

 Chiến lược giá  

 Chiến lược phân phối  

 Chiến lược xúc tiến và hỗ trợ kinh doanh  

 Quản lý quan hệ khách hàng  

  Kế hoạch marketing trong TMĐT 

 

 Lưu ý : Sinh viên  

 Trình bày các từ khoá tìm kiếm, địa chỉ 

trang web tham khảo tài liệu 

 Nêu rõ nguồn gốc các tài liệu tham khảo 

sách, báo , tạp chí,…. 
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 Trình bày nội dung rõ ràng trong phần word, 

định dạng , thiết lập thư mục tự động (lưu ý 

lỗi chính tả )  

 Thể hiện các ý chính trên các trang 

powerpoint (chú ý bố cục các trang chiếu : 

giới thiệu/ các nội dung sẽ trình bày/ các 

trang trình bày/ phần kết luận + trình bày 

một số hiệu ứng cho slide và các thành phần 

trong slide )  

 Lưu trữ toàn bộ nội dung tham khảo vào thư 

mục Internet  

 Tạo các đường liên kết đến các trang web đã 

download.  

 Có thể thực hiện theo nhóm Chủ đề 5 (tối đa 

4sv), chủ đề khác (tối đa 2sv) 

Ngòai ra sinh viên có thể chọn các chủ đề gần gũi với 

các vấn đề Xã hội – Kinh tế - Chính trị nóng bỏng 

đương thời. 
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CHƢƠNG 4: INTERNET  

 

I. KHAÙI NIEÄM :  

1/- Internet chính xaùc laø gì?  

 Internet laø vieát taét cho Maïng Quoác Teá 

(INTERnational NETwork). 

 Internet khoâng phaûi laø moät maïng duy nhaát, noù 

laø moät maïng roäng lôùn ñöôïc hình thaønh töø 

haøng ngaøn maïng (Network) vaø toå chöùc rieâng 

bieät. Moãi maïng rieâng naøy hoaït ñoäng ñoäc laäp 

(veà noäi dung, cô caáu, toå chöùc, chi phí hoaït 

ñoäng, . . .).  

 Internet laø moät taäp hôïp caùc maùy tính vaø maùy 

phuïc vuï treân toaøn caàu. Noù laø maïng 

khaùch/phuïcvuï vì coù nhieàu maùy phuïc vuï löu 

thoâng tin vaø baïn coù theå truy nhaäp caùc thoâng 

tin ñoù töø caùc maùy tính khaùc. Internet coù haøng 

trieäu maùy phuïc vuï vaø haøng trieäu maùy khaùch 

cuøng vôùi khoái löôïng thoâng tin ñöôïc löu tröõ raát 

lôùn. 

 Ñeå ñaït ñöôïc tính hieäu quaû, caùc maïng cuïc boä 

ñöôïc noái keát vôùi nhau thaønh caùc maïng khu 

vöïc thoâng qua caùc daây daãn keát noái, caùp 

quang, veä tinh. 

 Caùc maïng khu vöïc: cung caáp vaø duy trì söï truy 

caäp Internet trong moät vuøng ñòa lyù. Caùc maïng 

khu vöïc coù theå bao goàm: 

 Caùc maïng nhoû hôn. 
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 Caùc dòch vuï lôùn veà tröïc tuyeán nhö 

American Online vaø CompuServe. 

 Hoaëc caùc toå chöùc trong vuøng nhö:  

 Caùc tröôøng ñaïi hoïc. 

 Caùc maïng cuïc boä cuûa Coâng ty. 

 . . . 

2/- Caùc khaû naêng hoã trôï cuûa Internet ñoái vôùi con 

ngöôøi  

 Ñaëc ñieåm: 

 Internet laø moät kho thoâng tin voâ taän veà taát 

caû caùc lónh vöïc. 

 Thoâng tin treân Internet ñöôïc caäp nhaät lieân 

tuïc töøng giaây töøng phuùt. 

 Caùc khaû naêng hoã trôï cuûa Internet: 

 Tìm kieám thoâng tin lieân quan ñeán coâng 

vieäc cuûa mình (saùch baùo, taïp chí, . . . 

chuyeân ngaønh). 

 Caøi ñaët hoäi thoaïi töø xa (ñieän thoïai, thaûo 

luaän, . . . thoâng qua caùc phaàn meàm 

chuyeân duøng). 

 Khaùm phaù caùc nguoàn taøi nguyeân höõu 

duïng. 

 Thaêm caùc vieän baûo taøng treân theá giôùi. 

 Xem video, nghe nhaïc vaø ñoïc caùc taïp chí 

ña phöông tieän. 

 Mua saém haøng hoùa. 

 Thö ñieän töû (Email).  

3/- Ñöôøng ñi cuûa döõ lieäu treân Internet  
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a.- Ñöôøng ñi :  

 Ví duï, baïn caàn göûi thö ñieän töû cho moät 

ngöôøi ñang ôû Myõ.  

 

 B1: Ñaàu tieân, böùc thö töø maùy tính cuûa baïn 

ñöôïc chuyeån ñeán nôi baïn ñaêng kyù dòch 

vuï thö ñieän töû - thöôøng goïi laø nhaø cung 

caáp dòch vuï Internet (ISP, caùc ISP taïi 

Vieät Nam hieän nay nhö: VDC, FPT, Saøi 

Goøn Postel, Vieän Khoa Hoïc Coâng Ngheä, 

. . .) thöôøng laø theo ñöôøng ñieän thoaïi.  

 B2: ISP naøy thoâng qua moät toå chöùc khaùc 

goïi laø IAP(nôi quaûn lyù coång vaøo 

Internet, hieän nay ôû Vieät Nam chæ coù 

VDC - thuoäc Toång Coâng Ty Böu Chính 

Vieãn Thoâng VN - ñaûm traùch coâng vieäc 

naøy) ñeå göûi böùc thö cuûa baïn leân Internet.  

 B3: Sau khi ñaõ leân Internet, thö cuûa baïn 

seõ ñi ñeán ñòa chæ maø baïn ñaõ chæ ra khi 

göûi - thöôøng laø moät server thö tín cuûa 
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ISP ñang cung caáp dòch vuï cho ngöôøi maø 

baïn göûi thö. Tröôùc khi ñeán ISP cuûa nôi 

nhaän, böùc thö thöôøng phaûi ñi qua IAP 

cuûa ISP nôi ñeán.  

 B4: Khi thö ñeán ñöôïc server thö tín cuûa 

ISP nôi nhaän, böùc thö ñöôïc löu vaøo hoäp 

thö rieâng cuûa ngöôøi nhaän naèm treân maùy 

chuû cuûa ISP.  

 B5: Ngöôøi nhaän thö sau ñoù seõ truy caäp 

vaøo hoäp thö cuûa mình (taát nhieân cuõng 

baèng maùy tính) ñeå laáy böùc thö ñoù. Toaøn 

boä quaù trình treân ñöôïc thöïc hieän töï ñoäng 

vaø chæ xaûy ra trong thôøi gian thôøi gian raát 

ngaén, tuøy thuoäc vaøo löu löôïng giao dòch 

treân Internet (xem hình minh hoïa).  

 Töông töï nhö ñöôøng ñi treân khi baïn caàn truy 

caäp moät website (yeâu caàu cung caáp thoâng 

tin cuûa website), luùc naøy ñòa chæ cuûa 

website nôi ñeán cuõng ñöôïc xem nhö ñòa chæ 

cuûa böùc thö baïn caàn gôûi ôû treân. Chæ khaùc laø 

khi ñeán ISP cuûa website, ISP seõ chuyeån 

yeâu caàu cuûa baïn veà server cuûa website ñeå 

server naøy phaûn hoài thoâng tin maø baïn ñang 

yeâu caàu. 

b.- Khaùi nieäm xa loä thoâng tin:  

Qua ví duï treân, ta thaáy Internet ñoùng vai troø 

cuûa moät ñöôøng truyeàn taûi thoâng tin khoång loà, 

trong ñoù IAP, ISP nhö laø caùc traïm trung chuyeån 
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ñeå keát noái vaø cung caáp dòch vuï. Nhö vaäy, coù theå 

hình dung Internet nhö moät con ñöôøng cao toác keát 

noái caùc quoác gia, caùc toå chöùc laïi vôùi nhau. Bôûi 

vaäy khaùi nieäm xa loä thoâng tin cuõng laø moät khía 

caïnh cuûa Internet.  

II. CAÙ NHAÂN HAY TOÅ CHÖÙC NAØO ÑIEÀU 

KHIEÅN/ PHUÏ TRAÙCH INTERNET?  

 Khoâng coù caù nhaân naøo phuï traùch Internet.  

 ISOC (Internet SOCiety): 

 Do caùc nhaø tình nguyeän laäp neân vaø laø toå chöùc 

coù traùch nhieäm coù traùch nhieäm hoaøn toaøn veà 

Internet.  

 ISOC ñaûm baûo coù caùc quy taéc cuï theå cho taát caû 

caùc maùy tính coù theå lieân laïc. 

 YÙ töôûng cô baûn cuûa toå chöùc naøy laø khuyeán 

khích söï trao ñoåi thoâng tin toaøn caàu thoâng qua 

Internet.  

 The Internet Architecture Board (IAB): 

 Laø moät uûy ban vôùi nhöõng thaønh vieân töï nguyeän 

– chính nhöõng thaønh vieân naøy laø ngöôøi quyeát 

ñònh höùông phaùt trieån cuûa Internet vaø cuõng 

chính hoï laø ngöôøi quaûn lyù kyõ thuaät vaø quy 

ñònh caùc chöùc naêng thích hôïp cuûa Internet.  

 IAB toå chöùc caùc cuoäc hoïp veà nguyeân taéc, quy 

ñònh ñeå tieâu chuaån hoaù vaø phaân chia caùc 

nguoàn döõ lieäu nhö: nhöõng ñòa chæ cuûa nhöõng 

trang Web hoaëc vò trí cuûa nguoàn.  
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 IAB giöõ haøng loaït caùc caùc con soá ña daïng vaø 

phaûi löu giöõ nhöõng con soá ñoù moät caùch ñaëc 

bieät. Thí duï nhö moãi maùy vi tính treân maïng 

ñeàu coù ñòa chæ ñaëc bieät maø khoâng coù moät maùy 

tính naøo coù theå coù (ñöôïc löu tröõ trong 1 tröõ 

löôïng 32- bit). 

III. MOÄT SOÁ THUAÄT NGÖÕ:  

Địa chỉ Internet 

1) Địa chỉ IP (Internet Protocol Address)  

Khi tham gia vào Interntet, các máy tính gọi là 

các host, phải mang một địa chỉ IP dùng để 

nhận dạng. Địa chỉ IP được chia làm 4 số thập 

phân giới hạn từ 0 - 255, phân cách nhau bằng 

dấu chấm.  

Ví dụ: 172.16.19.5; 172.16.0.3; …  

2) Hệ thống tên miền DNS (Domain Name 

System)  

Địa chỉ IP gồm các số rất khó nhớ và khó sử 

dụng, cần phải xây dựng một hệ thống địa chỉ 

Internet khác, đó chính là hệ thống tên miền 

DNS, để đặt tên cho các host trên Internet.  

Ví dụ: www.yahoo.com, 

www.microsoft.com, www.ctu.edu.vn,  ...  

Mỗi host trên Internet sẽ có hai địa chỉ: địa chỉ 

IP và địa chỉ tên miền được ánh xạ với nhau. 

Khi người sử dụng dùng tên miền, nó sẽ được 

chuyển đổi qua địa chỉ IP tương ứng.  
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Các phần com, edu hay vn trong địa chỉ tên 

miền ở trên được gọi là tên miền cấp 1 (First-

level Domain hay Top-level Domain). Có hai 

loại Top-level Domain chính:  

 Domain mang tính tổ chức:  

 

Domain  Tổ chức  

com (Commercial)  Thương mại  

edu (Educational)  Giáo dục  

gov (Governmental)  Nhà nước  

int (International)  Tổ chức quốc tế  

mil (Military)  Quân đội  

net (Networking)  Tài nguyên trên mạng  

org (Organizational)  Các tổ chức khác  

 

 Domain mang tính địa lý: gồm 2 ký tự 

tắt đại diện cho từng quốc gia.  

 

Domain  Quốc gia  

at  Áo  

au  Úc  

ca  Canada  

de  Đức  

Fr  Pháp  

jp  Nhật  
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uk  Anh  

us  Mỹ  

vn  Việt Nam  

Một số thành phần trên Internet 

1) Nhà cung cấp truy cập Internet IAP 

(Internet Access Provider)  

IAP là nhà cung cấp dịch vụ đường truyền 

để kết nối với Internet, quản lý cổng 

(gateway) nối với quốc tế.  

IAP ở Việt Nam: Công ty dịch vụ truyền 

số liệu VDC thuộc tổng công ty bưu chính 

viễn thông, cơ quan thực hiện trực tiếp là 

VNN.  

2) Nhà cung cấp dịch vụ Internet ISP 

(Internet Service Provider)  

ISP là nhà cung cấp dịch vụ Internet cho 

các tổ chức và cá nhân, còn được gọi là 

các ISP thương mại. ISP phải thuê đường 

truyền và cổng của một IAP.  

ISP thương mại ở Việt Nam: Công ty dịch 

vụ truyền số liệu VDC thuộc tổng công ty 

bưu chính viễn thông, Công ty FPT thuộc 

Bộ khoa học công nghệ và môi trường, …  

3) ISP dùng riêng  

Là nhà cung cấp dịch vụ Internet không 

mang tính chất kinh doanh. Đây là loại 

hình dịch vụ Internet của các cơ quan hành 
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chính, các trường đại học,viện nghiên cứu, 

…  

ISP dùng riêng ở Việt Nam: mạng của 

Trung tâm khoa học và kỹ thuật hạt nhân, 

mạng Khoa học giáo dục VARENet.  

4) Ngƣời sử dụng Internet  

Người sử dụng Internet là người sử dụng 

các dịch vụ Internet. Những người này 

phải đăng ký với một ISP, có một tài 

khoản (Account) để quản lý truy cập và 

tính toán chi phí phải trả cho ISP. Khi 

đăng ký với ISP, người sử dụng cần phải 

biết:  

 ISP có cung cấp đầy đủ các dịch vụ của 

Internet không?  

 ISP được truy nhập thông qua đường 

điện thoại cục bộ hay đường dài.  

 Tốc độ đường truyền của ISP.  

 Phương thức và chi phí phải thanh toán.  

5) Tài khoản ngƣời dùng trên Internet  

Khi đăng ký với một ISP, người dùng 

được cung cấp một tài khoản. Mỗi tài 

khoản bao gồm tên (User name) và mật 

khẩu đăng nhập (Password).  

Ngoài việc sử dụng tài khoản do ISP cấp 

để quản lý truy cập và tính toán chi phí, 

khi sử dụng Internet có thể có nhiều trang 

Web yêu cầu bạn phải có một tài khoản 

đăng nhập vào mới sử dụng được một số 
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dịch vụ khác, đó là tài khoản của người 

dùng Internet.  

IV. CHOÏN PHÖÔNG PHAÙP TÌM KIEÁM 

THOÂNG TIN TREÂN INTERNET  

1/- Tìm theo heä thoáng caây phaân caáp veà chuû ñeà:   

 Laø duyeät laàn theo töøng khaùi nieäm töø toång quaùt 

ñeán cuï theå cho ñeán khi tìm ñöôïc thoâng tin caàn 

tìm. 

 Thöïc hieän (minh hoïa baèng trang google): 

 B1: Vaøo trang www.google.com.vn 

 B2: click choïn Thö muïc ( ) 

 B3:click choïn World 

 

 

 B4: click choïn Vietnamese  

Chọn World  
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 B5: click choïn Kinh teá vaø doanh nghieäp   

 

Chọn 

Vietnamese 

Click vaøo ñaây 
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 B6: xuaát hieän caùc trang web veà caùc doanh 

nghieäp. Choïn trang web caàn tìm  

 

 

 B7: Choïn Phoøng thöông maïi vaø Coâng 

nghieäp Vieät Nam  

Nhöõng trang web veà kinh 

teá vaø doanh nghieäp 
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 Keát quaû tìm kieám: 

Click vaøo ñaây 
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2/- Duøng Search Engine: (minh hoïa baèng trang 

Google)   

 
B1: Vaøo trang www.google.com.vn 

 

 B2: Thöïc hieän tìm kieám 

http://www.google.com.vn/
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Keát quaû tìm kieám: 

 

3/- Tìm kieám vôùi Google:   

a.- Tìm kieám naâng cao vôùi Google: 

 Töø maøn hình trang chuû Google.com.vn, choïn 

muïc Advanced Search ñeå söû duïng trang tìm 

kieám tieán boä. Trong trang naøy,  ngöôøi duøng deã 

Nhaäp töø caàn tìm 

Click nuùt Tìm kieám vôùi Google 

Click vaøo moät trong 

nhöõng keát quaû 
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daøng thu heïp phaïm vi tìm kieám laøm cho boä 

tìm kieám cho keát quaû nhanh vaø ñuùng vôùi 

mong muoán cuûa ngöôøi duøng hôn. 

 

 

 

 Chính xaùc nhoùm töø. Goõ töø khoùa caàn tìm kieám, 

xong nhaán Enter. 

 Ngaøy thaùng: coù theå ñaët ñieàu kieän ñeå nhöõng 

trang Web keát quaû chæ laø nhöõng trang môùi 

xuaát baûn trong 6 thaùng gaàn ñaây. 

 

b.- Keát hôïp giöõa tìm kieám theo ñieàu kieän vaø theo chuû 

ñeà: 

 Laø tìm kieám theo heä thoáng caây phaân caáp (xem 

laïi phaàn X.1). 
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 Thí duï: Neáu ngöôøi duøng muoán tìm kieám caùc 

phaàn meàm daïy hoïc mieãn phí thì vieäc ñôn giaûn 

vaø nhanh nhaát laø tìm ñeán chuû ñeà Computer> 

Software> Educational > . . . 

 Caùch thöïc hieän: 

 Töø maøn hình chính cuûa Google, baïn choïn 

muïc Chuû ñeà (Thö muïc). 

 Cöûa soå chöùa caùc chuû ñeà seõ xuaát hieän: 

 

 Choïn chuû ñeà baïn muoán laáy noäi dung cho 

ñeán khi baïn thaáy ñòa chæ trang Web caàn 

tìm. 
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 Keát hôïp giöõa tìm kieám theo ñieàu kieän vaø 

theo chuû ñeà: Giaû söû ta laøm tieáp theo phaàn 

treân ñeå tìm ñöôïc caùc trang Web noùi veà 

phaàn meàm daïy hoïc mieãn phí. Trong 

trang Web keát quaû, baïn goõ theâm töø khoùa 

Freeware roài click choïn Search only in 

Educational. Baïn seõ coù trang keát quaû sau 

ñaây: 
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c.- Tìm noäi trong keát quaû tìm kieám ñaõ coù: 

 Laø tìm noái tieáp treân keát quaû ñaõ coù. Nhô vaäy 

ngöôøi duøng khoâng caàn nhaäp caâu ñieàu kieän 

quaù daøi ngay töø ban ñaàu.  

 Thí duï: 

 

 Sau khi tìm ñöôïc caùc trang Web coù noùi veà 

Döï aùn THCS, baïn muoán tìm thoâng tin 

chính xaùc hôn veà Döï aùn THCS ôû Vuõng 

Taøu, click choïn . Cöûa 

soå Tìm noäi trong keát quaû xuaát hieän: 
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 Nhö vaäy, baïn seõ tìm ñöôïc caùc trang Web 

noùi veà Döï aùn THCS ôû Vuõng Taøu. Coâng 

vieäc coøn laïi laø baïn chæ caàn choïn trang web 

maø mình mong muoán. 

c.- Tìm kieám hình aûnh:  

 Töông töï nhö tìm trang Web. Baïn vaãn phaûi goõ 

töø khoùa cuûa hình aûnh caàn tìm, sau ñoù nhaép 

vaøo link Hình aûnh. Baïn seõ thaáy keát quaû laø coù 

nhieàu hình aûnh hieän ra. 

 

 Click vaøo hình aûnh caàn thieát ñeå coù theå xem 

hình aûnh vôùi kích thöôùc lôùn hôn. 

 Muoán löu hình vaøo ñóa, ta click chuoät phaûi vaøo 

hình roài choïn Save Picture as . . . 

4/- Tìm kieám baèng chöùc naêng Search cuûa IE 6.0:   

a.- Tìm kieám baèng nuùt leänh Search: 

 Töø cöûa soá cuûa Internet Explorer, click choïn nuùt 

leänh Search treân thanh coâng cuï. Cöûa soå 

Search Companion seõ xuaát hieän beân traùi cöûa 

soå IE. 
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 Goõ töø khoùa caàn tìm vaøo khung What are you 

looking for? Roài click choïn Search.  

 Danh saùch caùc trang Web ñöôïc tìm thaáy seõ 

xuaát hieän, baïn chæ caàn click vaøo ñòa chæ link 

ñöôïc hieån thò trong danh saùch. 

b.- Tìm kieám baèng thanh Address: 

 

 

 Ñeå tìm kieám nhanh, baïn goõ vaøo thanh Address 

töø khoùa coù daïng sau: 

?       Töø caàn tìm 

Go    Töø caàn tìm 

Find  Töø caàn tìm 

 Thí duï: ñeå tìm caùc trang Web lieân quan ñeán 

Nobel, ta goõ nhö sau: 
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?  Nobel  

hoaëc go  Nobel  

hoaëc find Nobel. 

5/- Giao dieän cuûa moät soá website hoã trôï vieäc tìm kieám:   

Ñeå thöïc hieän tìm kieám treân caùc trang Web 

naøy, baïn chæ caàn nhaäp töø khoùa caàn tìm kieám vaøo 

khung Search (hay Find), sau ñoù nhaép vaøo nuùt leänh 

Search (hay Find). 

Keát quaû tìm ñöôïc seõ hieån thò ngay beân döôùi. 

Neáu keát quaû coù nhieàu trang, baïn haõy click choïn 

Next (beân döôùi danh saùch keát quaû) ñeå sang trang keá 

tieáp. 

 www.yahoo.com 
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www.excite.com

 
www.msn.com 

 

 

 

http://www.msn.com/
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V. DOWNLOAD VAØ SAVE TAØI LIEÄU:   

1/. Download (taûi) taøi lieäu:   

 Trong caùc trang web coù hoã trôï vieäc taûi taøi 

lieäu (Download) xuoáng maùy tính cuûa baïn, baïn chæ 

vieäc click traùi vaøo muïc caàn duøng, seõ xuaát hieän 

caùc muïc choïn: 

 Open: muoán môû taäp tin ra xem. 

 Save: ghi vaøo ñóa (Save). Neáu choïn nuùt naøy, seõ 

xuaát hieän tieáp hoäp thoaïi Save ñeå baïn choïn thö 

muïc seõ löu taøi lieäu. Click OK maùy seõ thöïc 

hieän vieäc taûi taøi lieäu vaø ghi treân ñóa cuûa baïn 

theo caùc löïa choïn. 

 

2. Söû duïng phaàn meàm ñeå download taøi lieäu:   

Thoâng thöôøng, neáu baïn keát noái Internet thoâng 

qua ñöôøng daây ñieän thoaïi thì toác ñoä download 

khoâng cao, coù theå bò maát keát noái giöõa chöøng. Toát 

nhaát, baïn neân caøi ñaët moät phaàn meàm hoã trôï vieäc 

download nhö: coù khaû naêng taêng toác, taïm ngöng 

vieäc download (resume), . . . 
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a.- FlashGet: 

 Thöôøng duøng khi caàn löu 1 (hay nhieàu) taäp tin 

hoaëc 1 trang web. 

 Sau khi ñaõ caøi ñaët, trong tröôøng hôïp baïn ñang 

xem 1 trang Web treân Internet vaø muoán ghi 

laïi noäi dung ñang xem, baïn thao taùc nhö sau: 

 Ghi caû trang Web: choïn File – Save as – 

Choïn thö muïc, Goõ teân – Save. 

 Chæ ghi noäi dung: Ñaùnh daáu noäi dung caàn 

sao cheùp, choïn Edit -> Copy -> môû MS-

Word vaø daùn (Paste) noäi dung leân trang 

vaên baûn cuûa MS-Word. 

 Maøn hình FlashGet: 

 

b.- Teleport Pro: 

 Thöôøng duøng khi muoán ghi laïi caû Website 

(nhieàu trang coù lieân keát vôùi nhau). 

 Maøn hình Teleport Pro: 
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 Söû duïng: 

 B1:  

 Click choïn New Project Wizard ñeå taûi 

moät trang Web môùi. 

 Trong hoäp thoaïi New Project Wizard 

Choïn . . .hard drive ñeå taûi trang Web 

veà ñóa cöùng. 

 

 

 B2: 
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 Goõ ñòa chæ trang Web caàn taûi veà ñóa 

cöùng. 

 Choïn soá caáp baäc lieân keát con tính töø 

trang caàn taûi. 
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 B3:  

 Choïn ñoái töôïng caàn download treân 

trang Web. (Everything). 

 Nhaäp account, password neáu trang 

web caàn taûi veà caàn. 

 

 B4: Choïn Finish ñeå keát thuùc quaù trình 

khai baùo cho Project. 

 



   176 

 



   177 

 B5: Tröôùc khi taûi trang Web, baïn caàn 

choïn teân Project (thö muïc) khi löu vaøo 

ñóa cöùng. 

 

 

 B6: Coâng vieäc sau cuøng laø baïn click nuùt 

leänh Start ñeå taûi veà. 

 

 



   178 

DỊCH VỤ THƢ ĐIỆN TỬ 

GIỚI THIỆU 

Thư điện tử (Email) là phương tiện liên lạc vô cùng 

tiện lợi trong thời đại công nghệ thông tin ngày nay. 

Sử dụng Email ta có thể trao đổi thông tin với bạn bè, 

đồng nghiệp trên toàn cầu. Ưu điểm nổi bật nhất của 

việc sử dụng Email là nhanh, rẻ, mọi lúc mọi nơi.  

Nguyên lý vận hành 

Muốn sử dụng thư điện tử thì người dùng phải 

có máy tính nối kết Internet hoặc nối kết vào 

máy chủ cung cấp dịch vụ Email (Mail Server). 

Ngoài ra, để gởi hoặc nhận Email thì người sử 

dụng phải có tài khoản Email và danh sách địa 

chỉ Email của người nhận.  

Cấu trúc một địa chỉ Email 

Địa chỉ Email (Email Address) là 1 định danh 

trên Internet cho phép người sử dụng Internet 

nhận biết được chính xác người cần liên hệ, 

giao dịch, trao đổi thông tin và ra lệnh gửi các 

thông điệp, tài liệu, hình ảnh (Email message) 

tới định danh này.  

Cấu trúc một địa chỉ Email:  

<Tên tài khoản>@<Tên miền> 

 Tên miền: tên của máy tính Server lưu và 

quản lý địa chỉ Email này.  

 Tên tài khoản: tên được đăng ký, để phân 

biệt với các địa chỉ Email khác có cùng 

tên miền.  
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Ví dụ: info@yahoo.com; surport@ctu.edu.vn; 

webmaster@ctu.edu.vn; … 

Webmail 

Webmail là hệ thống cung cấp các dịch vụ 

Email (nhận, gửi, lọc Email) thông qua 1 

Website nào đó trên mạng Internet. Thông 

thường, đây là hệ thống cung cấp địa chỉ Email 

miễn phí. Để gửi và nhận Email, người sử dụng 

Internet chỉ có 1 cách duy nhất là dùng  

trình duyệt Web truy cập vào địa chỉ Website 

của nhà cung cấp dịch vụ, sử dụng Account đã 

được cung cấp để kiểm tra Email và sử dụng 

các dịch vụ Email thông thường khác.  

Ví dụ về các nhà cung cấp các dịch vụ Email:  

www.vol.vnn.vn; 

 www.hotmail.com;  

www.mail.yahoo.com;  

www.webmail.ctu.edu.vn;  

www.gmail.google.com , … 

CHƢƠNG TRÌNH OUTLOOK EXPRESS 

Outlook Express là phần mềm quản lý Email 

được cài đặt sẵn trong các máy tính sử dụng hệ 

điều hành Windows. Phần mềm này cung cấp hầu 

hết các tính năng cần thiết để người dùng có thể 

quản lý Email một cách hiệu quả.  

Các thành phần trong Outlook Express  

http://www.vol.vnn.vn/
http://www.hotmail.com/
http://www.mail.yahoo.com/
http://www.webmail.ctu.edu.vn/
http://www.gmail.google.com/
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1) Khởi động Outlook Express: chọn menu 

Start/ Programs/ Outlook Express, cửa sổ 

Oulook Express xuất hiện như sau:  

 

2) Thanh công cụ  

 Create Mail : soạn Email mới.  

 Reply: trả lời Email đang mở cho người 

gởi.  

 Reply All: trả lời Email đang mở cho tất 

cả các người có trong danh sách người 

nhận của Email đang mở.  

 Forward: gởi Email nhận được cho 

những người khác.  

 Print: in Email đang mở.  

 Delete: xóa Email đã chọn.  

 Send/Recv: gởi/ nhận Email mới từ máy 

chủ.  

 Addresses: mở danh sách địa chỉ Email.  



   181 

Sử dụng hotmail 

MSN Hotmail là hệ thống Email sử dụng giao 

diện Web. Đối với hệ thống này người dùng có 

thể sử dụng bất cứ máy tính nào có nối kết 

Internet để gởi và nhận Email.  

Để sử dụng Hotmail, người dùng phải đăng ký 

tài khoản với dịch vụ Hotmail. Nhập vào địa chỉ 

của Hotmail: www.hotmail.com, trang chủ của 

Hotmail xuất hiện như sau:  

 

1) Tạo tài khoản mới trong Hotmail  

Từ trang chủ của Hotmail, Click vào nút New 

Account Sign Up. Điền các thông tin cần thiết 
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 Đọc thỏa thuận “Điều khoản sử dụng” 

(Term of Use), nhấn nút I Agree nếu 

chấp nhận các điều khoản sử dụng.  

 Chọn thêm một số tùy chọn (nếu muốn) 

về các bản tin miễn phí, rồi Click 

Continue.  

 Chọn thêm một vài tùy chọn rồi nhấn 

Continue to E-mail.  

Sử dụng yahoomail 

Để sử dụng Yahoomail, người dùng phải đăng 

ký tài khoản với dịch vụ Yahoomail. Nhập vào 

địa chỉ của Yahoomail: www.mail.yahoo.com, 

trang chủ của Yahoomail xuất hiện như sau  
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Sử dụng Yahoomail cũng tương tự như 

Hotmail. Nếu có sẵn tài khoản, bạn có thể đăng 

nhập để sử dụng trong mục Enter your ID and 

Password, rồi Click Sign in. Nếu chưa có tài 

khoản, bạn có thể tạo tài khoản bằng cách Click 

vào Sign Up Now, khi đó sẽ xuất hiện 3 lựa 

chọn cách tạo tài khoản (có miễn phí hay 

không). Để sử dụng dịch vụ mail miễn phí, bạn 

Click vào tùy chọn “Free!”  

 
Sau đó điền thông tin cá nhân và thông tin về tài khoản 

của mình vào mẫu đăng ký. Sau khi đăng ký thành công, 

bạn có thể sử dụng tài khoản đó để đăng nhập và sử 

dụng dịch vụ Mail của Yahoo tương tự các dịch vụ của 

Hotmail. 
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CHƢƠNG 5: MICROSOFT ACCESS 

I. KHAÙI NIEÄM 

 Cô sôû döõ lieäu. 

Cô sôû döõ lieäu laø moät boä söu taäp goàm nhieàu 

baûng döõ lieäu. Moät baûng döõ lieäu goàm nhieàu doøng vaø 

nhieàu coät. Heä quaûn trò cô sôû döõ lieäu laø moät phaàn 

meàm phuïc vuï cho vieäc thu thaäp vaø truy vaán döõ lieäu.  

 Caùch thöùc thieát keá CSDL  

Thoâng thöôøng ngöôøi ta chia heä thoáng döõ lieäu 

ra thaønh nhöõng baûng khaùc nhau. Moãi baûng bao goàm 

nhöõng tröôøng (coøn goïi laø coät, thuoäc tính ). Caùc baûng 

trong CSDL thöôøng coù moái quan heä vôùi nhau. 

Ví duï : Ñeå theo doõi tình hình mua haøng vaø 

thanh toaùn cho khaùch haøng ta caàn coù caùc baûng : 

Khaùch haøng, Hoaù ñôn mua haøng ( Phieáu nhaäp kho ), 

Thanh toaùn caùc hoùa ñôn ( Phieáu thu  tieàn)  

Nhöõng giai ñoaïn thieát keá moät cô sôû döõ lieäu 

thöôøng laø : 

Xaùc ñònh muïc tieâu cuûa cô sôû döõ lieäu  

Tìm hieåu nhöõng yeâu caàu, thu thaäp nhöõng baûng 

baùo caùo caàn thieát  cuõng nhö caùc maãu bieåu ñeå nhaäp 

lieäu vaøo cho heä thoáng. 

Xaùc ñònh caùc baûng döõ lieäu sô khôûi  

Xaùc ñònh caùc tröôøng cuûa baûng döõ lieäu  

 Moãi tröôøng phaûi coù quan heä tröïc tieáp vôùi thöïc theå 

chöùa noù  
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 Khoâng khai baùo caùc tröôøng tính toaùn hay caùc 

tröôøng coù theå tham chieáu töø baûng khaùc vaøo baûng döõ 

lieäu  

 Moãi baûng coù moät tröôøng ( hay moät nhoùm tröôøng 

laøm khoùa chính ( Primarykey) cho moãi baûng vaø löu 

yù: 

 Access khoâng cho pheùp khoùa chính coù giaù trò roãng 

(Null) hay truøng nhau 

 Khoùa chính thöôøng duøng ñeå saép xeáp vaø truy tìm döõ 

lieäu. Do ñoù khoâng neân ñaët teân quaù daøi vaø phaûi 

mang tính gôïi nhôù ñeå tieän cho vieäc thoáng keâ döõ 

lieäu 

 Ta neân nhôù moät tröôøng coù theå laø khoaù chính cuûa 

baûng naøy nhöng khoâng haún laø khoùa chính cuûa baûng 

kia  

 Ví duï : Maõ sinh vieân laø khoùa chính cuûa baûng 

Sinhvieân. Nhöng khoâng phaûi laø khoùa chính cuûa 

baûng Saùch, trong baûng Saùch cho pheùp maõ sinh vieân 

truøng nhau vì sinh vieân naøy coù theå möôïn saùch 

nhieàu laàn. 

Xaùc ñònh moái quan heä giöõa caùc baûng  

Moät ñieåm maïnh cuûa Access cuõng nhö caùc 

phaàn meàm quaûn trò döõ lieäu sau naøy laø thieát laäp moái 

quan heä giöõa caùc baûng döõ lieäu baèng thao taùc ( Thay 

vì duøng caùc leänh ) vaø coù theå nhìn thaáy ñöôïc chuùng. 

Ví duï : 

 Moái quan heä giöõa Sinhvieân  vaø Khoa ñöôïc thieát laäp 

treân tröôøng Maõ khoa. 
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 Moái quan heä giöõa Sinhvieân vaø Saùch ñöôïc thieát laäp 

treân tröôøng Maõ saùch.  

 Giôùi thieäu caùc loaïi quan heä  

 Quan heä moät – moät :  

Laø moái quan heä maø moät maãu tin cuûa baûng naøy 

coù moái quan heä vôùi moät maãu tin cuûa baûng kia vaø 

ngöôïc laïi.  

 Quan heä moät – nhieàu :  

Laø moái quan heä maø moät maãu tin cuûa baûng coù 

quan heä vôùi nhieàu maãu tin cuûa baûng döõ lieäu kia ( 

nhöng khoâng coù chieàu ngöôïc laïi ) 

 Khoaù chính (Primary Key):  

Laø moät hoaëc nhieàu tröôøng trong baûng maø döõ 

lieäu taïi coät naøy phaûi khoâng roãng vaø duy nhaát. Töø 

giaù trò cuûa khoùa chính xaùc ñònh ñöôïc duy nhaát moät 

boä giaù trò trong baûng. 

 Khoùa ngoaïi (Foreign key):  

Laø moät hoaëc nhieàu tröôøng trong moät baûng maø 

caùc tröôøng naøy laø khoùa chính cuûa moät baûng khaùc. 

II. TAÏO LAÄP MOÄT CÔ SÔÛ DÖÕ LIEÄU  

 Caùc ñoái töôïng trong Cô sôû döõ lieäu 

Access 

Trong Access moät CSDL ñöôïc löu tröõ trong 

moät taäp tin duy nhaát laø .MDB. Taäp tin naøy chöùa 6 

ñoái töôïng cuûa CSDL laø Table, Query, Form, Report, 

Macro vaø Module. 

Table-baûng: Laø thaønh phaàn quan troïng nhaát, 

cô baûn nhaát cuûa CSDL. Duøng ñeå löu tröõ döõ lieäu, laø 
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moät trong caùc coâng cuï giuùp ngöôøi söû duïng moâ taû 

phaàn löu tröõ soá lieäu, vaø cho pheùp ngöôøi söû duïng 

xem hay nhaäp soá lieäu tröïc tieáp vaøo cô sôû döõ lieäu. 

Query – baûng vaán tin:  Duøng ñeå xöû lyù soá lieäu. 

Query laø coâng cuï giuùp xöû lyù soá lieäu raát hieäu quaû 

nhö tính toaùn, ruùt trích, toång hôïp, taïo döõ lieäu nguoàn 

cho caùc ñoái töôïng khaùc… 

Form – bieåu maãu: Ñeå xem, nhaäp döõ lieäu vaøo 

CSDL. Maøn hình nhaäp gaàn guõi vôùi ngöôøi söû duïng. 

Report – Baùo bieåu: Ñeå xem, in döõ lieäu ra 

giaáy. Baùo bieåu vôùi hình thöùc trình baøy phong phuù  

Macro – Vó moâ: Moät taäp hôïp caùc leänh ñöôïc 

choïn, saép xeáp hôïp lyù nhaèm töï ñoäng hoùa moät soá thao 

taùc thöôøng duøng.  

Module – ñôn theå chöông trình: Laø phöông 

tieän laäp trình trong Access vôùi ngoân ngöõ laäp trình 

Access Basic. 
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III. KHÔÛI ÑOÄNG – THAO TAÙC TREÂN TAÄP 

TIN CSDL 

  Khôûi Ñoäng Access 

 Taïo Môùi Cô sôû döõ lieäu  

 

 MÔÛ MOÄT CÔ SÔÛ DÖÕ LIEÄU 

Nhaép coâng cuï Open treân database Toolbar 

(hoaëc File -  Open) xuaát hieän : 

Choïn oå ñóa, folder vaø choïn teân CSDL. Xong 

choïn Open 

  ÑOÙNG CSDL: Choïn File, Close 

Khi chaám döùt laøm vieäc vôùi CSDL, neân nhôù 

ñoùng CSDL, neáu khoâng ñoùng coù theå daãn ñeán tình 

traïng bò hö CSDL 

Moät Soá Thao Taùc  chung Trong Cöûa Soå 

Database 
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Caùc coâng cuï cuûa Access coøn goïi laø caùc ñoái 

töôïng (object) Table, Query, Form, Modul, Report, 

Macro. Caùc Object naøy coù thao taùc xöû lyù nhö nhau., 

Choïn trang Object caàn xöû lyù 

Thöïc hieän caùc coâng vieäc sau neáu caàn : 

Choïn Open: Môû ñeå xem hay nhaäp döõ lieäu 

Choïn Design: Môû ñeå xem, söûa caáu truùc cuûa 

object 

Choïn New: Taïo môùi 

Kích phaûi Mouse choïn Rename: ñoåi teân  

Kích phaûi 

Mouse choïn 

Delete: xoùa 

Kích phaûi 

Mouse choïn 

Copy, Kích phaûi 

Mouse choïn 

Paste, xuaát hieän 

khung Paste Table As : 

Muïc Table Name : Ñaùnh teân môùi  
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IV. TABLE – baûng  

CAÙC KHAÙI NIEÄM VEÀ BAÛNG DÖÕ LIEÄU  

Table ñöôïc toå chöùc thaønh doøng, nhieàu coät. Moãi 

moät coät goïi laø moät tröôøng (field) vaø moãi doøng ñöôïc 

goïi laø moät maãu tin (record). Moãi moät tröôøng coù moät 

teân tröôøng vaø moät kieåu döõ lieäu.  

Döõ  lieäu trong moät coät phaûi ñoàngnhaát ( Cuøng 

kieåu döõ lieäu vaø cuøng yù nghóa ) 

 

Field Name – Teân Tröôøng 

Caùch ñaët teân: 

+ daøi toái da 64 kyù töï. 

+ Baét ñaàu laø caùc kyù töï A – Z, 0 – 9 

+ Coù theå coù kyù töï “space”, “-“ nhöng ñaëc bieät 

laø khoâng ñöôïc coù daáu chaám 
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Data Type – Kieåu Döõ Lieäu Cuûa Tröôøng 

Trong Table moãi Field duøng ñeå löu tröõ moät 

loaïi döõ lieäu do vaäy töông öùng moãi field baïn phaûi 

choïn moät trong caùc döõ lieäu sau ñaây. 

 

Kieåu döõ lieäu Coâng duïng 

Text 

Kieåu chuoãi 

Duøng ñeå löu tröõ caùc thoâng tin 

daïng caùc kyù töï chöõ vaø kyù töï 

soá, khoâng duøng ñeå tính toaùn. 

Daøi toái ña laø 255 kyù töï. 

Memo 

Kieåu Memo  

Gioáng kieåu Text nhöng ñeå 

duøng löu tröõ caùc döõ lieäu coù 

kích thöôùc lôùn hôn 255 kyù töï, 

coù nghóa ñoái vôùi nhöõng döõ lieäu 

neáu khoâng löu tröõ ñöôïc ôû daïng 

Text môùi duøng ôû daïng Memo 

Coù theå löu tröû caùc vaên baûn 

khoaûng 64000 kyù töï 

Ví duï: löu tröõ Tieåu söû baûn 

thaân. 

Number 

Kieåu soá 

Duøng ñeå löu tröõ caùc giaù trò soá, 

coù theå tính toaùn. 

Ví duï: Löông caên baûn 

(550.000), Heä soá löông (2.02) 

Date/Time Kieåu ngaøy/giôø 
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Duøng ñeå löu tröõ caùc thoâng tin 

daïng ngaøy vaø giôø, duøng ñeå 

tính toaùn. 

Ví duï: Ngaøy sinh 

(15/01/1980), Ngaøy nhaän 

vieäc(20 Jan 1998) 

Currency 

Kieåu soá coù ñònh daïng tieàn teä 

Duøng ñeå löu tröõ giaù trò tieàn, coù 

theå tính toaùn. 

Ví duï: Ñôn giaù ($ 100.00), Giaù 

veù (1000.000 VNÑ) 

Autonumber 

Kieåu soá nhöng töï ñoäng taêng 

Duøng ñeå löu tröõ moät soá, ñaây laø 

daïng ñaëc bieät cuûa Access giuùp 

quaûn lyù caùc thoâng tin caàn phaûi 

ñaùnh soá thöù töï khi nhaäp vaøo. 

Giaù trò cuûa field naøy seõ ñöôïc 

Access töï ñoäng nhaäp vaøo vaø 

khoâng cho ngöôøi söû duïng 

chænh söûa hay nhaäp. 

Thöôøng duøng kieåu 

Autonumber ñeå ñaët maõ töï 

ñoäng. 

Ví duï: Maõ khaùch haøng (ngöôøi 

ñaàu tieân seõ coù maõ laø 0001, 

ngöôøi keá tieáp theo seõ laø 0002, 

0003….), Maõ haøng 

(001,002,….999,…) 
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Yes/No 

Kieåu Logic 

Duøng ñeå löu tröõ caùc thoâng tin 

maø chæ coù hai giaù trò 

Ví duï: Phaùi: Chæ coù hai phaùi 

Nam hay Nöõ (ñuùng hoaëc sai), 

Loaïi hoaù ñôn xuaát nhaäp: Chæ 

coù hai loaïi laø Xuaát hay Nhaäp 

OLE Object 

Kieåu ñoái töôïng  

Duøng ñeå löu tröõ caùc vaên baûn, 

Hình veõ, Bieåu ñoà goïi laø ñoái 

töôïng nhuùng (Object Linking 

Embebding). 

Chæ neân choïn kieåu OLE 

Object khi khoâng löu tröõ soá 

lieäu ôû moät trong caùc daïng treân 

Ví duï: 

Hình cuûa nhaân vieân 

-   Caùc taøi lieäu cuûa Word hay 

Excel. V.v… 

Hyperlink 

Kieåu chuoãi chæ ñöôøng 

Duøng ñeå caùc ñòa chæ cuûa caùc 

trang Web, cho pheùp lieân keát 

caùc trang Web deã daøng khi 

caàn thieát. 

Ví duï: 

ñòa chæ trang Web cuûa caùc cô 

quan hay coâng ty 

(TTDT 
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http:/www.hcmc.edu.vn/defaul

t.htm 

DHBK 

http:/www.hcmut/default.htm) 

Lookup 

Wizard 

Kieåu doø tìm 

Taïo moät coät ñeå choïn giaù trò vaø 

tìm kieám töø moät baûng khaùc. 

 

Description – Moâ Taû 

Coät description duøng ñeå chuù thích cho tröôøng, 

chæ coù giaù trò tham khaûo cho ngöôøi söû duïng. Khi baïn 

nhaäp hay söûa döõ lieäu treân tröôøng ôû cheá ñoä 

datasheet, noäi dung cuûa description seõ hieån thò ôû 

thanh traïng thaùi (Status line) ñeå höôùng daãn ngöôøi 

nhaäp. 

Properties – moâ taû thuoäc tính cuûa tröôøng  

Ngoaøi caùch choïn döõ lieäu hôïp lyù ñeå quaûn lyù döõ 

lieäu chính xaùc, Access coøn cho pheùp ngöôøi söû duïng 

quy ñònh theâm moät soá thuoäc tính cuøa field nhaèm 

muïc ñích tieát kieäm ñóa khi löu tröõ soá lieäu hay kieåm 

tra döõ lieäu xuaát nhaäp coù hôïp lyù hay khoâng .v.v. 

Thuoäc tính thoâng duïng cuûa field goàm caùc loaïi 

sau ñaây: 

 

Thuoäc tính Coâng duïng 

Field Size 

Kích thöôùc döõ lieäu 

Duøng ñeå quy ñònh kích thöôùc 

döõ lieäu caàn döï tröõ, neáu choïn 
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ñuùng seõ giuùp baïn tieát kieäm ñóa 

vaø nhaäp soá lieäu chính xaùc hôn. 

Chæ coù field chöùa döõ lieäu kieåu 

TEXT & NUMBER môùi cho 

pheùp thay theá giaù trò field size. 

Text: Field size coù giaù trò töø 1 

– 255 (moãi 1 kyù töï chím 1 

byte, Vaên baûn coù daáu vieät 

chieám 2 byte ) 

Num 

Byte       1byte, duøng ñeå löu 

caùc con soá nguyeân döông 

            (coù giaù trò töø 0 – 255) 

Integer     2 byte, duøng ñeå löu 

caùc con soá nguyeân  

                 (coù giaù trò töø –32768 

– 32767) 

LongIteger 4 byte duøng ñeå löu 

caùc con soá nguyeân  

                 (coù giaù trò töø –

2.147.483.648 – 

2.147.483.647) 

Single      4 byte, duøng ñeå löu 

caùc con soá baát kyø 

                 (coù giaù trò töø –3,4 x 

10
38 

– 3,4x10
38

) 

Double     8 byte, duøng ñeå löu 

caùc con soá baát kyø  
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                 (coù giaù trò töø –1,797 

x 10
308

 – 1,797 x 10
308

) 

Format 

Daïng theå hieän 

Duøng ñeå quy ñònh daïng döõ lieäu 

khi hieån thò leân maøn hình hoaëc 

in ra giaáy. Moãi moät kieåu döõ 

lieäu coù moät format khaùc nhau. 

(xem baûng Format) 

Input Mask Maët naï nhaäp lieäu 

Duøng ñeå quy ñònh daïng döõ lieäu 

nhaäp vaøo. Neáu choïn Input 

Mask ñuùng seõ haïn cheá ñöôïc 

caùc sai soùt khi nhaäp soá lieäu. 

Caption Nhaõn 

Moät dieãn ñaït khaùc cho teân 

tröôøng, chæ ñeå hieån thò khi xem 

treân maøn hình hay in ra giaáy. 

Khi coù nhaõn thì Access seõ hieåu 

nhaõn thay cho teân tröôøng. 

Default 

Value 

Giaù trò ngaàm ñònh 

Giaù trò ñöôïc töï ñoäng gaùn giaù trò 

ban ñaàu cho tröôøng khi nhaäp 

theâm moät Record môùi. 

Thoâng thöôøng ta choïn giaù trò 

cuûa Default Value laø giaù trò 

thöôøng xuaát hieän nhieàu laàn 

trong field, ñieàu naøy seõ giuùp 

baïn ñôû maát coâng nhaäp giaù trò 
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cho tröôøng. 

Validation 

rule 

Qui taéc hôïp leä 

Duøng ñeå nhaäp qui taéc kieåm tra 

döõ lieäu hôïp leä khi nhaäp döõ lieäu 

beân ngoaøi vaøo baûng coù hôïp leä 

hay khoâng. 

Validation 

Text 

Thoâng baùo loãi 

Duøng ñeå nhaäp caâu thoâng baùo 

loãi seõ xuaát hieän neáu nhaäp döõ 

lieäu vaøo baûng khoâng hôïp leä vôùi 

qui taéc ñaõ ñònh trong thuoäc tính 

Validation Rule. 

Required Yeâu caàu 

Neáu choïn Yes thì baét buoäc 

phaûi nhaäp vaøo field naøy.  

Neáu choïn No cho pheùp coù theå 

boû troáng taïi field naøy hoaëc coù 

theå ñeå nhaäp sau. 

Allow  

Zero 

Length 

Cho pheùp chieàu daøi cuûa chuoãi 

laø khoâng 

Choïn Yes trò chuoãi roãng. 

Thuoäc tính Allow Sero Length 

phuï thuoäc vaøo thuoäc tính 

Required 

Neáu Required=No thì Allow 

Sero Length khoâng coù taùc 

duïng, coøn Required=Yes thì 

Allow Sero Length môùi coù taùc 
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duïng, trong tröôøng hôïp 

Required=Yes vaø Allow Sero 

Length=Yes baïn coù theå nhaäp 

“space” xem nhö ñaõ nhaäp döõ 

lieäu vaøo field. 

Indexed 

Chæ muïc 

Duøng ñeå choïn caùch taïo chæ 

muïc cho field. 

Choïn phuø hôïp seõ giuùp cho vieäc 

tìm kieám vaø saép xeáp soá lieäu seõ 

nhanh choùng hôn, neáu khoâng 

phuø hôïp (thöøa) seõ laøm cho vieäc 

caäp nhaäp soá lieäu nhö theâm, 

söûa, xoaù seõ chaäm ñi. 

Thoâng thöôøng chæ choïn Indexd 

cho field duøng laøm Primary 

Key vaø field thöôøng duøng ñeå 

saép xeáp soá lieäu khi xem hay in. 

Indexed=No hay ñeå troáng laø 

khoâng caàn taïo Indexed 

Indexed=Yes (Duplicates OK) 

taïo Indexed vaø cho nhaäp truøng 

soá lieäu. 

Indexed=Yes (No Duplicates) 

taïo Indexed vaø khoâng cho 

nhaäp truøng soá lieäu ñaõ nhaäp 

tröôùc trong field naøy. 

Diplay Daïng ñieàu khieån 
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Control Choïn daïng ñieàu (Text Box, 

ListBox, CommboBox, 

CheckBox v.v….) duøng ñeå hieån 

thò soá lieäu cho field chöùa soá 

lieäu kieåu Number, Text, 

Yes/No v.v… 

 Baûng Format 

Ñònh 

Daïng 

Ñeå hieån thò Thí duï 

hieån thò 

Date/Tim

e 

 

General 

Date 

Ngaøy giôø ñaày ñuû 4/3/93, 

05:34:00 

PM 

Long 

Date 

Thöù, thaùng ngaøy, 

naêm 

Saturday, 

April 3, 

1993 

Medium 

Dater 

Ngaøy-thaùng-naêm 3-Apr-93 

Short 

Date 

Ngaøy-thaùng-naêm 3/4/93 

Long 

time 

Giôø:phuùt:giaây 

AM/PM 

5:34:23 

PM. 

Medium 

Time 

Giôø:phuùt AM/PM 5:34 PM 

Short 

time 

Giôø:phuùt 5:34 

Number  
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General 

Num 

Ñuùng soá ñaõ nhaäp 

vaøo 

 

Currency Coù phaân caùch phaàn 

ngaøn, soá leû cheøn 

theâm $ 

$1,998.0

3 

Fixed Coù phaân caùch phaàn 

ngaøn vaø coù laøm 

troøn, phuï thuoäc 

vaøo vò trí soá leû 

trong Decimal 

Places 

1,998.03 

(2 soá leû) 

1,998.0 

(1 soá leû) 

Standard Coù phaân caùch phaàn 

ngaøn, soá leû 

1,998.03 

Percent Döõ lieäu nhaäp nhaân 

(x) 100 vaø kyù töï % 

Nhaäp 0.1  

- 10% 

Scientific Soá khoa hoïc Nhaäp 50  

- 

5.0E+01 

TEXT  

> Laøm thay ñoåi chöõ 

IN 

 

< Laøm thay ñoåi chöõ 

thöôøng 

 

@ Döõ lieäu baét buoäc 

nhaäp 

 

& Döõ lieäu khoâng baét 

buoäc nhaäp 
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Input Mark: Maët naï ñònh daïng döõ lieäu duøng ñeå 

baét buoäc ngöôøi söû duïng khi nhaäp döõ lieäu vaøo baûng 

phaûi tuaân theo ñuùng ñònh daïng ñoù. Ví duï khi nhaäp 

ñieåm thi thì chæ cho pheùp nhaäp vaøo caùc con soá chöù 

khoâng ñöôïc pheùp nhaäp moät chuoãi kyù töï. 

 

Kyù töï YÙ nghóa cho pheùp nhaäp 

0 Kyù soá 0 – 9, khoâng cho pheùp 

nhaäp daáu vaøo 

9 Kyù soá 0 – 9 vaø khoaûng traéng 

khoâng cho pheùp nhaäp daáu 

# Kyù soá 0 – 9 vaø khoaûng traéng 

cho pheùp nhaäp daáu 

L Kyù töï A – Z baét buoäc nhaäp döõ 

lieäu 

? Kyù töï A – Z khoâng baét buoäc 

nhaäp döõ lieäu 

A Kyù töï vaø kyù soá baét buoäc nhaäp 

döõ lieäu 

A Kyù töï vaø kyù soá khoâng baét buoäc 

nhaäp döõ lieäu 

& Baát kyø moät kyù töï naøo hoaëc 

khoaûng traéng baét buoäc nhaäp döõ lieäu 

 

. , : ; - 

/ 

Caùc daáu phaân caùch: soá leû, phaàn 

ngaøn, ngaøy giôø, (Thaät söï caùc daáu 

phaân caùch naøy coøn phuï thuoäc vaøo 

beân trong thuoäc tính Regional 

Settings cuûa Control Panel treân 
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Windows) 

< Chuyeån ñoåi caùc döõ lieäu chuoãi 

sang chöõ thöôøng 

> Chuyeån ñoåi caùc döõ lieäu chuoãi 

sang chöõ IN 

TAÏO TABLE 

 Caùc böôùc taïo 1  Table (baûng döõ lieäu ) 

Böôùc 1 : Choïn muïc Table, nhaép choïn  New  xuaát hieän khung 

New Table : 

Böôùc 2 : Khai baùo caáu truùc 

Böôùc 3:  Xaùc ñònh khoùa chính – neáu coù (PrimaryKey) 

Choïn tröôøng duøng laøm khoùa chính (neáu choïn 

nhieàu tröôøng thì giöõ theâm phím CTRL khi choïn) 

 Choïn leänh Edit  Primary Key hoaëc baïn coù theå choïn 

nuùt leänh  treân thanh coâng cuï Table Design ñeå taïo khoùa 

chính (Primary Key. ) 

 Khi ñoù tröôøng ñöôïc choïn laøm khoùa seõ coù bieåu töôïng 

hình chìa khoùa beân traùi . 

 Neáu choïn sai coù theå choïn tröôøng khaùc vaø ñaët laïi  

Böôùc 4 : Löu - ñaët teân cho baûng 

 Choïn leänh File  Save hoaëc choïn coâng cuï Save 

 Nhaäp teân baûng. Choïn OK 

Löu yù: Neáu khoâng choïn tröôøng khoùa chính, 

Access seõ thoâng baùo vaø xin yù kieán “ There is no 

primary key defined. Create a primary key?” 

Khi ñoù ta choïn: 
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Yes: ñoàng yù ñeå Access röï taïo theâm moät tröôøng kieåu 

Counter coù teân laø REID laøm khoùa chính. 

No: Xaùc nhaän baûng khoâng caàn coù khoùa chính ( 

nhöõng baûng maø döõ lieäu cho pheùp truøng nhau ) 

Cancel: Huõy boû leänh ghi, trôû veà choïn tröôøng laøm 

khoùa chính ñeå ñaët khoùa chính 

 Chænh söûa caáu truùc baûng 

 Choïn baûng caàn chænh 

 choïn nuùt leänh Design 

 Thao taùc xöû lyù: 

Cheøn moät tröôøng: 

Nhaép chuoät ôû oâ xaùm beân traùi doøng öùng vôùi 

tröôøng bò cheøn 

Nhaán phím Insert (hoaëc choïn Insert  Insert 

hoaëc Shortcut menu  insert row) 

Xoùa tröôøng 

Nhaép chuoät ôû oâ xaùm beân traùi doøng öùng vôùi 

tröôøng caàn xoùa 

Nhaán phím Delete (hoaëc choïn Edit  Delete 

hoaëc Shortcut menu  Delete row) 
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Thay ñoåi vò trí tröôøng 

Nhaép chuoät ôû oâ xaùm beân traùi doøng öùng vôùi 

tröôøng caàn thay ñoåi vò trí 

Ñaët chuoät ôû tröôøng choïn sau cho chuoät coù daïng  

vaø keùo thaû ôû vò trí thích hôïp 

THIEÁT LAÄP MOÁI QUAN HEÄ 

Sau khi thieát keá caùc baûng, chuùng ta chæ môùi coù 

caáu truùc caùc baûng chöù chöa coù caùc thoâng tin quan heä 

(lieân heä) giöõa caùc baûng vôùi nhau. Do ñoù vieäc thieát 

laäp quan heä giöõa caùc baûng deõ giuùp Access quaûn lyù 

döõ lieäu ñöôïc hôïp lyù vaø chaét cheõ. 

 Thieát laäp quan heä vaø khai baùo quan heä  

 Vaøo maøn hình RelationShip: Tool  RelationShip 

hoaëc nhaép nuùt leänh relationShip treân thanh coâng cuï 

 Choïn caùc baûng tham gia quan heä - Reâ chuoät coù theå 

choïn nhieàu Table vaø Add 

 Choïn nuùt Close ñeå ñoùng laïi, neáu phaùt hieän thieáu baûng 

thì choïn nuùt leänh Show table   treân thanh coâng cuï 

ñeå choïn theâm 

table 

 Khai baùo quan 

heä :   Drag 

tröôøng khoùa 

chính cuûa baûng 

chính (baûng 

beân 1) sang thaû 

taïi tröôøng quan 

heä (khoùa 
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ngoaïi) cuûa baûng beân nhieàu. Access laäp töùc môû hoäp 

thoaïi thoaïi Relation Ships  

Trong ñoù 

 Enfore Referentiall Integrity: Xaùc ñònh eùp buoäc tính 

toaøn veïn döõ lieäu 

 Cascade Update related field: Chính söûa söõ lieäu thì 

phuï söûa theo  

 Cascade Delete related field: Xoùa beân chính thì phuï 

xoùa theo  

 Chænh söûa moái quan heä:  

 Nhaép ñuùp taïi daây quan heä choïn Edit Replationships.  

 Xoùa daây quan heä: Click choïn daây quan heä, nhaán 

Delete 

 Löu yù: khi taïo xong relation Ship, phaûi löu laïi quan heä 

baèng caùch choïn Save 

 Nhöõng khoùa chính laø nhöõng tröôøng treân baûng laø chöõ 

ñaäm  

 

 Thieát laäp quan heä xong roài môùi nhaäp lieäu döõ lieäu. 

Ñaûm baûo khi nhaäp döõ lieäu, neáu sai thì Access seõ thoâng 

baùo loãi ngay ñeå kòp thôøi ñieàu chænh, neáu nhaäp lieäu maø 

bò sai, sau naøy thieát laäp quan heä thì khoâng khai baùo 

raøng buoäc ñöôïc, luùc naøy thaät raéc roái. 

 Nhaäp döõ lieäu thì nhaäp baûng cha ( Table - moät) tröôùc,  

baûng con sau ( Table - nhieàu ) 
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Neáu 2 baûng coù quan heä 1 –1 thì reâ khoùa chính cuûa baûng 

naøo thì sau naøy khi nhaäp lieäu thì phaûi nhaäp döõ lieäu baûng 

ñoù tröôùc.  

XÖÛ LYÙ DÖÕ LIEÄU TRONG TABLE 

 Nhaäp – Xoùa – Söûa caùc maãu tin 

 Nhaäp döõ lieäu : 

Töø cöûa soå Database, choïn Table, choïn teân 

baûng döõ lieäu caàn thieát vaø nhaép nuùt Open hoaëc 

doube mouse vaøo baûng caàn nhaäp. 

Caùc thoâng baùo loãi khi nhaäp döõ lieäu : 

 Khoâng nhaäp döõ lieäu ôû tröôøng coù khoùa chính maø 

chuyeån con nhaùy sang maãu tin khaùc, baùo loãi “ Index 

or Primary key can’t contain a null value “ 

 Nhaäp döõ lieäu treân moät baûng coù quan heä vôùi baûng khaùc 

maø vi phaïm tính toaøn veïn döõ lieäu thì seõ thoâng baùo loãi 

“ You can’t add or change a record because a 

related record is required in table … “ Ví duï nhaäp 

moät maõ haøng hoùa trong baûng chi tieát nhaäp nhöng laïi 

khoâng coù trong Baûng Danh muïc haøng hoùa  

 Nhaäp döõ lieäu ôû tröôøng coù khoùa chính, döõ lieäu truøng thì 

seõ baùo loãi : “ The changes you requested to the table 
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were not successful because they would create 

duplicate value in the index, primary or 

relationship”  

Theâm moät maãu tin: Chæ ñöôïc theâm vaøo cuoái baûng 

Thao taùc - xoùa – söûa : gioáng trong Excel 

 Tìm kieám 

Nhaép chuoät taïi coät chöùa gía trò muoán tìm vaø taïi 

doøng baét ñaàu tìm 

Choïn Edit  Find. Xuaát hieän hôïp thoaïi hình 

1.8 

 

Hình 1.8: Hoäp thoaïi tìm döõ lieäu 

Khai baùo giaù trò tìm vaø caùch tìm 

Find what:  <Giaù trò tìm> 

Search:  Höôùng tìm 

Match:  choïn caùch so saùnh 

giaù trò trong oâ 

Search Only Current Field:  Chæ tìm taïi coät 

hieän haønh 

Match case:  Coù phaân bieät chöõ 

thöôøng hoa 
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Search Field as format:  Coù phaân bieät ñònh 

daïng 

Thi haønh leänh tìm 

Find first:  baét ñaàu tìm 

Find next:  Tìm tieáp 

Close:  chaám döùt tìm 

   Tìm kieám vaø thay theá: Thao taùc goáng nhö 

tìm 

 

 

Löu yù: Access cung caáp moät soá kyù töï ñaïi diieän 

tìm kieám nhö sau: 

 

? ñaïi ñieän moät kyù töï Taâ?: Taâm, 

Taân 

* ñaïi dieän moät chuoãi caùc 

kyù töï 

Taâ*: Taân, 

Taâm, Taây 

# ñaïi dieän moät kyù soá 25##: töø 2500 

 2599 

{

} 

ñaïi dieän moät trong caùc 

kyù töï naêm trong 

Taâ[ny]: Taân, 

Taây 
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- ñaïi dieän kyù töï naèn 

trong moät khoaûn [] 

[L-N]am: 

Lam, Mam, 

Nam 

! phuû ñònh [!L-N]: Khoâng 

laø Lam, Mam, 

Nam 

 Saép xeáp caùc maãu tin: 

Khoùa saép xeáp döïa treân moät tröôøng 

choïn coät laøm khoùa saép xeáp 

Record  Sort  Ascending 

(taêng)/Descending (giaûm) 

Khoùa saép xeáp döï treân nhieàu tröôøng 

Do thöù töï öu tieân saép xeáp laø töø traùi sang phaûi 

do ñoù caùc tröôøng khoùa saép xeáp phaûi ñöôïc di chuyeån 

laïi gaàn nhau vaø theo thöù töï khoùa saép xeáp 

Ví duï: Xeáp danh saùch nhaân vieân taêng daàn theo 

Phoøng ban, neáu truøng phoøng thì xeáp theo thöù töï taêng 

daàn cuûa MSNV 

Thao taùc thöïc hieän: 

choïn coät caùc coät laøm khoùa saép xeáp 

Record  Sort  Ascending 

(taêng)/Descending (giaûm) 

 Loïc Caùc Maãu Tin 

Döõ lieäu trong moät baûng coù theå ñeán moät luùc 

naøo ñoù seõ quaù nhieàu ñoâi khi laøm cho chuùng ta roái 

maét khi xem döõ lieäu. Do ñoù ñeå che ñi nhöõng maãu tin 

khoâng caàn hieån thò, vaø khi caàn thieát thì cho xuaát 
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hieän laïi. Ñeå laøm vieäc naøy thì trong Access cung caáp 

cho chuùng ta tính naêng loïc döõ lieäu 

Filter By Selection 

 Choïn döõ lieäu caàn xem 

 Vaøo leänh Record  Filter  Filter 

by  

Ví duï 1 : Loïc ra nhöõng maãu tin coù maõ haøng laø 

X83 

Filter by form :  

Ví duï 2 : Loïc ra nhöõng maãu tin maø kyù töï ñaàu 

cuûa maõ haøng laø X 

 Vaøo leänh Record  Filter  Filter by Form. 

Access môû cöûa soå Filter 

 Khai baùo ñieàu kieän loïc döõ lieäu ( “X* “) 

 Luùc naøy menu Record trôû thaønh menu Filter 

vaøo ñaây choïn leänh Apply Filter/ Sort: ñeå xem 

caùc maãu tin thoûa ñieàu kieän loïc 

 Muoán trôû veà ban ñaàu vaøo menu Record/ 

choïn leänh Remove Filter/Sort:  

Filter excluding selection: 

Ví duï 3 Loïc ra nhöõng maãu tin maø maõ haøng 

khoâng phaûi laø X83  

 Choïn moät oâ baát kyø coù maõ haøng laø X83 

 Vaøo leänh Record  Filter  Filter 

excluding  

 Luùc naøy Access loïc ra nhöõng maãu tin khaùc 

X83 (khoâng phaûi laø X83) 
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Advanced Filter/Sort:  

Duøng ñeå saép xeáp hay loïc döõ lieäu thoaû 

nhöõng ñieàu ñieàu kieän phöùc taïp  

Ví duï 4: Loïc ra nhöõng maãu tin hoaëc laø X83 

hoaëc laø X92  

Record  filter  Advanced filter/Sort. Xuaát 

hieän hoäp thoaïi Filter 

 

Khai baùo  ñieàu kieän ôû doøng Criteria vaø field 

MaHang  

Caùc thao taùc khaùc  

Format     Font  choïn font chöõ cho 

baûng soá lieäu vaø maøu chöõ  

Datasheet : ñònh daïng caùc oâ trong baûng 

Row Height : thay ñoåi chieàu cao 

cuûa doøng 
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Column Width : Thay ñoåi chieàu 

roäng cuûa coät 

Rename : ñoåi teân cuûa tröôøng 

Hide Columns : daáu caùc coät 

Unhide Columns : hieån thò laûi caùc coät 

bò aån 

Freeze Columns : Coät ñònh caùc coät, 

duøng ñeå cuoän maøn hình 

Unfreeze All Columns : huõy boû coát ñònh 

coät. 

TAÏO TABLE - QUERY- FORM- REPORT  TÖØ 

MOÄT TAÄP TIN CÔ SÔÛ DÖÕ LIEÄU KHAÙC  

 Môû taäp tin cô sôû döõ lieäu chöa coù  döõ lieäu  

 Vaøo menu File/External Data/ Import - xuaát hieän 

khung cöûa soå  

 Choïn teân taäp tin cô sôû döõ lieäu – Ví duï Du Lieu Bai 

Tap Access2000 

 Choïn teân table – Ñeø phím Shift ñeå choïn nhieàu 

baûng cuøng moät luùc  

 Choïn OK 
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V. QUERY – BAÛNG VAÁN TIN  

BAÛNG VAÁN TIN LÖÏA CHOÏN 

 Taïi sao phaûi duøng baûng vaán tin Khaùi 

nieäm: 

Trong thöïc teá vieäc tham khaûo thoâng tin coù raát 

nhieàu daïng khaùc nhau vaø thöôøng vôùi daïng döõ lieäu 

nhaäp vaøo. Khi ñoù ngöôøi ta phaûi söû duïng moät coâng 

cuï ñeå truy vaán thoâng tin (Query ) chaúng haïn nhö : 

 Löïa choïn caùc tröôøng vaø maãu tin caàn thieát  

 Xeáp thöù töï caùc maãu tin theo tröôøng quy ñònh  

 Tham khaûo döõ lieäu treân nhieàu baûng  

 Söû duïng baûng vaán tin ñeå laøm Form hay Report 

 Thöïc hieän nhöõng thay ñoãi trong baûng döõ lieäu  

 Tính toaùn soá lieäu treân table 

 Coù theå taïo ra moät Table môùi  

Keát quaû cuûa moät query ñöôïc goïi laø moät dyna 

Set (Dynamic Set). Moät Dynaset khoâng phaûi laø  moät 

baûng soá lieäu thöïc söï maø noù chæ laø boä soá lieäu “soáng 

ñoäng” phaûn aùnh tình traïng soá lieäu ñöông thôøi. Neáu 

ta söû soá lieäu treân Dynaset thì ñoàng thôøi soá lieäu trong 

table cuõng thay ñoåi theo vaø ngöôïc laïi. 

 Caùc loaïi Query thoâng duïng : 

Select Query – truy vaán choïn 

CrossTab Query – truy vaán tham chieáu cheùo 

Make Table Query – truy vaán taïo baûng 

Update Query – truy vaán caäp nhaät 

Append Query – truy vaán theâm soá lieäu 
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Delete Query – truy vaán xoùa soá lieäu 

 Caùch taïo 1 Query:  

Coù 3 caùch taïo moät Query: 

 Duøng tröïc tieáp ngoân ngöõ truy vaán coù caáu truùc SQL 

( cöûa soå SQL) 

 Duøng coâng cuï Wizard Query  

 Ngöôøi duøng töï thieát keá thoâng qua löôùi QBE (Query 

By Example) (cöûa soå Design View ) 

TAÏO TRUY VAÁN BAÈNG DESIGN VIEW 

 Böôùc 1: - Taïi cöûa soå database, choïn 

trang Query, choïn New. Hoaëc choïn 

Insert  Query  xuaát hieän 

 Böôùc 2: Choïn muïc Design View xuaát 

hieän cöûa soå Show Table  

Xaùc ñònh loaïi döõ lieäu laø Table/Query tham gia 

truy vaán taïi cöûa soå Add Table 

Table: neáu xaùc ñònh chæ coù table tham gia truy 

vaán 

Query: neáu xaùc ñònh chæ coù Query tham gia 

truy vaán 

Both: Neáu xaùc ñònh laø coù caû table vaø query 

tham gia truy vaán 

Xaùc ñònh cuï theå table/query naøo tham gia truy 

vaán: choïn teân table/query vaø choïn Add – close 

Sau khi nhaán nuùt Close – phaùt hieän thaáy thieáu 

1 table thì nhaép vaøo nuùt leänh  ñeå theâm Table  
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 Böôùc 3:  Xaùc laäp moái quan heä giöõa 

caùc ñoái töôïng  

 Xaùc ñònh moái lieân heä giöõa caùc table/query 

neáu coù nhieàu table/query tham gia truy 

vaán 

 Neáu caùc moái lieân heä naøy ñaõ ñöôïc thieát laäp 

trong Relationship thì noù seõ töï xuaát hieän 

 Neáu moái lieân heä naøy chöa coù thì ta seõ töï 

thieát laäp moái lieân heä 

 Böôùc  4: Xaùc ñònh caùc noäi dung truy vaán taïi 

baûng löôùi QBE 

 

YÙ NGHÓA CUÛA CAÙC DOØNG TRONG 

KHUNG LÖÔÙI  

FIELD :  Tröôøng caàn hieån thò 

Duøng ñeå choïn caùc field caàn laáy soá lieäu hoaëc 

khai baùo coâng thöùc duøng ñeå tính toaùn soá lieäu 
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Choïn field coù saún trong table/ query: thöïc 

hieän 1 trong 3 caùch  

 Drag field caàn choïn trong table/query vaøo oâ Field 

name ôû löôùi QBE 

 Hoaëc Double Click field caàn choïn 

 Hoaëc choïn field trong combo Box field 

Khai baùo caùc field coâng thöùc:  

Khai baùo theo maãu sau:  Teân Tröôøng : Bieåu 

thöùc  

Ví duï :  

Field MaHang SLxuat Gia 

Ban 

ThanhTien:S

LXuat*GiaBa

n 

Table     

Criteria     

Khi nhaäp coâng thöùc vaøo ta neân nhaán Shift-F2 

ñeå  phoùng lôùn oâ Field cho deã daøng nhaäp coâng thöùc. 

Xoaù Field treân löôùi QBE:  

Choïn coät chöùa Field caàn xoùa vaø nhaán phím 

Delete 

Saép xeáp thöù töï caùc field:  

Drag coät field ñeán vò trí môùi. Thöù töï caùc field 

laø thöù töï treân baûng keát quaû DataSheet 

Ñoåi teân tröôøng ñöôïc theå hieän trong truy 

vaán; 

Nhaèm muïc ñích cho baûng DynaSet deã ñoïc hôn. 

Khi ñoåi teân, Access trình baøy teân môùi trong tieâu ñeà 

coät cuûa baûng keát quaû thay cho teân tröôøng thöïc söï 
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cuûa baûng. Hôn nöõa, teân môùi seõ ñöôïc söû duïng baát kyø 

ñoái töôïng naøo hoaït ñoäng treân cô sôû cuûa truy vaán ñoù. 

Caùch thöïc hieän: 

Nhaép chuoät vaøo beân traùi kyù töï ñaàu tieân cuûa 

tröôøng trong löôùi QBE. 

Nhaäp vaøo teân môùi vaø theo sau laø daáu hai chaám 

<Teân môùi > : <field name>  

ví duï : SLXuat: Soá Löôïng Xuaát  

Ví duï taïo theâm coät kyù nhaän, treân doøng field 

ñaùnh   Kyù Nhaän : “ “  

TABLE:  Baûng chöùa field caàn hieån thò 

 Hieån thò teân table/query chöùa field töông öùng 

 Access töï ñoäng hieån thò teân table cuûa field töông 

öùng , baïn coù theå choïn laïi. 

 Coù theå taét/baät haøng table baèng leänh View  Table 

Name 

SORT:  Saép xeáp  

 Duøng ñeå choïn caùch saép xeáp thöù töï soá lieäu. 

 Ascending: Saép xeáp döõ lieäu theo thöù töï taêng 

 Descending: Saép xeáp döõ lieäu theo thöù töï giaûm 

 Not Sorted: khoâng caàn saép xeáp 

Löu yù:   Chæ khai baùo ôû haønh Sort cho caùc  field 

caàn saép xeáp coøn caùc field khoâng caàn saép xeáp thì ñeå 

troáng. Thöù töï saép xeáp treân nhieàu field ñöôïc öu tieân töø 

traùi sang phaûi 

SHOW:  Hieån thò caùc field hoaëc aån 

Giaù trò ngaàm ñònh ôû haøng naøy laø Yes. Neáu laø 

Yes töùc laø field naøy ñöôïc choïn ñeå hieån thò treân 

DataSheet View 
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CRITERIA:  Ñieàu kieän  

Baûng tieâu chuaån - duøng ñeå khai baùo ñieàu kieän 

ñeå laáy soá lieäu 

Caùch 1: Laäp tieâu chuaån baèng phöông phaùp 

duøng boä xaây döïng bieåu thöùc: 

 Choïn oâ Criteria cuûa field baïn muoán ñònh 

nghóa bieåu thöùc. 

 Nhaép bieåu töôïng Build treân thanh coâng cuï. 

Khi ñoù Access trình baøy boä xaây döïng bieåu thöùc 

trong cöûa soå Expression Builder. Hình 3.7 

Goõ bieåu thöùc hoaëc laép gheùp caùc thaønh phaàn ñeå 

taïo thaønh bieåu thöùc 

Hình 3.7 Expression Builder 

Caùch 2: Laäp tieâu chuaån baèng caùch goõ thaúng 

bieåu thöùc vaøo Criteria 
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 Nhaép chuoät vaøo oâ Criteria öùng vôùi field lieân 

quan ñeán vôùi ñieàu kieän 

 Goõ thaúng bieåu thöùc vaøo. 

Field MaHang SLxuat Gia

Ba

n 

ThanhTien:SL

Xuat*GiaBan 

Total     

Criteria “X92”    

 Löu yù : 

Neáu bieåu thöùc khaù daøi, baïn neân môû hôïp Zoom 

(phoùng to) ñeå coù theå vöøa goõ vöøa quan saùt toaøn boä 

bieåu thöùc. Baèng caùch nhaán Shift_F2 

Laäp baûng tieâu chuaån cho nhieàu tröôøng: Ta 

coù theå laäp ñieàu kieän treân nhieàu tröôøng nhöng phaûi 

tuaân thuû theo qui taéc sau: Neáu yeâu caàu cuûa baïn baét 

buoäc phaûi thoûa caû hai ñieàu kieän thì caùc hai ñieàu 

kieän phaûi vieát cuøng haøng, coøn neáu chæ caàn thoûa moät 

trong hai ñieàu kieän thì baïn vieát khaùc haøng 

 Böôùc 5:  chaïy thöû vaø löu truy vaán 

Nhaép vaøo nuùt leänh  ñeå xem truy vaán, neáu 

ñuùng thì vaøo menu File choïn Save vaø ñaùnh teân 

MOÄT SOÁ KHAI BAÙO TIEÂU CHUAÅN VAÁN TIN ( 

CRITERIA) 

 Hieån thò nhöõng doøng coù MaSp laø X92 

– treân muïc Critera taïi coät MaSp 

Field Ma 

Hang 

Slxuat Gia 

Ban 

ThanhTien:SLX

uat*GiaBan 

Table     
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Criteri

a 

X92    

OR     

 Hieån thò nhöõng doøng coù MaSp laø X92  

hoaëc X83 – treân muïc Critera taïi coät 

MaSp 

Field MaHang Slxuat Gia 

Ban 

ThanhTien:S

LXuat*GiaB

an 

Table     

Criteria X92    

OR X83    

 Hieån thò nhöõng doøng coù MaSp laø X92  

vaø SLXuat lôùn hôn 20  

Field MaHang SlXuat Gia 

Ban 

ThanhTie

n:SLXuat

*GiaBan 

Table     

Criteria X92 >`20   

OR     

 Hieån thò nhöõng doøng coù ñòa chæ laø 

ñöôøng Traàn Höng Ñaïo  

Field MaNV MaDV DiaChi 

Table    

Criteria   Like *Traàn Höng 

Ñaïo* 

OR    
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 Toaùn töû IIF (Ñieàu kieän 1, Coâng vieäc 

1, Coâng vieäc 2 ) 

Thuong :IIF(NgayCong<=24, 50000, 100000) 

 Ñònh daïng soá coù daáu phaân caùch haøng 

nghìn  

 Choïn coät caàn ñònh daïng, kích phaûi mouse choïn 

Properties 

 Xuaát hieän  khung  

 Treân muïc Format ñaùnh vaøo #,### 

XEM KEÁT QUAÛ TRUY VAÁN 

Query Datasheet: Laø baûng soá lieäu keát quaû 

cuûa Query, Query chæ laáy soá lieäu ngay taïi thôøi ñieåm 

thöïc thi Query vaø hieån thò keát quaû trong baûng soá 

lieäu DataSheet, ngöôøi söû duïng coù theå theâm xoùa söûa 

soá lieäu tröïc tieáp treân baûng keát quaû. 

Query Design Window: Laø cöûa soå duøng ñeå 

xem hay moâ taû hay chænh söûa caáu truùc cuûa query.  
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SQL Windows : Hieån thò leänh SQL duøng ñeå xöû lyù soá 

lieäu, Access döïa vaøo phaàn moâ taû Query ñeå chuyeån 

sang leänh SQL töông öùng. 
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Baøi taäp Microsoft Word 

 

BAØI TAÄP 1 

Ñònh daïng:Font chöõ, leà, khoaûng caùch 

doøng/ñoaïn, kieåu canh leà 

 

Taïo Folder laáy teân laø teân cuûa lôùp baïn: D:\Teân lôùp 

cuûa baïn 

Soaïn thaûo vaên baûn sau, ghi taäp tin vaøo Folder Teân 

lôùp maø baïn vöøa taïo: 

Baïn coù theå soaïn thaûo baèng 2 caùch: 

Caùch 1: Ñònh daïng tröôùc, goõ VB sau 

Caùch2  Goõ VB thoâ tröôùc 

 Ñaùnh daáu töøng khoái vaø ñònh daïng theo trình 

bayø döôùi ñaây 

 

"Con ngöôøi laø 

ñoäng vaät coù khaû naêng 

suy nghó. Nhöng coù khaû 

naêng suy nghó khoâng töï 

ñoäng daãn ñeán bieát caùch 

suy nghó. Söï phaùt trieån 

ngaøy caøng ñoøi hoûi moãi 

ngöôøi phaûi bieát laøm 

vieäc, chuû yeáu baèng caùi 

ñaàu, ñeå giaûi quyeát toát 

L
ef

t 
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caùc vaán ñeà gaëp phaûi vaø 

ra caùc quyeát ñònh ñuùng"  

 

Taøi lieäu naøy hy voïng seõ mang 

laïi cho ngöôøi hoïc nhöõng kieán thöùc 

caàn thieát veà tö duy, nhöõng phöông 

phaùp vaø kyõ naêng tö duy hôïp lyù ñeå 

giuùp hoï traùnh ñöôïc moät caùch toái ña 

nhöõng löïc caûn voâ hình nhöng laïi coù 

söùc caûn raát gheâ gôùm
 treân con ñöôøng 

tö duy ñeå ra ñöôïc quyeát ñònh ñuùng. 

Kha û  n a ê n g  t r í  t u e ä  c u û a  c on  

ngöô ø i  la ø  b ình  ñ a ú n g , söï khaùc 

nhau laø ôû choã hoï coù bieát caùch khai 

thaùc khaû naêng ñoù hay khoâng,  

con ngöôøi hôn nhau 

khoâng phaûi ôû choã hoï 

bieát nhöõng caùi gì (what)  

maø laø hoï bieát ñieàu ñoù 

baèng caùch naøo (how).  
Ju

st
if

y
 

L
ef

t 
R

ig
h

t 
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Chuùng ta haõy tin töôûng raèng trong 

moãi baøi toaùn ñeàu chöùa ñöïng beân trong 

noù lôøi giaûi,  

chæ coù nhöõng ngöôøi coù trí tueä saéc beùn, 

coù phöông phaùp tö duy ñuùng môùi coù 

theå "nhìn" thaáy lôøi giaûi tieàm aån ñoù 

BAØI TAÄP 2 

Format Bullets and Numbering, Border and 

Shading, DropCap 

1/ Soaïn thaûo vaên baûn sau 

 

KYÕ NAÊNG TD 

 Tuyeät ñoái tuaân thuû caùc giai ñoaïn cuûa quaù 

trình TD. Trong töøng giai ñoaïn cuûa quaù trình 

Td phaûi quaùn trieät caùc quan ñieåm sau 

 Toân troïng tính khoa hoïc cuûa TD 

 Toân troïng tính khaùch quan cuûa ñoái 

töôïng Td 

 Toân troïng kieán thöùc KH coù lieân quan 

 Quaùn trieät quan ñieåm heä thoáng trong 

TD 

 Toân troïng tính caùch maïng cuûa TD 

 Coù ñaïo ñöùc vaø löông taâm trong saùng 

 

 TÍNH HEÄ THOÁNG TRONG TÖ DUY   

 
C

en
te

r 
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Heä thoáng laø taäp hôïp caùc yeáu toá lieân keát vôùi nhau 

theo moät caùch thöùc nhaát ñònh. Vaø keát quaû cuûa söï lieân 

keát ñoù laø taäp hôïp seõ coù nhöõng tính chaát maø nhöõng tính 

chaát ñoù khoâng theå coù ôû nhöõng yeáu toá hôïp thaønh khi 

chuùng ñöùng rieâng reõ. 

 

aùch thöùc lieân keát giöõa caùc yeáu toá taïo neân 

tính chaát cuûa heä thoáng. Chì vaø kim cöông 

ñeàu ñöôïc caáu taïo töø nguyeân töû Cacbon, 

song do caáu truùc lieân keát giöõa caùc nguyeân töû C ôû 2 

nguyeân toá hoaù hoïc naøy khaùc nhau daãn ñeán tính chaát 

hoaøn toaøn khaùc nhau cuûa 2 nguyeân toá naøy. Khi so 

saùnh söùc maïnh cuûa ngöôøi Nhaät vaø ngöôøi Myõ ngöôøi ta 

ñaõ ñöa ra hình aûnh raát tröïc quan sau 

I. 1 ngöôøi Nhaät yeáu hôn 1 ngöôøi Myõ 

II. 2 ngöôøi Nhaät maïnh baèng 2 ngöôøi Myõ 

III. 3 ngöôøi Nhaät maïnh hôn 3 ngöôøi Myõ 

 

ieàu ñoù khoâng theå giaûi thích ñöôïc baèng logic cuûa 

toaùn hoïc maø chæ coù theå giaûi thích baèng logic heä 

thoáng. Cuoäc soáng voâ cuøng phöùc taïp vaø muoân hình 

muoân veû, chæ coù logic heä thoáng môùi coù theå giuùp chuùng 

ta caét nghóa moät caùch ñaày ñuû ñöôïc nhöõng vaán ñeà phöùc 

taïp ñoù. 

 

C 

Ñ 
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2/ Taïo baûng ñeà cöông sau baèng 2 caùch (nhaäp 

noäi dung tröôùc, ñònh daïng sau) 

Caùch 1:  Bullet  and Numbering daïng Outline 

Numbered 

Caùch 2: Style (nhieàu caáp) 

 

 

ÑEÀ CÖÔNG CHUYEÂN ÑEÀ KYÕ NAÊNG TÖ DUY 

 

I/ Toång quan veà tö duy (tö duy thuaät toaùn) vaø tö duy 

saùng taïo 

1) YÙ nghóa cuûa tö duy vaø tö duy saùng taïo trong 

cuoäc soáng 

2) Taàm quan troïng cuûa chuyeân ñeà ñoái vôùi chöông 

trình giaûng daïy taïi tröôøng CBQLGD-ÑT 

 

II/ Tính yø taâm lyù 

1) Khaùi nieäm veà tính yø taâm lyù 

2) Cô sôû sinh lyù cuûa tính yø taâm lyù 

3) Caùc yeáu toá coù aûnh höôûng ñeán tính yø taâm lyù 

 

III/ Tö duy  

1) Lyù thuyeát TLH veà tö duy 

a. Khaùi nieäm 

b. Caùc giai ñoaïn cuûa quaù trình tö duy 

c. Tö duy vaø tính yø taâm lyù 

2) Ñaëc tröng tö duy cuûa ngöôøi VN vaø caên nguyeân 

cuûa noù trong lòch söû 
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a. Ñaëc tröng tö duy cuûa ngöôøi VN 

b. Keát quaû ñieàu tra veà nhöõng haïn cheá trong 

tö duy cuûa hoïc vieân tröôøng CBQLGD-ÑT 

3) Kyõ naêng tö duy  

a. Tuaân thuû caùc giai ñoaïn cuûa quaù trình TD 

b. Khaéc phuïc tính yø taâm lyù. Hình thaønh 

phong caùch tö duy môùi: 

- Ñaûm baûo tính khoa hoïc  

- Ñaûm baûo tính caùch maïng trong tö duy 

 

IV/ Tö duy saùng taïo (Saùng taïo) 

1) YÙ nghóa vaø lòch söû phaùt trieån cuûa khoa hoïc saùng 

taïo 

2) Baûn chaát cuûa hoaït ñoäng saùng taïo 

a. Khaùi nieäm 

b. Cô cheá cuûa hoaït ñoäng saùng taïo 

c. Moái quan heä giöõa linh caûm (tröïc giaùc, 

tieàm thöùc) vaø hoaït ñoäng saùng taïo 

d. Moái quan heä giöõa tö duy vaø saùng taïo  

3) Caùc thuû thuaät saùng taïo (40 thuû thuaät) 

 

V/ Nhöõng yeâu caàu veà phong caùch tö duy môùi trong 

tö töôûng cuûa Baùc Hoà. 
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